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Part 1: Introduction to Electionware

The Introduction to Electionware contains information about the following topics. 

 Chapter 1: Overview

 Chapter 2: System Requirements

 Chapter 3: Before Installing Electionware and Associated Products

 Chapter 4: Install Removable Media Service

 Chapter 5: VAT Preview

 Chapter 6: ExpressVote Previewer

 Chapter 7: Install Electionware

 Chapter 8: Electionware in a Multi-User Environment

 Chapter 9: Getting Started

 Chapter 10: Default Electionware Icons

 Chapter 11: Electionware Procedures
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Chapter 1: Overview

Electionware enables you to create elections for the ES&S DS200, ES&S DS850,ES&S 
ExpressVote, and ES&S AutoMARK. Within Electionware there are five groups and 
eleven modules. The content of this documentation is meant to mirror both the 
structure and the order of processes within Electionware. A brief description of these 
groups and their modules are listed below:

 Define - The Define group is used to input critical data for your election. Modules 
contained within the Define group are Home, Capture, and Element Library.

• Home - This module is the starting point within Electionware. Use Home to 
create, edit, and manage your elections.

• Capture - This module is used for entering important election-based information 
into the election database. Use Capture to enter precincts, districts, contests, 
candidates, parties, and other information pertinent to creating an election.

• Element Library - Store graphics in this module for use with ES&S AutoMARK, 
ES&S DS200, ES&S ExpressVote, and ES&S DS850. Or, manage system 
translations and audio for the ES&S AutoMARK and ES&S ExpressVote.

 Design - The Design group is used to design ballot and audio elements for your 
election. Modules contained within the Design group are Paper Ballot and 
Accessible Ballot.

• Paper Ballot - This module opens in a separate window and enables you to 
design paper ballots for use with the ES&S DS200, ES&S DS850, ES&S 
ExpressVote, and ES&S AutoMARK.

• Accessible Ballot - Format ballot display options as they will appear on the ES&S 
AutoMARK and ES&S ExpressVote and manage ADA audio settings for the 
ES&S AutoMARK and ES&S ExpressVote, validate data prior to generation of the 
ES&S AutoMARK and ES&S ExpressVote election files.

 Deliver - The Deliver group is used to configure equipment, package election data 
and print ballots on demand. Modules contained within the Deliver group are 
Configure Equipment, Package, and Print.

• Configure Equipment - This module enables you to add or edit polling 
information, set parameters and Access Codes for voting on the ES&S DS200, 
ES&S DS850, ES&S ExpressVote, and ES&S AutoMARK. You can also generate 
your election files for use with the ES&S DS200, ES&S DS850, ES&S ExpressVote, 
and ES&S AutoMARK.

• Package - Create media for use in the ES&S DS200, ES&S DS850, ES&S 
ExpressVote, and ES&S AutoMARK with this module. You can also create the 
Ballot File for the PollBook.

• Print - View and Print BOD (Ballot on Demand) ballots by precinct from the Print 
module.
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 Results - Modules in the Results group are used to load election results data, view, 
filter and export poll place and ballot records, view and print ballot scan images, 
facsimiles and Cast Vote Records, generate Media Status, Machine Log and Election 
Summary results reports, and optionally clear loaded results. Modules within this 
group are Acquire and Produce.

• Acquire - This module is used to load results files and view data related to media 
devices encoded for the election. Poll place records can be viewed and exported 
to file. Media Status and Machine Log reports can be viewed, saved to file or 
printed. If required, results loaded from selected media storage device(s) can be 
cleared from the database, or all loaded results can be cleared from the 
database.

• Produce - This module is used to filter, display and export ballot data from 
loaded results data. Ballot records can be viewed and exported to file. The scan 
images or facsimiles of ballots associated with selected ballot records can be 
viewed and printed. In addition, scan images of ballots and their Cast Vote 
Records can be viewed, printed and saved. The Election Results Summary 
report, which includes the results of all loaded ballots, can be viewed, printed or 
saved.

 Manage - The Manage group is used to manage users and jurisdictions in 
Electionware. Modules contained within the Manage group are Setup.

• Setup - This module enables you to add and edit users and jurisdictions, and set 
the strength of election codes. 

Note: Each module in Electionware enables you to generate reports to track event activity 
and work-flow.
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The following diagram illustrates how Electionware interacts with the various elements 
and stages of a typical election:
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ES&S Elections

Use ES&S software and hardware to create an election information database, format 
ballots, program ballot scanning equipment, count ballots, and generate Election Day 
reports. Election Systems and Software products and services enable you to customize 
and scale election processes to meet the needs of your jurisdiction.

In a typical ES&S election, jurisdiction officials or ES&S election specialists use Capture 
to create an election database for your jurisdiction. Ballot layout artists and election 
programmers use the election database to format ballots with the Paper Ballot and 
Accessible Ballot modules and program ballot scanning and/or tabulating equipment 
using the Configure Equipment and Package modules. On Election Day, poll officials 
collect paper ballots or monitor voting on precinct tabulators. Officials then transfer 
scanner data directly from polling places to their jurisdiction’s central election facility. At 
the central location, election officials use Election Reporting Manager to convert raw 
data from your ballot scanners into formatted election reports.

Jurisdictional Nomenclature

Terminology for the lowest-level common geopolitical civil division differs by state and 
country. In this manual and other ES&S documentation, the entity is referred to as a 
precinct. 

As a company with accounts across the country and around the world, ES&S recognizes 
that certain jurisdictions use terms other than precinct. Some examples of the terms 
used by other jurisdictions are Election District (or ED), Borough, Province, Division, and 
District. These terms and others may be substituted for precinct depending upon the 
particular jurisdiction. However, for consistency, ES&S uses the term precinct throughout 
its documentation.

Contact ES&S for Technical Support

This manual should aid you in accomplishing most tasks. However, if you need 
additional assistance, or if you encounter a processing problem or system error, ES&S’s 
technical support staff can provide advice and help you resolve the situation.

When you contact ES&S for technical support, be near your equipment. In addition, be 
prepared to provide the following information to the support representative:

 The version number of the product you are using (for example, Electionware version 
x.x).

 The exact wording of any messages that appeared.

 A description of what happened when the problem occurred.
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Support representatives are available Monday through Friday, between 8:00 A.M. and 
5:00 P.M. Central time. 

ES&S’s support services are subject to ES&S’s prices, terms and conditions in place at 
the time the service is used.

Contact an ES&S Support Representative:

Telephone: 877-377-8683 (USA & Canada)

402-593-0101 (International)

Fax: 402-593-8107

Write: Election Systems & Software

11208 John Galt Blvd.

Omaha, NE 68137 USA
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Chapter 2: System Requirements

The ES&S voting system supports the following computer, system, and equipment 
configurations. 

Standalone System - Each Microsoft Windows 7 based PC configuration is a single, 
dedicated Election Management System (EMS) workstation. These requirements are 
needed for all client workstations for every configuration.

Multi-User Locally Networked Client Server - This is a closed-networked system with a 
Microsoft Windows 2008 Server that is set up to support two or more client EMS 
workstations. 

Following are the hardware and software requirements for each equipment 
configuration option.

System Requirements for Standalone System and/or Client 
Workstations

 Dual core processor

 2 GB of RAM minimum, 4 GB of RAM recommended.

 500 GB hard drive or larger

 Keyboard

 Mouse

 Monitor with a resolution of 1024x768 or better

 CD/DVD Reader (must be able to read both) with a speed of 16x or faster

 Minimum of 2 USB 2.0 ports

 Ethernet port (only required if you are using a networked deployment)

Reference: For more information on multi-user functionality in a closed network 
environment, see Chapter 8: Electionware in a Multi-User Environment.

Note: The use of an Uninterruptible Power System, (UPS) and the utilization of a frequent 
data backup plan are recommended for any computer that has Electionware installed.

Reference: Software products need to be installed in the proper order. See Chapter 3: 
Before Installing Electionware and Associated Products for more information the order of 
installation.
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 USB Media - Depending on voting system configuration and supported tabulators:

• USB thumb-drive (DS200, DS850 and ExpressVote)

• USB CF drive (AutoMARK) 

 Installation Media for OEM drivers

 Printer attached to the individual PC

 Windows 7, Service Pack 1

 Microsoft Patches

System Requirements for the Server in a Multi-User Environment

 Dual core processor

 ES&S Electionware - Server

 2 GB of RAM minimum, 4 GB of RAM recommended.

 500 GB hard drive or larger

 Keyboard

 Mouse

 Monitor with resolution of 1048 x 768 (or better) 

 CD/DVD reader (must read both) – 16x (or faster) 

 USB 2.0 port – quantity 2 (or more) 

 Ethernet port

 Printer

 Installation media for OEM drivers

 Licensed installation media for Windows 2008 Server

 The media for Windows 2008 Server should be acquired from the OEM or directly 
from Microsoft

 Microsoft Server 2008

 Microsoft Patches
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Chapter 3: Before Installing Electionware and 
Associated Products

The installation of Electionware requires the installation of the PostgreSQL database 
software and the Java 6 Environment. The installation of these products is automatic, 
but it is recommended that before you begin installation, you should close all programs 
and turn off virus protection software to prevent conflicts.

Following is the order in which you should install each module if you have purchased a 
suite of products from ES&S. The Products in bold pertain only to Electionware.

Order of Installation for Electionware Suite

Product Location

Windows 7 Utilize the associated user documentation supplied with 
this software. Typically, this program is installed to its 
default directory.

Adobe Acrobat Standard 
version 9.0 or higher

Utilize the associated user documentation supplied with 
this software. Typically, this program is installed to its 
default directory.

RM/Cobol 12.06 RM Cobol must be installed prior to installing ERM. 
Refer to the ERM System Operating Procedures manual 
for installation instructions.

Event Logging Service Refer to the Event Logging Services System Operating 
Procedures manual for installation instructions.

Removable Media Service The Removable Media Service is required to create 
media in Electionware. See Chapter 9: Getting Started 
for installation instructions.

Election Reporting 
Manager (ERM)

Refer to the ERM System Operating Procedures manual 
for installation instructions.

VAT Preview The VAT Preview is optional, but should be installed 
prior to installing Electionware. See Chapter 5: VAT 
Preview for installation instructions.

ExpressVote Previewer The ExpressVote Previewer is optional, but should be 
installed prior to installing Electionware. See Chapter 6: 
ExpressVote Previewer for installation instructions.

Electionware See Chapter 7: Install Electionware for installation 
instructions.

Note: The products in the table above are required in order to fully utilize Electionware. 
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Chapter 4: Install Removable Media Service

The ES&S Removable Media Service must be installed before attempting to create 
media devices for the ES&S DS200, ES&S DS850, ES&S ExpressVote, or ES&S 
AutoMARK. Before you begin installation, close all programs and turn off virus 
protection software to prevent installation conflicts.

Install Removable Media Service

1. Click the My Computer icon on your desktop and select the drive that contains the 
installation files for Removable Media Service. 

2. Double-click RMU Setup.exe in the Removable Media folder to install the program.

The ES&S Removable Media Service - InstallShield Wizard window appears:

3. Review the information in the window, then click Next to continue.

The License Agreement window appears.

4. Select the I accept the terms of the license agreement radio button to accept the 
license agreement.

5. Click Next to open the Customer Information window.

6. Enter your name and your employer name in the User Name and Company Name 
fields respectively.

7. Click Next to open the Ready to Install the Program window.

8. Click Install to begin loading Removable Media Service onto the PC.

The InstallShield Wizard Complete window will appear when the installation is 
complete.

9. Click Finish to close the InstallShield Wizard.

Note: If you are not an administrator, be sure to right-click and run the program as an 
administrator.
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Chapter 5: VAT Preview

The VAT Preview may be installed prior to the installation of Electionware, but is not 
required. Before you begin installation, close all programs and turn off virus protection 
software to prevent installation conflicts.

Install VAT Preview

1. Click the My Computer icon on your desktop and select the drive that contains the 
installation files for VAT Preview. 

2. Double-click Setup.exe in the VAT Preview folder.

The VAT Preview InstallShield window appears.

3. At the VAT Preview - InstallShield Wizard screen, click Next.

4. Click Install to begin the installation.

A Status window will appear showing the progress of the installation.

5. Click Finish to exit the installation and close the Wizard.

Note: Although the installation of the VAT Preview is not required, the system will alert you 
to its absence during the installation process.
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Chapter 6: ExpressVote Previewer

The ExpressVote Previewer may be installed prior to the installation of Electionware, but 
is not required. Before you begin installation, close all programs and turn off virus 
protection software to prevent installation conflicts.

Install ExpressVote Previewer

1. Click the My Computer icon on your desktop and select the drive that contains the 
installation files for ExpressVote Preview. 

2. Double-click Setup.exe in the ExpressVote Previewer folder.

The ExpressVote Previewer InstallShield window appears.

3. At the ExpressVote Previewer - InstallShield Wizard screen, click Next.

4. When the License Agreement information appears, read through the licensing 
information, and then either select I accept the terms of the license agreement to 
continue, or I do not accept the terms of the license agreement to cancel the 
installation. Click Next to continue.

5. Once the Ready to Install the Program window appears, click Install to continue.

A Status window will appear showing the progress of the installation.

6. Click Finish to exit the installation and close the Wizard.

Note: Although the installation of the ExpressVote Previewer is not required, the system 
will alert you to its absence during the installation process.
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Chapter 7: Install Electionware 

1. Click the My Computer icon on your desktop and select the drive that contains the 
installation files for Electionware. 

2. Double-click ElectionwareInstaller.exe to begin the installation.

The Electionware InstallShield window appears.

3. At the ES&S Electionware - InstallShield Wizard Welcome screen, click Next.

4. When the license agreement appears, select the I accept the terms of the license 
agreement radio button to accept the license agreement.

5. Click Next to open the Customer Information window.

6. Enter your name and your employer name in the User Name and Company Name 
fields respectively. 

7. Click Next to open the Setup Type window.

8. Select from the following options:

• Electionware - All Components - Select this option if you want to install all 
components of Electionware on a single computer. Electionware will only be 
installed in a single-user configuration and will be accessible only from this 
computer. Go to Step 9 to proceed.

• Electionware - Client - Select this option if you want to install the client 
component of Electionware. This configuration will require you to access an 
Electionware server, installed on another computer. Go to Step 10c to proceed.

• Electionware - Server - Select this option if you want to install the server 
component of Electionware. This configuration only installs server information, 
and requires users to log on to the server from client consoles. Go to Step 9 to 
proceed.

9. Click Next to continue.

Installation Configuration

If the All Components or Server installation options is selected, Electionware 
determines whether one, or multiple hard drives are present, and then calculates the 
total drive size.

If the All Components or Server options are selected, you will then be prompted to 
enter a Database Super User Password: 

Note: If the multiple drives are available, you will be prompted to select the data and 
working drives. The data drive is where image and election files are archived. The working 
drive is where working files (such as those used with the Results group) are stored. Use the 
available drop-down menus to select the appropriate drives for each. ES&S recommends 
that the larger drive is used as the data drive, and the smaller drive be used as the working 
drive.

If the system only has one drive, the screen mentioned above is bypassed.
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9a.  You have the option to either enter the database super user password for the 
database user, or leave this field blank to use the system-generated password.

9b.  If you choose to enter a password, confirm it by re-entering the password in the 
Confirm Password field.

9c.  Click Next to continue with the installation.

Client Installation

If instead you selected the Client configuration in step 9, the adjacent window will 
appear:

10. In the available field, enter the IP address of the Electionware server. Click Next to 
continue.

Finalizing Electionware Installation

After selecting the Electionware configuration to be installed, the License File 
window appears.

The license file is used by Electionware to determine the modules that will be 
available to the user. Verify that you have the proper license file before proceeding.

11. Enter the target path for the license file in the available field, then click Next to 
continue.

DS850 Network Setup

12. At this stage of the installation, you will be prompted to select whether or not to 
utilize DS850 networking. 

Select Yes to utilize DS850 networking, or No to not utilize the service.

13. Click Next to proceed. 

If DS850 Networking is selected, the Results Location screen appears.

14a. From the drop-down menu, select the data drive of the FTP server where the 
DS850 results will be stored.

Warning: Do not lose this password. If you lose this password, you will lose the ability to 
perform any database administration functions or to upgrade Electionware.

Note: If you have selected the Server installation type, the following three screens do not 
appear. Skip to step 16 to continue.
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15. Once the appropriate drive has been selected, click Next to continue.

If No is selected, the installation continues on, and the Ready to Install Program screen 
appears.

16. After the Ready to Install Program window appears, click Install to begin loading 
Electionware onto the PC.

The Setup Status window shows a status bar until the installation is complete. 

During this installation, the Electionware system, as well as PostgreSQL are being 
installed. Status bars will appear as each of these items is installed.

Depending on the speed of the computer, the installation may take some time. Do not 
restart or shut off the PC during the installation process.

17. When Complete, the InstallShield Wizard Complete window will appear.

18. Click I would like a shortcut created on my desktop, to create a shortcut to the 
Electionware program on your desktop.

19. Click Finish to close the InstallShield Wizard.

20. Restart the PC prior to using Electionware.

System Acquisition Procedures

Once you have installed Electionware, make sure your version matches the version listed 
on the purchase order. After opening Electionware, check the version number by using 
the following steps: 

1. From the Help menu, click on About Electionware. 

Note: If the system contains multiple drives, make sure that the FTP drive selection 
corresponds with the data drive selection made for Electionware. If the system only contains 
one hard drive, then the above screen does not appear.
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The About Electionware window 
appears:

2. Verify that the version number at the 
top of the About Electionware 
window matches the version number 
on your purchase order. 

Verify: Contact ES&S customer 
support if the Version number on 
your software does not match the 
purchase order.
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Chapter 8: Electionware in a Multi-User Environment

Multi-user Electionware functionality enables large jurisdictions to use authorized 
election personnel to simultaneously create precinct media devices and enter 
information for the ES&S DS200, ES&S DS850, ES&S ExpressVote, and ES&S 
AutoMARK, and Election Reporting Manager. Additionally, the multi-user functionality 
in Electionware allows multiple teams of election officials to simultaneously work on 
different elections. Several reports exist within the Package module, enabling you to 
determine precinct device creation. This is a great advantage to large jurisdictions, who 
are able to enter data and create media rapidly with many users. 

Pressing the Refresh button at certain points in these processes will allow updated data 
to be viewed for multiple users. 

Electionware supports multi-user functionality in a networked environment, however a 
few menu and dialog actions are not multi-user enabled due to application and data 
integrity considerations. Therefore, the following actions listed in the table below are 
only available in single-user mode. 

Note: The “Action Location” column demonstrates one method of accessing the 
single-user abilities of Electionware. Other access methods exist using the Modules panel 
or the Toolbar.

Single-User Action Table

Electionware Single-user Only Actions Action Location in the Electionware Menu Structure

Import Election information using the 
Import Election Data option.

1. Modules > Define > Capture 

2. Tools > Import Election Data

Paper Ballot Modules > Design > Paper Ballot

Import Translations 1. Modules > Define > Element Library > 
2a. Tools > Import AutoMARK System Translations

2b. Tools > Import ExpressVote System Translations

Import System Audio Recordings 1. Modules > Define > Element Library 

2a. Tools > Import AutoMARK System Audio Recordings 

2b. Tools > Import ExpressVote System Audio 
Recordings 

Import Ballot Audio Recordings 1. Modules > Design > Accessible Ballot

2. Tools > Import Ballot Audio Recordings
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Before the single-user action is performed, the system confirms there is no other user 
accessing the election. If another user is accessing the election, the single-user action 
fails and a message appears stating that the election is being accessed by other users. 

For the single-user action to be performed successfully, secondary users must log out of 
that election while the single-user action is performed. Until the single-user action is 
complete, the election is unavailable to other users. 

Multi-User Functionality in a Closed Network Environment

A closed network consists of a stand-alone server that is used for a specific purpose, 
such as an EMS (Election Management System), and to which access is restricted to 
specific workstations and users and not connected to any other internal or external 
network. Only (EMS) Election Management System components are allowed on this 
network and specifically forbid any voting system component at a precinct voting site 
from being connected.

DS200 Election Data, DS850 Election 
Data, ExpressVote Election Data, and 
AutoMARK Election Data.

1. Modules > Deliver > Configure Equipment 

2a. Tools > Generate DS Election Data

2b. Tools > Generate Accessible Equipment Election 
Data

Note: The single-user actions apply separately to each election.

Security: Election Systems & Software recommends only using Electionware within a 
closed network environment to enhance election security.

Reference: See the system requirements for a multi-user environment in System 
Requirements for the Server in a Multi-User Environment.

Single-User Action Table
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Chapter 9: Getting Started

This chapter provides information about how to work within Electionware.

Start Electionware

1. From the Windows Start menu, point to All Programs, select ES&S, and click 
Electionware 4.6.0.0. 

The Login window appears.

2. Enter your user name in the User Name field.

3. Enter your password in the Password field.

4. The main Electionware window appears.

Note: For optimal viewing of Electionware, a minimum screen resolution of 1280 x 1024 is 
recommended. 

Note: Electionware shuts down after three failed attempts. If you bring Electionware back 
up, it keeps shutting down after each failed attempt. Once you get the password correct, 
the count resets, giving you three tries the next time.
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Electionware Workspace

The Electionware window can be customized to fit your needs. Panes within the window 
can be resized and combined to allow for greater workspace.

 Title Bar - The Title Bar states the name of the currently opened election and 
Electionware module.

 Menu Bar - The Menu Bar contains menus that correlate to the selected module.

 Toolbar - The Toolbar contains buttons that open commonly used Electionware 
features.

 Module Selector Pane - The Module Selector Pane enables the selection of various 
modules.

 Navigator Pane - The Navigator Pane list. The Navigation Pane title bar has 
right-click options for current lists (if available) in that navigation view.

 Work Space - The Work Space contains forms, screens, and reports.

 Quick Help Pane- The Quick Help Pane displays basic how-to assistance regarding 
the screen open in the Work Space. 

 Work Space tabs - Click on the Work Space tabs to toggle between screens in the 
work space.

Warning: Selecting a Windows shortcut from a File Browser window should be avoided 
whenever possible. Selecting a shortcut from the browser may cause Electionware to exit 
abnormally. 
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Navigator Pane

The Navigator pane is an essential tool used in almost every module of Electionware. 
You will note that the Navigator contains three distinct sections:

 The Navigator tool bar - This 
tool bar contains quick keys 
for performing various 
functions.

 The Navigator tree - This tree 
displays a hierarchical 
structure dependent upon the 
selected module. Utilize the 
(+) and (-) symbols to expand 
and retract items in the tree. 
The items in the tree can also 
be used for many procedural 
shortcuts.

 The Navigator buttons - These 
buttons are used to quickly 
navigate to different 
Navigator pane views within 
the same module. These views 
directly affect both the 
Navigator tool bar and the 
Navigator tree.
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It is critical to note that the Navigator changes to reflect the selected module, as 
demonstrated in the graphic below:

Report Screen Toolbar

Each module within Electionware offers its own collection of individual reports. These 
reports appear in the work space, and can be saved, viewed and printed all by utilizing 
the report screen toolbar. Use the report screen toolbar to save, print, scroll through 
pages, and change the view of the report currently displayed. Use the following 
information for reference on how to use the Report Screen Toolbar.

Saving and Printing Reports

To access the Report Screen Toolbar, use the Reports menu to produce reports specific 
to the module you are currently using.
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Upon displaying the report in the work space, the report screen toolbar becomes 
available:

At the top left of the Report Screen 
Toolbar are the Print and Save icons.

Use the Save icon to save the report 
currently displayed in the Report Screen. Electionware reports may be saved as (.pdf, 
.rtf, .html, .xlsx or .csv) formats. Click the Save icon.

A browser window appears:

Enter a file name that describes the report in the File name field, and click Save Report 
File.

Use the Print icon to print a hard copy of a 
report. The Print window appears:

Select the printer of your choice from the 
Name drop-down menu.

You can choose to print all pages by selecting 
All from the print range window. Or, you can 
select a specific page range by selecting 
Pages, and entering the desired page numbers 
in the from and to fields.

Select the number of copies you wish to print from the Number of copies cell. You may 
enter the number of copies you wish manually, or you can use the up or down arrows to 
increase or decrease the number of copies respectively.

Select Collate if you wish the report pages to print in sequential order.

Note: Reports are defaulted to save in the (.pdf) format.
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Click Cancel to cancel the print job and close the Print window. Or, click OK to accept 
the print job and return to the Electionware window.

Page Selection Arrows

Use the page selection arrows to navigate through the report pages sequentially, or to 
jump to the beginning or end of the report. 

Click the Previous Page arrow to move one page backward in the report. 

Click the Next Page arrow to move one page forward in the report.

Click the First Page arrow to skip to the first page. 

Click the Last Page arrow to skip to the last page.

Or, use the Go To Page field to skip to a specific 
page in the report. You can also use this field to 
check the number of the currently displayed 
page.

Note: The print option can be used to create soft copies of a report as well. Use the Name 
drop-down list to select Adobe PDF option if Adobe 9.0 or higher is installed. Otherwise 
select Print to file from the drop-down menu.
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Changing the On screen Report View

Use the page size and zoom icons to change the way that the on screen report is 
currently displayed. 

Use the Actual Size icon to view the report in its actual size.

Use the Fit Page icon to make the report fit the page to the size of the current screen.

Use the Fit Width icon to make the report fit to the width of the current screen.

Use the Zoom In icon to zoom in on the report.

Use the Zoom Out icon to zoom out of the report.

Use the Zoom Ratio drop-down menu to manually select the size of the report on 
screen. The Zoom Ratio ranges from 50% to 800%. Select from the available 
percentages, or enter a manual percentage in the box

Window Menu Options

The Window menu enables you to manipulate many of 
the physical aspects of the Electionware workspace. Use 
the information found below to help customize the 
Electionware workspace so that it better suits your needs.
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Home Page

The Home Page options enables you to 
quickly navigate to the Electionware 
home page. This home page is also one 
of the two locations where you can 
acquire the version number for your copy 
of Electionware. From this screen you 
can select from various options to 
perform numerous functions.

Election Status

The Election Status screen 
shows you information as it 
pertains to the selected 
election. Use the status screen 
to gain valuable information 
regarding the election name, 
state and county, election 
description, template applied, 
date of the election, and 
election type. Further, use this 
page to review the list of 
modules in Electionware, and 
whether these modules have 
been used to modify the 
selected election. The time and 
date stamp is updated to reflect when any modifications took place. The user who made 
modifications is included as well.
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Module Status

The Module Status screen shows you information as it pertains to the selected module. 
Use the status screen to gain valuable information regarding various module 
information. Information in this area includes the module, whether that module was 
used to modify the election, and the time and date stamp for when the modification 
took place.

Output 

The Output panes display log events and exception messages in Electionware. To 
access the Output pane, select Window, point to Output, then choose one of the 
following:

 Output - Displays Event and Exception messages under separate tabs.

 Events - Displays Event messages only.

 Exceptions - Displays error messages only.

 Ballot Style Generation - Displays Ballot Style Generation information, warnings, and 
errors.

Note: Module Status is available in every module except Home. The information within the 
module status screen changes depending on which module is selected.
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Quick Help

Select Window, then Quick Help to display the Quick Help 
pane for the current screen.

Navigator

Select this option to display the Navigator pane on the 
main screen.

Note: If the Navigator pane is already displayed, 
selecting this option has no effect.
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Module Selector

Select this option to display the Modules pane in the Electionware 
main window.

Close Window

Select this option to close the most recent window that was opened.

Maximize Window

Select this option to maximize the most recent window that was opened. 

Undock Window

Select this option to undock any window and make it movable. First, click on the 
window you want to undock, then select Undock Window from the Window menu. To 
return the window to its locked position on the main screen, select Dock Window. 

Close All Documents

Select this option to close all documents on the main screen of Electionware.

Close Other Documents

Select this option to close all documents other than the one most recently opened.

Note: If the Module pane is already displayed, selecting this 
option has no effect.
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Documents

Select this option to open a window that lists all currently opened documents within a 
module.
From here, you can highlight a 
document and click Switch to 
Document to go directly to the chosen 
document. (This can also be done by 
clicking the tab of that document.) You 
can also close a document by 
highlighting the document and clicking 
Close Document. Documents can also 
be saved at this screen; if there are 
unsaved changes, the Save 
Documents button will appear.

Click Close to exit this screen.

Reset Windows

Select this option to reset all windows back to the default setup.

Moving Panes

The panes of the Electionware window can be moved to increase the amount of work 
area in the window. 

Combine Panes As Tabs

Panes can be combined to create a tabbed pane, thus creating a greater amount of 
workspace.
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1. Click and drag the pane toward its target location. 

2. When an orange tabbed outline appears in the pane, release the 
button. The two panes appear as tabs.

Stack Panes

Panes can be combined to create more space.
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1. Click and drag the pane toward its target location.

2. When a red outline that does not extend the length of the pane 
appears, release the button. The two panes will merge into a 
stacked formation.



 Chapter 9: Getting Started 37

EVS5200_DOC_SOP_EW01ADMIN
 Software Version 4.6

 Published: April 24, 2014

Undock Panes

Panes can be undocked to create a separate window.

1. Select a pane in the Electionware Window.

2. From the Window menu, select Undock Window.

3. The new window can be moved anywhere on the screen 
by clicking and dragging on the top bar.

4. From Window menu, select Dock Window to place the 
pane in its previous spot.

Help Menu

Electionware contains several help features. Quick Help is a screen-level help system 
designed to give an overview of a selected screen or task. The Electionware Help 
system is designed to assist with the broader tasks in the application. The User Guide is 
used to reference the Electionware manual at any time.

Help System

Use the Help System option to open an intuitive help system within the Electionware 
program. This help system is based on an interrogative format. Enter questions 
regarding a process in the search engine, and the system will provide those topics which 
reflect the question you provided. You can also access topics by clicking in the left pane 
on a module and selecting a specific question from there. 

1. From the Help menu, click Help System. 
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The Electionware Help system opens 
in an external Internet Explorer 
window. Depending upon your 
Internet Explorer security settings, a 
security warning may appear at the 
top of the window.

2. If you receive a security warning, right-click on the warning 
and select Allow Blocked Content.

3. When prompted, select Yes to activate the necessary ActiveX controls.

The Electionware Help system becomes available:

4. If your EMS computer has 
internet access, click the 
ES&S logo to navigate to the 
ES&S website.

5. Click the Contents button in the upper left corner of the 
Overview window for a list of topics in the Electionware Help 
system. 
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The contents are organized by Group, then 
Module, then procedural questions.

6. Click Index to view the Electionware Help system’s index of key 
terms.

7. At the top of the Index pane, enter a key word in 
the Type in the Keyword to find field to locate 
that keyword in the Index.

8. Click Search to search through the help system for specific topics.

9. In the Type in the word(s) to search for field, type the 
word or words to search, then click GO.

• Or, use the Search field in the upper right hand 
corner to enter the word or words to search, then 
click GO.

10. Click Glossary to open the Electionware Help system’s glossary of 
terms.
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11. Click on a word or phrase in the Term frame to open the 
definition in the Definition frame.

The Electionware Help system also contains what are known as Glossary Hotspots. 
When viewing a topic, look for italicized words or phrases in a maroon font:

Click on the term within the topic, 
to expand the term’s definition 
there on the page:

The help system also contains 
multimedia demonstrations in 
various locations. When you come 
across a button labeled Show Me, click on the button to begin the multimedia 
demonstration. If the video does not start, click on the available hyperlink.

12. Close the Internet Explorer window to close the Electionware Help system.

User Guide PDF

The User Guide is an electronic copy of Electionware’s System Operation Procedures 
manual. Use the User Guide PDF option to read through specific portions, or the 
entirety of the user guide from an Adobe Reader window.

From the Help menu, click User Guide PDF to view the Electionware 
System Operations Procedures manual. This document is a 
comprehensive manual covering the entire Electionware program. 
When selected, an external Adobe Acrobat window opens displaying 
the Electionware manual in a PDF format. 
There are two panes in the User Guide window. The left pane is a navigation window 
that contains bookmarks to individual chapters and headings. These bookmarks will 
guide you to specific areas that may be beneficial to you during the creation of your 
election.

The right hand pane contains the actual content of the Electionware manual. Read 
through this information to acquire helpful hints regarding the functionality of 
Electionware. 
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To obtain specific information from a section in the left pane, click the + sign next to the 
part, chapter, or section you want to view. For example, to view information about the 
Capture module, click + on “Part 2: Capture.” This will then become a - sign and display 
the chapter headings below. Select the topic you want to view.

Close the document to return to the Electionware window you were previously viewing.

About Electionware

Use the About feature of the Help menu to review information about your copy of 
Electionware.

From the Help menu, click About Electionware to view the disclaimer 
and copyright information for Electionware. The following window 
appears.

Read the information in this window and click OK 
to return to the Electionware window you were 
previously viewing.
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Chapter 10: Default Electionware Icons

The icons at the top of the Electionware screen can be used as shortcuts to Electionware 
menu options. The available icons change depending on the module you are currently in. 
Listed here are only those icons that are available in every module in Electionware.

Icon Action Name Description

List Elections View the list of elections that have been imported into a 
selected county in Electionware.

New Election Create a new election and import data into 
Electionware. 

Edit Election Edit an existing election. 

Backup Election Create a backup copy of your election.

Restore Election Restore an election you have previously backed up.

List Election Templates List a county’s election templates.

Edit Election Template Edit an existing election template.

Save as Template Save an election as a template.

Backup Election Template Backup an election template.

Restore Election Template Restore an election template you have previously 
backed up.

Home Page Return to the Home tab of Electionware. 

User Preferences Change your user preferences. 

Help System Open the Electionware help system.

Refresh Navigator Refreshes the Navigator pane to reflect edited and or 
deleted items.
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Chapter 11: Electionware Procedures

This section is intended to be a general overview of the steps necessary to create an 
election and load and view election results using Electionware. Many of the processes 
listed below have been abbreviated for the purposes of this book. For more detailed 
instructions regarding any of the processes listed here, see the volumes and sections 
referenced below.

Install Removable Media Service

If this is the first time you are using Electionware to create a media device, you must 
install Removable Media Service on your PC.

Install VAT Preview

If this is the first time you are using Electionware, you should install VAT Preview on your 
PC prior to installing Electionware. Although the installation of VAT Preview is not 
required, the system will alert you if it is missing during the installation process.

Install ExpressVote Previewer

If this is the first time you are using Electionware, you should install ExpressVote 
Previewer on your PC prior to installing Electionware. Although the installation of 
ExpressVote Previewer is not required, the system will alert you if it is missing during the 
installation process.

Reference: See Chapter 4: Install Removable Media Service for instructions on installing 
Removable Media Service. 

Reference: See Chapter 5: VAT Preview for instructions on installing VAT Preview.

Reference: See Chapter 6: ExpressVote Previewer for instructions on installing 
ExpressVote Previewer.
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Install Electionware

If this is the first time you are using Electionware, you must install it on your PC.

Start Electionware

1. Start Electionware.

Setup Module

The Add State, Add County, Add Users, 
Customize Labels, Set Election Code 
Strength, and Set Password Policies options 
are all found in the Manage module. 
Although this module is at the bottom of the 
Modules pane, it is the very first module you 
will utilize after installing Electionware.

Use the steps found in the following 
procedures to help you set up your 
jurisdiction specific information, as well as 
any password policies, prior to beginning 
your initial work in the Capture module.

Add State

The Add State feature enables you to add a state node to the jurisdiction view of the 
Navigator pane. Use state nodes to categorize counties by their home states.

1. From the Modules menu, select Manage and click Setup.

2. From the Navigator pane, select the Jurisdictions button.

Reference: See Chapter 7: Install Electionware for instructions on installing Electionware.

Reference: See Chapter 9: Getting Started for instructions about starting and working in 
Electionware.
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3. From the Jurisdiction menu, click Add State.

4. Enter the state name in the State Name field.

5. Enter any additional information about the state in the Additional Text field.

6. Click Clear to clear any unsaved information.

7. Once you have finished editing your jurisdictional information, click Save at the 
bottom of the Add State screen.

8. Click Close on the Add State screen to finish adding state information.

Add County

The Add County feature enables you to add county nodes under existing state nodes. 
Use county nodes to create election databases.

1. From the Modules menu, select Manage and click Setup.

2. From the Navigator pane, select the Jurisdictions button.

3. From the list of available jurisdictions in the Navigator pane, select the state for the 
county.

4. From the Jurisdiction menu, click Add County.

5. Enter the county name in the County Name field.

6. Enter any additional information about the county in the Additional Text field.

7. Click Clear to clear any unsaved information.

8. Once you have finished editing your jurisdictional information, click Save at the 
bottom of the Add County screen.

9. Click Close on the Add County screen to finish adding state information.

Add Users

The Add Users feature enables you to add authorized users to your copy of 
Electionware. There are several different Access Levels for users, and a user’s access 
level delineates the functions they will be authorized for. Keep this information in mind 
when adding users to the Electionware system.

1. From the Modules menu, select Manage and click Setup.

Reference: See Chapter 14: Manage Jurisdictions for instructions about adding a state to 
Electionware.

Reference: See Chapter 14: Manage Jurisdictions for instructions about adding a county to 
Electionware.
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2. From the Navigator pane, select the Users button.

3. From the Manage menu, click Add User.

4. Enter the user’s first name in the First Name field.

5. Enter the user’s last name in the Last Name field.

6. Enter the user’s ID in the Login ID field.

7. Select the user’s access level from the Access Level drop-down menu.

8. Enter the user’s password in the Password field.

9. Re-enter the user’s password in the Confirm Password field.

10. Select the user’s status from the Status drop-down menu.

11. Click Clear to clear any unsaved information.

12. Once you have finished adding users, click Save at the bottom of the Add Users 
screen.

13. Click Close on the Add Users page to finish adding users.

Customize Labels

The Customize Labels feature enables you to add or customize the nomenclature for the 
term precinct and/or split. Although the majority of users utilize the term precinct as a 
definition for the lowest common denominator for a voting location, not all states utilize 
this term. Therefore, if your jurisdiction uses a term such as borough or parish, use this 
option to change the term precinct to the appropriate verbiage for your jurisdiction.

1. From the Modules menu, select Manage, and then click Setup.

2. From the Tools menu, select Customize Labels.

The Label Customization screen appears.

3. Enter the new name for the list of available items in the New Label column.

For instance, in the New Label column, enter Election District in the cell adjacent to 
Precinct.

In the cell next to Precincts, enter the term Election Districts to represent the 
pluralized form of the term.

4. Proceed through the list until all necessary labels have been customized.

5. When finished, click the Save button to save your changes.

Reference: See Chapter 15: Manage Users for instructions about adding users to 
Electionware.

Reference: See Chapter 15: Manage Users for more information on customizing precinct 
name information.
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Set User Password Policies

The Set User Password Policies feature enables you to set password policies for 
individual users. Use this option to stipulate the number of days a user’s password 
remains valid. 

Set Election Code Strength

Set Election Code Strength enables you to set the election code strength for ES&S 
DS200, ES&S DS850, ES&S ExpressVote, and ES&S AutoMARK. Follow the steps below 
to access the Election Code Strength screen.

1. From the Manage menu, click Set Election Code Strength. 

The Election Code Strength screen appears in the work pane.

2. Use the slider bar at the left-hand side of the screen to adjust the Election Code 
strength.

3. The slider bar allows for three settings: High, Medium, and Low. 

 High: The Election Code you define must contain 8-16 characters and have at least 
three of the four listed characteristics:

• Upper case letters (A-Z)

• Lower case letters (a-z)

• Numerals (0-9)

• Punctuation symbols ‘ ~ ! @ # $ % ^ & * ( ) = + , . / < > ? ; : “ [ ] { } | 

 Medium: The Election Code must contain 6-16 characters and at least one letter and 
one number.

 Low: The Election Code must contain 4-16 characters.

Reference: See Chapter 16: Set User Password Policies for instructions on setting user 
password policies in Electionware.

Note: In order to access the Set Election Code Strength feature, an election must be 
selected.

Note: The ‘-’ (hyphen) is the only symbol available for the ES&S AutoMARK Election Code.
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After you have selected your Election Code strength, click Save if you want to save the 
new Election Code Strength setting. Select Refresh to discard the change made on the 
screen and reset the value to the one last saved, or select Close to exit the screen.

Vacuum Analyze

The Vacuum Analyze option, enables Electionware to inspect the database for empty 
placeholders. Use this option prior to the Vacuum Full option, as this will enable the 
system to recognize empty placeholders prior to removing them.

To run the Vacuum Analyze option, use the following steps:

1. From the Tools menu, point to Database Maintenance and then select Vacuum 
Analyze.

The system automatically starts the database analysis. You will be prompted when the 
process is complete. To check for messages, be sure to scan the Output-Events portion 
of the screen for any important information.

Vacuum Full

The Vacuum Full option goes through the database and eliminates all of the empty 
placeholders found during the Vacuum Analyze scan performed previously. Use this 
option after deleting information from the election to clean out empty placeholders, 
thereby freeing up space within the database, and helping to prevent potential errors.

To run the Vacuum Full option, use the following steps:

1. From the Tools menu, point to Database Maintenance and then select Vacuum Full.

The system automatically starts the vacuum process. You will be prompted when the 
process is complete. To check for messages, be sure to scan the Output-Events portion 
of the screen for any important information.

Note: The Vacuum Analyze option is only enabled if an election is open.

Note: The Vacuum Full option is only enabled if an election is open.
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Home Module

The Home module is where election management, election template management, and 
election equipment selection options take place. This is also the location where 
Electionware will open, each and every time the program is started.

Use the steps found in the following procedures to help you create or edit an election, 
create a template from an existing election, or select the equipment types to be used 
with the selected election.

Create New Election

The New Election option enables you to create a new election. Use this feature to name 
and set options for any new elections.

1. From the File menu, click New Election. 

• Or, from the Navigator pane, right-click on a county and select New Election.

The “New Election” window appears.

2. In the Election Name field, type the name of your election. 

3. If applicable, from the Election Template drop-down menu, select the election 
template you want to apply to the new election. 

4. Click Next. A status bar appears while Electionware creates the new database.

The Election Information screen appears.

5. From the State Name drop-down menu, select the state the new election will be 
created for.

6. From the County Name drop-down menu, select the county the new election will be 
created for.

7. Enter a descriptive name for the election in the Election Description field.

8. Enter an abbreviated name for the election in the Election Abbreviation field.

9. From the Election Type drop-down menu, select the proper type for the election. 
Selections for election types include General/Other, Open Primary, and Closed 
Primary

10. Click the Election Date drop-down menu to select the date for the election.

11. From the State Name drop-down menu, select a state. 

Note: A county must be selected in order to create a new election.

Reference: The State Name and County Name fields are populated with information 
entered in Manage. To learn more about adding states and counties, see Chapter 14: 
Manage Jurisdictions



 Chapter 11: Electionware Procedures 50

EVS5200_DOC_SOP_EW01ADMIN
 Software Version 4.6

 Published: April 24, 2014

12. From the Rules Profile drop-down menu, select the state that applies to the 
election. The selected state will define the rules that will be used for election setup 
and support.

13. Enter the jurisdiction ID in the Jurisdiction ID field. 

14. Enter the Tape and Report names in the Tape Name and Report Name fields. These 
fields will specify how the election name appears on tape and report headings.

15. Enter the alternate IDs for the election in the Alternate ID 1 and Alternate ID 2 
fields.

16. In the Results Folder Name field, enter the name of the results folder. This is a 
required field, and must be entered prior to proceeding to the next step.

17. Select a folder for the election database by clicking the Browse button adjacent to 
the Election Folder Name field.

18. Click Next to continue. 

The Election Options screen appears.

19. Under Precinct ID Options, select either System Generated Precinct ID, or User 
Entered Precinct ID. 

20. Enter any additional information for the election in the Additional Information 
table. 

21. Enter any notes pertaining to the election in the Election Notes field.

22. Click Finish to create the new election.

23. If election creation is successful, you will automatically be returned to the main 
Electionware window. The new election will appear in the Navigator Pane.

Equipment Selection

The Equipment Selection option is where you will select the specific election equipment 
to be used. Use this feature to select or deselect specific equipment types for your 
election.

1. From the modules menu, select Define and click Home.

Note: If additional information is entered for the English text, it must also be entered for 
each of the languages in the election. Select the language tabs from the top of the 
Additional Information section to populate these fields:

Note: If the election creation is unsuccessful, a prompt detailing the reason will appear. 
Click OK to return to the main Electionware window.
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2. From the Tools menu, click Equipment Selection.

3. Select the desired equipment to be used by clicking the appropriate check boxes.

4. If applicable, select Election Day Equipment for the appropriate equipment type(s).

5. If applicable, select Early Vote/Absentee Equipment for the appropriate 
equipment types.

6. Click Refresh at the bottom of the Equipment Set Up screen to clear any unsaved 
information.

7. Once you have completed selecting the equipment types, click Save at the bottom 
of the Equipment Set Up screen.

8. Click Close on the Equipment Set Up screen to finish selecting equipment types.

Capture Module

The Capture module is where all of the 
necessary data entry for an election is 
performed. Items such as languages, 
districts, precincts, contests, candidates, and 
ballot sets can all be found in this module. 
Once an election is created, this will be the 
first stop in the overall election creation 
process.

Add Languages

The Add Language option is a language 
option found in the Capture module. This 
option enables you to add languages to the current election. These languages can later 
be grouped for application to particular precincts.

1. From the Modules menu, select Define, then click Capture.

2. From the bottom of the Navigator pane, click the Languages button.

3. From the Manage Menu, point to Languages and click Add Languages.

• Or, right-click on Languages in the Navigator pane, select add, and then click 
Add Languages.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 5: Equipment 
Selection for information about selecting election equipment.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 9: Languages for 
information about adding languages.
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4. From the Languages drop-down menu, select from the available languages:

5. If applicable, edit the language name in the Language Name field.

6. If applicable, edit the translated language name in the Translated Name field.

7. Enter any additional information in the Additional Information field.

8. Enter alternate IDs for the language in the Alternate ID 1 and Alternate ID 2 fields.

9. Once you have finished adding the new language, click Save at the bottom of the 
Add Language screen.

10. Click Close to close the Add Language screen.

Add Audio Languages

The Add Audio Language is the other language option found in the Capture module. 
This option enables you to add audio languages to be used with accessible equipment 
such as the, ExpressVote, and AutoMARK equipment types.

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the Languages button.

3. From the Manage Menu, point to Languages and click Add Audio Languages.

• Or, right-click a language in the Navigator pane and click Add Audio 
Languages.

4. Select the language for which the audio language will apply from the Screen 
Language drop down menu.

5. Enter the audio language name in the Audio Language Name field.

6. Enter the translated language name in the Translated Name field.

• English • Japanese

• Spanish

• Chinese

• Korean

Note: Alternate IDs are utilized for the import and export to external systems. These fields 
are limited to 22 characters.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 9: Languages for 
information about adding audio languages.
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7. If applicable, enter alternate IDs for the audio language in the Alternate ID 1 and 
Alternate ID 2 fields. 

8. Enter any additional information in the Additional Information field.

9. Click Clear at the bottom of the Add Audio Language screen to clear any unsaved 
information.

10. Once you have finished adding the new audio language, click Save at the bottom of 
the Add Audio Language screen.

11. Click Close on the Add Audio Language screen to finish adding audio languages.

Add Language Groups

The Add Language Groups option is found in the Capture module. This option enables 
you to group the languages added in the previous steps. These language groups are 
then applied to specific precincts for use. This insures that only those precincts using a 
specific set of languages have those languages written to the election media. 

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the Languages button.

3. From the Manage Menu, select Add Language Groups.

4. Enter the name of the language group in the Language Group Name field.

5. Select the languages to be combined in the language group by clicking in the check 
box next to the appropriate languages.

6. If applicable, enter alternate IDs for the audio language in the Alternate ID 1 and 
Alternate ID 2 fields. 

7. Once you have finished adding the new language groups, click Save at the bottom 
of the Add Language Group screen.

8. Click Close on the Add Language Group screen to finish adding language groups.

Note: Alternate IDs are utilized for the import and export to external systems. These fields 
are limited to 22 characters.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 10: Language Groups 
for information about adding language groups.

Note: Alternate IDs are utilized for the import and export to external systems. These fields 
are limited to 22 characters.
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Add Parties

The Add Parties option is found in the Capture module. This option enables you to add 
parties to the election. 

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the Parties button.

3. From the Manage Menu, select Add Parties.

4. Enter a name for the party in the Party Name field.

5. Enter the party abbreviation in the Party Abbreviation field.

• Optional: select the Major Party option if applicable.

6. Enter the tape name in the Tape Name field.

7. Enter the report name in the Report Name field.

8. Enter the alternate identification for the party in the Alternate ID 1 and Alternate 
ID 2 fields.

9. If applicable, click Browse next to the Party Graphic File field to locate and apply a 
graphic file to the selected party. A preview of the graphic will appear in the Current 
Graphic preview pane when a party graphic is selected.

10. Enter any additional text in the Additional Information table at the bottom of the 
screen.

11. Once you have finished adding the new party, click Save at the bottom of the Add 
Party screen.

12. Click Close on the Add Party screen to finish adding parties.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 11: Parties for 
information about adding parties.

Note: Alternate IDs are utilized for the import and export to external systems. These fields 
are limited to 22 characters.

Note: If additional information is entered for the English text, it must also be entered for 
each of the languages in the election. Select the language tabs from the top of the 
Additional Information section to populate these fields:
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Add Precincts

The Add Precincts option is found in the Capture module. Precincts are defined as a 
part of a territory established for administrative or election purposes. It should be noted 
however that although a majority of US jurisdictions utilize this term, other states such as 
New York, utilize terms such as Election District. If your term utilizes a term other than 
precinct, use the Customize Labels option to enter the appropriate verbiage. Also note 
that if the Customize Labels option is used the substituted verbiage will appear in menu 
options where the term precincts appears.

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the Precincts and Splits button.

3. From the Manage Menu, point to Precincts and Splits, then select Add Precincts.

4. Enter the precinct name in the Precinct Name field.

5. If your election allows user generated Precinct IDs, enter the precinct ID in the 
Precinct ID field.

• Optional: If applicable, select a language group from the Default Language 
Group drop-down menu.

6. Enter the tape name in the Tape Name field.

7. Enter the report name in the Report Name field.

8. Enter the alternate identification for the precinct in the Alternate ID 1 and 
Alternate ID 2 fields.

9. Enter any additional text in the Additional Information table at the bottom of the 
screen.

10. If applicable, add splits to the precinct by clicking the Add Split button below the 
Additional Information table.

11. Once you have finished adding the new precinct (and splits), click Save at the 
bottom of the Add Precinct screen.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 12: Precincts for 
information about adding precincts.

Note: Alternate IDs are utilized for the import and export to external systems. These fields 
are limited to 22 characters.

Note: If additional information is entered for the English text, it must also be entered for 
each of the languages in the election. Select the language tabs from the top of the 
Additional Information section to populate these fields:
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12. Click Close on the Add Precinct screen to finish adding precincts.

Registered Voters

The Registered Voters option is found in the Capture module. This option enables you 
to enter registered voters for the election. Registered voters are assigned to precincts 
and splits, and typically change from election to election.

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the Precincts and Splits button.

3. From the Manage Menu, point to Precincts and Splits, then select Registered 
Voters.

4. Enter the appropriate registered voter totals for each precinct in the list, using the 
individual party columns to enter these numbers.

5. Once you have finished entering registered voter totals, click Save at the bottom of 
the Registered Voters screen.

6. Click Close on the Registered Voters screen to finish entering registered voter totals.

Add District Types

The Add District Types option is found in the Capture module. This option enables you 
to add district types to the election. District types are categorical entries in the 
database, used to define what types specific districts are assigned to (e.g. Municipal, 
County, and Federal).

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the District Types and Districts 
button.

3. From the Manage Menu, point to District Types and Districts, then select Add 
District Types.

4. Enter the district type name in the District Type Name field.

5. Enter the district type ID in the District Type ID field.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 12: Precincts for 
information about entering registered voter totals.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 13: District Types and 
Districts for information about adding district types.
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6. Enter the alternate identification for the district type in the Alternate ID 1 and 
Alternate ID 2 fields.

7. Once you have finished adding district types, click Save at the bottom of the Add 
District Type screen.

8. Click Close on the Add District Type screen to finish adding district types.

Add Districts

The Add Districts option is found in the Capture module. This option enables you to add 
districts to the election. Districts are jurisdictional boundaries that divide members of 
the voting population by geographical location.

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the District Types and Districts 
button.

3. From the Manage Menu, point to District Types and Districts, then select Add 
Districts.

4. Enter the district name in the District Name field.

5. Enter the district ID in the District ID field.

6. Enter the tape name in the Tape Name field.

7. Enter the report name in the Report Name field.

8. Enter the alternate identification for the district in the Alternate ID 1 and Alternate 
ID 2 fields.

Note: Alternate IDs are utilized for the import and export to external systems. These fields 
are limited to 22 characters.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 13: District Types and 
Districts for information about adding districts.

Note: Alternate IDs are utilized for the import and export to external systems. These fields 
are limited to 22 characters.
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9. Enter any additional text in the Additional Information table at the bottom of the 
screen.

10. Once you have finished adding districts, click Save at the bottom of the Add 
Districts screen.

11. Click Close on the Add Districts screen to finish adding districts.

Assign Precincts/Splits to Districts

The Assign Precincts/Splits to Districts option is found in the Capture module. This 
option enables you to assign precincts and splits to available districts already entered 
for the current election.

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the District Types and Districts 
button.

3. From the Manage Menu, point to District Types and Districts, then select Assign 
Precincts/Splits to Districts.

4. From the District Type drop-down menu, select the district type.

5. From the District drop-down menu, select the district. 

6. From the displayed districts in the table, click the check box adjacent to the 
appropriate district to assign it to the selected district and district type. 

7. Click Save to save your changes.

Add Headings

The Add Headings option is found in the Capture module. This feature enables you to 
add headings to the election. Headings can be used to divide up categories on the 
ballot. Typically these categories are related to the contest type attributed to a 
particular portion of a ballot (e.g. Federal, Municipal, Judicial).

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the Headings button.

Note: If additional information is entered for the English text, it must also be entered for 
each of the languages in the election. Select the language tabs from the top of the 
Additional Information section to populate these fields:

Reference: See Electionware Volume II: Define User’s Guide, Chapter 13: District Types and 
Districts for information about assigning precincts to districts.
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3. From the Manage Menu, select Add Headings.

4. Enter the heading title in the Heading field.

5. Enter the alternate identification for the heading in the Alternate ID 1 and 
Alternate ID 2 fields.

6. Enter any additional text in the Additional Information table at the bottom of the 
screen.

7. Once you have finished adding headings, click Save at the bottom of the Add 
Heading screen.

8. Click Close on the Add Heading screen to finish adding headings.

Add Contests

The Add Contests option is found in the Capture module. This feature enables you to 
add contests to the election. Contests are typically defined as races where political 
candidates run for a specific office. It should be noted however that there are several 
other contest types associated with this option, such as question and group vote 
contests.

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the Contests and Candidates button.

3. From the Manage Menu, point to Contests and Candidates, then select Add 
Contests.

4. Enter the contest title in the Title field.

5. Select the contest type from the Contest Type drop-down menu.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 14: Add Headings for 
information about adding headings.

Note: Alternate IDs are utilized for the import and export to external systems. These fields 
are limited to 22 characters.

Note: If additional information is entered for the English text, it must also be entered for 
each of the languages in the election. Select the language tabs from the top of the 
Additional Information section to populate these fields:

Reference: See Electionware Volume II: Define User’s Guide, Chapter 15: Contests and 
Candidates for information about adding contests.
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6. Select a party to affiliate with the contest from the Party drop-down menu.

7. Select the appropriate contest heading from the Heading field.

8. Enter the “Vote For” number in the Vote For Number field.

9. Enter the term in the Term Number field.

10. Enter the row number in the Row Number field.

• Optional: Select the Flag Undervote option to have the system flag undervotes 
for the selected contest.

• Optional: Select Allow Write-ins to allow write-ins for the selected contest. If 
this option is selected, enter the number of write-ins in the adjacent Number of 
Write-ins field.

11. Assign a district type to the selected contest by selecting the appropriate district 
type from the District Type drop-down menu.

12. Select the appropriate district(s) by clicking the check box next to those districts 
associated with the selected contest in the District box.

• Optional: Select any optional contest options from the Contest Omit and 
No-Candidate Creation Method drop-down menu.

• Optional: Select a rotational algorithm from the Candidate Rotation drop-down 
menu.

13. Enter the tape name in the Tape Name field.

14. Enter the report name in the Report Name field.

15. Enter the alternate identification for the district in the Alternate ID 1 and Alternate 
ID 2 fields.

16. Enter any additional text in the Additional Information table at the bottom of the 
screen.

17. Once you have finished adding the contest, click Save at the bottom of the Add 
Contest screen.

18. Click Close on the Add Contest screen to finish adding contests.

Note: The Party drop-down menu is not available for General Election types.

Note: Alternate IDs are utilized for the import and export to external systems. These fields 
are limited to 22 characters.

Note: If additional information is entered for the English text, it must also be entered for 
each of the languages in the election. Select the language tabs from the top of the 
Additional Information section to populate these fields:
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Add Candidates

The Add Candidates option is found in the Capture module. This feature enables you to 
add candidates to the election. Candidates are typically defined as members of political 
parties (or nonpartisan individuals) running for a particular contest. 

1. From the Manage menu, point to Contests and Candidates, and then select Add 
Candidates.

The Add Candidate screen appears in the workspace.

2. Enter the candidate’s last name in the Last Name field.

3. Enter the candidate’s first name (and middle initial if applicable) in the First Name 
field.

4. From the Party drop-down menu, select the candidate’s party affiliation.

5. If applicable, from the Candidate Type drop-down menu, select whether the 
candidate is Standard or a Group Vote Candidate.

6. If rotations are enabled, select Do Not Rotate to disable the candidate from 
rotating. 

7. Select Exclude From Reports to exclude the candidate from reports.

8. Enter the candidate name as you would like it to appear on your report tapes in the 
Tape Name field.

9. Enter the candidate name as you would like it to appear on your reports in the 
Report Name field.

10. Enter an Alternate ID 1 and Alternate ID 2 as another way to identify the candidate 
in other systems external to Electionware, (e.g. an external database or reporting 
system).

Note: Candidates do not appear in their own Navigator view. Instead, these entities are 
listed under the contests they are assigned to. In order to see candidates for a given 
contest, click the ‘+’ sign next to the contest in order to expand the full candidate list.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 15: Contests and 
Candidates for information about adding candidates.

Note: Although the Order Number field cannot be edited from this screen, the order of 
candidates can be changed by utilizing the move options in the Navigator pane.

Note: Alternate IDs are utilized for the import and export to external systems. These fields 
are limited to 22 characters.
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11. Click Browse in the Graphic section to apply a graphic to the candidate. When a 
graphic is selected, a preview of the image will appear in the box next to the 
Browse and Remove buttons.

12. Include any additional information in the Additional information table at the bottom 
of the screen.

13. Click Save to save the candidate. Click Clear to clear any unsaved information. Or 
click Close to exit the screen without saving the information. 

Add Poll Places

The Add Poll Places option is found in the Capture module. This feature enables you to 
add polling places to the election. Polling places are locations where multiple precincts 
are consolidated for voting purposes.

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the Poll Places button.

3. From the Manage Menu, point to Poll Places, then select Add Poll Places.

4. Enter the poll place name in the Poll Place Name field.

5. Select the poll place type from the Poll Place Type drop-down menu.

6. Enter the poll place ID in the Poll Place ID field.

7. Enter the tape name in the Tape Name field.

8. Enter the report name in the Report Name field.

Note: Candidate graphics are only supported for the paper ballot, and not the accessible 
equipment.

Note: If additional information is entered for the English version of the candidate, it must 
also be entered for each of the languages in the election. Select the language tabs from 
the top of the Additional Information section to populate these fields:

Reference: See Electionware Volume II: Define User’s Guide, Chapter 16: Poll Places for 
information about adding poll places.
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9. Enter the alternate identification for the poll place in the Alternate ID 1 and 
Alternate ID 2 fields.

10. Enter any notes for the poll place in the Poll Place Notes field.

11. Enter any additional text in the Additional Information table at the bottom of the 
screen.

12. Once you have finished adding the poll places, click Save at the bottom of the Add 
Poll Place screen.

13. Click Close on the Add Poll Place screen to finish adding contests.

Add Ballot Sets

The Add Ballot Sets option is found in the Capture module. This feature enables you to 
add ballot sets to the election. Ballot sets are defined as collections of ballots with a 
singular identifier such as a party. For instance, in a closed primary election, depending 
on the number of parties, there would be a ballot set for each party within the election.

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the Ballot Sets and Ballot Styles 
button.

3. From the Manage Menu, point to Ballot Sets and Ballot Styles, then select Add 
Ballot Sets.

4. Enter the ballot set name in the Ballot Set Name field.

5. Select the party to attribute to the ballot set from the adjacent Party drop-down 
menu.

6. Select either By Precinct or By Style to select whether they ballot set will be created 
by precinct or by ballot style.

• Optional: If By Precinct is selected, click Combine Splits if the Same, to 
combine splits within the ballot set that are the same.

Note: Alternate IDs are utilized for the import and export to external systems. These fields 
are limited to 22 characters.

Note: If additional information is entered for the English text, it must also be entered for 
each of the languages in the election. Select the language tabs from the top of the 
Additional Information section to populate these fields:

Reference: See Electionware Volume II: Define User’s Guide, Chapter 17: Ballot Sets and 
Ballot Styles for information about adding ballot sets.
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• Optional: If By Style is selected, select either Additional Style for each split, or 
Additional Style for each District in Specified District Type to create additional 
styles for individual splits or specified districts. If the latter is selected, choose 
the affected district from the available drop-down menu.

7. If applicable, select Rotate Candidates to enable candidate rotation for the 
selected ballot set. If selected, be sure to set the home rotation by entering a ballot 
style number in the Home Position field. 

8. If candidate rotation is selected, choose either Before Grouping Ballot Styles or 
After Grouping Ballot Styles to decide whether candidate rotation is implemented 
before or after grouping ballot styles.

• Optional: Select Don’t Rotate Splits to disable rotations for splits.

9. Select from the following to stipulate any contest conditions for the ballot set:

• All Contests and Candidates - to include all contests and candidates in the 
ballot set.

• All Except Local - to include all contests and candidates other than those 
stipulated as local in the ballot set.

• Local Only - to include only those contests and candidates stipulated as local in 
the ballot set.

• Exclude Non Partisan - to include all contests and candidates other than those 
stipulated as non partisan in the ballot set.

• Select Contests to Exclude - to exclude specific offices from the ballot set. If 
this option is selected, contests must be selected from the selections in the box 
below.

10. Once you have finished adding ballot sets, click Save at the bottom of the Add 
Ballot Set screen.

11. Click Close on the Add Ballot Set screen to finish adding ballot sets.

Add Rotation Exceptions

The Add Rotation Exceptions option is found in the Capture module. This feature 
enables you to add rotation exceptions to ballot sets within the election. Rotation 
exceptions are added when specific contests have rotation exceptions affiliated with a 
particular ballot set.

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the Ballot Sets and Ballot Styles 
button.

3. From the Manage menu, point to Ballot Sets and Ballot Styles and select Rotation 
Exception.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 17: Ballot Sets and 
Ballot Styles for information about adding rotation exceptions.
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The Rotation Exceptions screen appears.

4. From the Ballot Set drop-down menu, select the ballot set to apply the rotation 
exception.

5. Click the Add Exception button.

6. Click the list under the Contest column to select the contest for the exception.

7. Click the list under the Precinct/Split column to select the precinct and split for the 
exception.

Once the contest, precinct and splits are chosen, the Registered Voters, System 
Rotation, and Static/Flow columns are automatically populated by the system. 

8. Click the list under the New Rotation column to select a candidate for the rotation 
exception.

9. Once you have finished adding rotation exceptions, click Save at the bottom of the 
Rotation Exceptions screen.

10. Click Close to finish adding rotation exceptions.

Generate Ballot Styles

The Generate Ballot Styles option is found in the Capture module. This feature enables 
you to generate ballot styles for the election. Generating ballot styles is one of the final 
steps taken in the Capture module. This step generates ballot set information from the 
data entered in Capture, and converts it into a usable format for the Paper Ballot 
module.

1. From the Modules menu, select Define and click Capture.

2. From the bottom of the Navigator pane, click the Ballot Sets and Ballot Styles 
button.

3. From the Manage Menu, point to Ballot Sets and Ballot Styles, then select 
Generate Ballot Styles.

4. When prompted, click OK to complete the process.

Note: To delete a rotation exception, simply select it from the list of exceptions in the 
table, and click the Delete Exception Button.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 17: Ballot Sets and 
Ballot Styles for information about generating ballot styles.
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Export Ballot Translations

The Export Ballot Translations option is found in the Capture module. This feature 
enables you to export ballot translations for the election. Ballot translations are similar in 
concept to system translations, and are exported into an Excel spreadsheet. The script 
(or spreadsheet) is then translated by you or by a professional translation service.

1. From the Modules menu, select Define and click Capture.

2. From the Tools menu, select Export Ballot Translations Script.

3. Select a specific language to export by clicking the check box next to the 
language(s) you want to export.

4. Select whether to export All ballot translations or Missing or changed ballot 
translations. 

5. Click Browse to select a location for the exported ballot translation scripts.

6. Click Export to begin the ballot translation script export process.

7. Close the prompt detailing the successful export of the translations by clicking OK.

8. Click Close on the Export Ballot Translations screen to finish exporting ballot 
translation scripts.

9. Select a translation service, or edit the translation scripts yourself for the required 
languages.

Importing Ballot Translations

The Import Ballot Translations option is found in the Capture module. This feature 
enables you to import the translated ballot script into the election. 

1. After you have finished translating, or have received the completed ballot 
translations from your chosen translation provider, place the completed scripts in the 
original directory where the ballot translation scripts were exported.

2. From the Modules menu, select Define and click Capture.

3. From the Tools menu, select Import Ballot Translations.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 19: Export Ballot 
Translations for information about exporting ballot translations.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 20: Import Ballot 
Translations for information about importing ballot translations.
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4. Click Browse to locate the translation script folder. 

5. Select a specific language to import by clicking the check box next to the 
language(s) you want to import.

6. Click the translation script for the selected language, and click Select.

7. Click Import to begin the translation import process.

8. Click OK to close the File Import prompt.

9. From the Modules menu, select Design and click Accessible Ballot. 

10. From the Tools menu, click Validate Data. Verify that the ballot data translations 
imported correctly by checking the Validate Data screen for errors.

11. Click Close on the Import Ballot Translations screen to finish importing ballot 
translation scripts.

Element Library Module

The Element Library module is where 
accessible features for the AutoMARK, and 
ExpressVote can be customized. These 
features include both system files (defined as 
instructional text and audio displayed/played 
for the user) and screen graphics.

Exporting System Translations

The exporting of system translations is 
performed in the Element Library module. 
These features, for the AutoMARK, and 
ExpressVote are all performed from this module, although depending upon the 
configuration purchased by your jurisdiction, not all of these options may appear under 
the Tools menu.

System translations are similar in concept to ballot translations, and are exported into an 
Excel spreadsheet. The script (or spreadsheet) is then translated by you or by a 
professional translation service.

1. From the Modules menu, select Define and click Element Library.

Reference: Refer to Electionware Volume III: Design User’s Guide, Chapter 31: Validate 
Data for further information about using the Validate Data feature.
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2. From the Tools menu, select Export AutoMARK System Translations Script, or 
Export ExpressVote System Translations Script.

3. Select a specific language to export by clicking the check box next to the 
language(s) you want to export.

4. Select whether to export All system prompts or Missing or changed system 
prompts. 

5. Click Browse to select a location for the exported system translation scripts.

6. Click Export to begin the system translation script export process.

7. Close the prompt detailing the successful export of your language(s) by clicking OK.

8. Click Close on the Export Script screen to finish exporting system translation scripts.

9. Select a translation service, or edit the translations script yourself for the required 
languages.

Importing System Translations

The importing of system translations for the AutoMARK, and ExpressVote are 
performed in the Element Library module. Use the Excel spreadsheet exported in the 
previous steps for import.

1. After you have finished translating, or have received the completed system 
translations from your chosen translation provider, place the completed scripts in the 
original directory where the system translation scripts were exported.

2. From the Modules menu, select Define and click Element Library.

3. From the Tools menu, select either Import AutoMARK System Translations Script, 
or Import ExpressVote System Translations Script.

4. Click Browse to locate the translation script folder. 

5. Select a specific language to import by clicking the check box next to the 
language(s) you want to import.

6. Click the translation script for the selected language, and click Select.

7. Click Import to begin the translation import process.

8. Click OK to close the File Import prompt.

9. From the Modules menu, select Design and click Accessible Ballot. 

Reference: See Electionware Volume II: Define User’s Guide, Chapter 23: Export 
AutoMARK System Translations Script or Chapter 28: Export ExpressVote System 
Translations Script for information about exporting system prompt translations.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 24: Import 
AutoMARK System Translations Script, or Chapter 29: Import ExpressVote System 
Translations Script for information about importing system prompt translations.
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10. From the Tools menu, click Validate Data. Verify that the system translations 
imported correctly by checking the Validate Data screen for errors.

11. Click Close on the Import Translations screen to finish importing system translation 
scripts.

Export System Audio Scripts

The exporting of system audio scripts is performed in the Element Library module. 
These features, for the AutoMARK, and ExpressVote are all performed from this 
module, although depending upon the configuration purchased by your jurisdiction, not 
all of these options may appear under the Tools menu. 

System audio scripts are similar in concept to system translations, and are exported into 
an Excel spreadsheet. The script (or spreadsheet) is then used by you or a professional 
studio to record audio files for the election.

1. From the Modules menu, select Define and click Element Library.

2. From the Tools menu, select either Export AutoMARK System Audio Script, or 
Export ExpressVote System Audio Script.

3. Select a specific language to export by clicking the check box next to the 
language(s) you want to export.

4. Select whether to export All system prompts or Missing or changed system 
prompts.

5. Click Browse to select a location for the exported system prompt audio scripts.

6. Click Export to begin the system prompt audio script export process.

7. Close the prompt detailing the successful export of your language(s) by clicking OK.

8. Click Close on the Export Audio Script screen to finish exporting system audio 
prompt scripts.

9. Send the exported system prompt audio script to a voice talent service, or perform 
the recording process yourself.

Reference: See Electionware Volume III: Design User’s Guide, Chapter 31: Validate Data for 
further information about using the Validate Data feature.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 25: Export 
AutoMARK System Audio Script, or Chapter 30: Export ExpressVote System Audio Script 
for information about exporting system audio scripts.
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Import System Audio Recordings

The importing of system audio recordings for the AutoMARK, and ExpressVote is 
performed in the Element Library module. Place the recorded audio files in the same 
folder as the system audio script in order to ensure that the import process is successful.

1. After you have finished recording, or have received the completed system audio 
files from your chosen audio services provider, place the completed audio files 
within the same directory as the exported system prompt audio script(s).

2. From the Modules menu, select Define and click Element Library.

3. From the Tools menu, select Import ExpressVote System Audio Recordings, or 
Import AutoMARK System Audio Recordings.

4. Click Browse to locate the translation script folder. 

5. Select a specific language to import by clicking the check box next to the 
language(s) you want to import.

6. Click Import to begin the system prompt import process.

7. From the Modules menu, select Design and click Accessible Ballot. 

8. From the Tools menu, click Validate Data. Verify that audio recordings imported 
correctly by checking the Validate Data screen for errors.

9. Click Close on the Import Recordings screen to finish importing system audio 
prompt files.

Import Screen Definitions

Use the Import DS200 Screen Definitions, Import AutoMARK Screen Definitions, and 
Import ExpressVote Screen Definitions options to import screen definitions that the 
voter will see when utilizing the DS200, AutoMARK or ExpressVote. These definitions 
must be stored in the form of an (.ezip) file to be imported properly.

To import DS200, AutoMARK, or ExpressVote screen definitions, follow the steps below:

Reference: See Electionware Volume II: Define User’s Guide, Chapter 26: Import 
AutoMARK System Audio Recordings, or Chapter 31: Import ExpressVote System Audio 
Recordings for information about importing system audio recordings.

Reference: Refer to Electionware Volume III: Design User’s Guide, Chapter 31: Validate 
Data for further information about using the Validate Data feature.

Verify: The screen definition file is created and/or edited by ES&S. If you desire changes 
to the default DS200, AutoMARK, or ExpressVote screen definitions, please contact your 
ES&S representative for more details.
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1. From the Tools menu, select Import DS200 Screen Definitions, Import AutoMARK 
Screen Definitions, or Import ExpressVote Screen Definitions.

A warning prompt appears explaining that changing the screen definition changes how 
the screen will appear to voters. Click Yes to continue.

• Or, click No to cancel the import screen definition process.

The Import <Equipment Type> Screen Definitions browser window appears. 

2. Browse to the location of the screen definition (.ezip) file and click Select.

If successful, Electionware prompts you to let you know that the new screen definitions 
have been implemented. Click OK to return to the main Electionware window.

If the import of screen definitions is unsuccessful, you will be prompted to let you know 
that the new screen definitions were not implemented. Contact ES&S for more 
information on why the import of screen definitions failed.

Import Graphics

The Element Library module enables you to import graphics for the DS200, 
ExpressVote, and AutoMARK. Although the importing of screen graphics for all three 
systems is found under the Element Library module, the options that appear under the 
Tools menu will depend upon the configuration purchased by your jurisdiction.

1. From the Modules menu, select Define and click Element Library.

2. From the Tools menu, select either Import DS200/ExpressVote Election Header 
Graphic, or Import AutoMARK Election Header Graphic. 

3. Select either the Custom Graphic or Use Default Graphic option to indicate 
whether you will be using the default or custom graphic.

4. If you are using the default election header, the default graphic will display. If you 
choose to use a custom graphic, click Browse to locate the file.

5. Click Refresh at the bottom of the Election Headers screen to clear any unsaved 
graphical information.

6. Once you have completed making changes to your header graphics, click Save at 
the bottom of the Election Headers screen to save the new graphical information.

7. Click Close at the bottom of the Election Headers screen to finish the graphics 
editing process.

Reference: See Electionware Volume II: Define User’s Guide, Chapter 31: Import DS200 
Election Header Graphic, or Chapter 34: Import AutoMARK Election Header Graphic, or 
Chapter 35: Import ExpressVote Election Header Graphic for information about importing 
header graphic files for the ES&S AutoMARK, ExpressVote, or DS200.
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Import DS200 Voter Thank You Screen Graphic

To import a thank you screen graphic, follow the steps below:

1. From the Tools menu, click Import Voter Thank You Screen Graphic. 

The DS200 Voter Thank You Screen appears.

2. Select either Custom Graphic or Use Default Graphic. 

3. If you select a Custom Graphic, click Browse to open and select the new graphic.

A file browser window appears:

4. Select the custom graphic you wish to import and click Open.

Electionware displays the path of the graphic file in the Voter Thank You Screen 
graphic to display on the DS200: field.

A preview of the graphic appears in the Current Graphic: portion of the screen.

Following are the requirements for imported graphics.

• The imported graphic file must be of file type (.png).

• It is recommended that the format size of the image be approximately 100 pixels 
in width by 88 pixels in height.

5. Click Save to save the selected graphic. Or, click Refresh to discard any unsaved 
information or Close to close the Election Headers screen.

If you close the Voter Thank You Screen prior to saving, a prompt will appear asking you if 
you want to save. Click Yes to save and close the prompt and screen. Click No to close the 
prompt and your work without saving. Or, click Cancel to return to the Voter Thank You 
Screen.

Note: Custom Graphic must be selected for the browse button to become available.

Time Saver: You can also Import your AutoMARK Election Header graphics from the same 
screen, by clicking on the AutoMARK link at the top of the screen.
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Paper Ballot Module

The Paper Ballot module is used to design 
ballots for an election. Using the information 
entered in Capture, you can design ballots to 
meet the needs of your jurisdiction. Use this 
module to configure the sheet size and 
orientation, as well as utilize style sheets to 
create a ballot that conforms to those election 
laws governing your locality.

Design Paper Ballot

The Paper Ballot module is complex, and encompasses a greater amount of steps than 
those listed below. Additionally, paper ballots come in three different configurations, 
specific to the election guidelines put forth by your state. Use style sheets and various 
design options to create a ballot that conforms to the needs and requirements of your 
jurisdiction.

1. From the Modules menu, select Design and click Paper Ballot.

2. The Electionware Paper Ballot module opens in a new window.

3. From the File menu in Paper Ballot, point to New, then select New document 
wizard or New document from template to create a ballot in the application. If the 
ballot has already been created, select Open from the File menu and select the 
previously saved file name.

4. Once you have finished, select File and click Save. 

5. Enter a name for the new ballot.

6. Select File and click Finalize Ballot Layout.

7. Close Paper Ballot to return to Electionware.

Reference: See Electionware Volume III: Design User’s Guide, Part 1: Paper Ballot for 
information about designing your ballot.

Note: When Paper Ballot is open, all other modules in Electionware are inaccessible.

Warning: Finalizing the Ballot Layout will overwrite any Accessible Ballot format changes 
you have made. A prompt will appear asking if you want to finalize the ballot layout. 
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Accessible Ballot Module

The Accessible Ballot module is where features 
that relate to the accessible ballot are configured. 
Using the features found in this module, you can 
configure the look and feel of the ballot as it 
appears on the AutoMARK and ExpressVote 
equipment types. Additionally, Accessible Ballot 
is also where ballot audio scripts are exported, 
and ballot audio files are imported.

Formatting Screen Elements

From the Tools menu, you have the option of formatting various elements of the 
on-screen ballot. From here you can format headings, contests, contest summaries, 
candidates, and ballot style names. These functions enable you to change font size, 
color, justification, and weight of the text. In the Content editor portion of the screen, 
you can then preview how these changes will appear on the AutoMARK and 
ExpressVote.

1. From the Modules menu, select Design and click Accessible Ballot.

2. Select the element you wish to format from the four categorical buttons at the 
bottom of the Navigator pane. 

3. From the Navigator pane, click on the element you wish to format (for example, a 
candidate or contest). 

4. From the Manage menu, select the element you wish to format (e.g. Format 
Headings, Format Contests, Format Contest Summary, Format Candidates, and 
Format Ballot Style Names).

5. From the Content Editor portion of the screen, select the item you wish to format 
(e.g. the candidate or contest name).

6. Use the commands in the Ballot Presentation Editor screen to change the font color, 
text formatting, or justification for the on screen element.

7. Click Save to save your changes.

8. Click Close to close the Ballot Presentation Editor screen.

Reference: See Electionware Volume III: Design User’s Guide, Chapter 28: Formatting 
Display Elements for information about formatting screen elements.
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Exporting Ballot Audio Scripts

The Export Ballot Audio Scripts option is found in the Accessible Ballot module. Ballot 
audio scripts are similar in concept to system audio scripts, and are exported into an 
Excel spreadsheet. The script (or spreadsheet) is then used by you or a professional 
studio to record audio files for the election.

1. From the Modules menu, select Design and click Accessible Ballot.

2. From the Tools menu, select Export Ballot Audio Scripts.

3. Select a specific language to export by clicking the check box next to the 
language(s) you wish to export.

4. Select whether to export All election audio or Missing or election audio.

5. Click Browse to select a location for the exported election audio scripts.

6. Click Export to begin the election audio script export process.

7. Close the pop-up window(s) detailing the successful export of your script(s).

8. Click Close on the Export Audio Scripts page to finish exporting system election 
audio script(s).

9. Select a translation and audio talent service, or edit the translations within the script 
and create the necessary audio files for the required language(s).

Importing Election Audio Recordings

The importing of ballot audio recordings for the AutoMARK, and ExpressVote, is 
performed in the Accessible Ballot module. Place the recorded audio files in the same 
folder as the ballot audio script in order to ensure that the import process is successful.

1. After you have finished recording, or have received the completed election audio 
files and translations from your chosen audio services provider, place the completed 
audio files and edited scripts in the same directory.

2. From the Modules menu, select Design and click Accessible Ballot.

Reference: See Electionware Volume III: Design User’s Guide, Chapter 27: Export Ballot 
Audio Scripts for information about exporting ballot audio scripts.

Note: The export of ballot audio scripts must be completed for all elections utilizing audio 
services. 
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3. From the Tools menu, select Import Ballot Audio Recordings.

4. Click Browse to locate the folder where the audio files and script are located.

5. Select the election audio script for the language you have selected, and click 
Import.

6. Select a specific language to import by clicking the check box next to the 
language(s) you wish to import.

7. Verify that the system audio prompts imported correctly by checking the Validate 
Data page for errors. This is accessed from the Tools menu by selecting Validate 
Data.

8. Click Close on the Import Recordings page to finish importing system audio prompt 
files.

Validating Translation and Audio Data

The Validate Data option is found in the Accessible Ballot module. This option enables 
you to validate all data (translations, system audio files, and ballot audio files) have been 
imported correctly. Be sure to highlight any errors found and click View Details in order 
to learn more about the issue(s).

1. From the Tools menu, click Validate Data.

2. In the Data Validation Errors list, select a specific set of errors and click View Details.

Note: The import of election audio recordings must be completed for all elections utilizing 
audio services. 

Reference: See Electionware Volume III: Design User’s Guide, Chapter 29: Import Ballot 
Audio Recordings for information about importing ballot audio recordings.

Note: Refer to Electionware Volume III: Design User’s Guide, Chapter 31: Validate Data for 
further information about using the Validate Data feature.

Note: Refer to Electionware Volume III: Design User’s Guide, Chapter 31: Validate Data for 
further information about using the Validate Data feature.

Note: You must select a specific set of errors to generate the appropriate translation or 
audio error report. 
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3. Review the selected error report, and repeat the appropriate export or import steps 
to correct the errors listed in the report. 

Configure Equipment Module

The Configure Equipment module is where 
you will configure the equipment to be used 
in the election. From here, you will be able to 
set various options including the processing 
of ballots, reporting, and security settings. In 
addition, once you have made the 
appropriate changes to these settings, you 
can then generate the data to be used with 
your equipment.

Configure Security and Settings 
for Digital Scan and Accessible 
Equipment

From the Manage menu of the Configure Equipment module, you can configure security 
and various elements of digital scan (DS) and accessible equipment types. 

1. From the Modules menu, select Deliver and click Configure Equipment.

2. From the Manage menu, select DS/ExpressVote Security, AutoMARK Security, 
DS200 Settings, DS850 Settings, AutoMARK Settings, or ExpressVote Settings. 

3. Set the fields according to your jurisdiction’s regulations.

4. Enter the desired security codes and re-enter each security code to confirm the 
choice. If the security codes match, a green check mark will appear to the right of 
the row.

5. Click Save to save your changes.

Note: You must correct all of the listed errors to proceed with the election production 
process. 

Note: The election security code is dependent on the strength set in the Setup module. Do 
not use spaces, a colon (:), or a pipe (|) symbol. Security Codes are case sensitive.

Reference: See Electionware Volume IV: Deliver User’s Guide, Chapter 3: DS/ExpressVote 
Security, Chapter 4: DS200 Settings, or Chapter 7: DS850 Settings for information about 
configuring digital scan equipment.
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DS850 Network Settings

The DS850 Network Settings option is found in the Configure Equipment module. This 
option enables you to configure IP address of the server PC. 

Verifying the Server (PC) IP Address

1. From Search field of the Windows Start menu, enter the command Command 
Prompt.

2. Once the Command Prompt window opens, enter the command ipconfig at the 
DOS prompt.

3. From the list of available information, find the line labeled IPv4 Address. The IPv4 
address will be a series of numbers in a format similar to the following: 156.56.27.32

After the IP address has been verified, use the following steps in Electionware to 
configure the DS850 network settings.

Setting the IP Address in Electionware

1. From the Manage menu, select DS850 Network Settings.

The DS850 Network Settings window appears.

2. Select Enable Network to enable network functionality for the DS850.

3. Enter the Primary IP address found in the previous steps in the Internal SFTP Server 
IP Address field.

4. Click Save to save the DS850 Network Settings

• Or click cancel to close the DS850 Network Settings window without saving.

Configure Equipment for ES&S AutoMARK

The AutoMARK Security and AutoMARK Settings options are both found in the 
Configure Equipment module. These options enable you to configure settings and 
security for the AutoMARK. 

Note: The IPv4 address may consist of greater or fewer digits than in the example above.

Reference: See Electionware Volume IV: Deliver User’s Guide, Chapter 6: DS850 Network 
Settings for more information on configuring the DS850 network options.
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1. From the Modules menu, select Deliver and click Configure Equipment.

2. From the Manage menu, select AutoMARK Security or AutoMARK Settings.

3. Set the fields according to your jurisdiction’s regulations.

4. Enter the desired security codes and re-enter the security code to confirm the 
choice. If the security codes match, a green check mark will appear to the right of 
the row.

5. Click Save to save your changes.

ExpressVote Settings

Use the ExpressVote Settings option to select how you want the ES&S ExpressVote to 
handle vote session, audio, ballot, write-in, and terminal properties.

1. From the Manage menu, select ExpressVote Settings. 

The ExpressVote Settings screen will appear.

Vote Session Properties

2. Select Alert Voter if all Contest Choices have not been Displayed if you want the 
ES&S ExpressVote to display an alert to the voter when there are some choices that 
have not yet been displayed. 

3. Select Alert Voter of Under-Vote Condition if you want the ES&S ExpressVote to 
display an alert when the voter has not selected the full number of candidates 
allowed for any given race. 

4. Select Force Voter to View All Contest Choices if you want the ES&S ExpressVote 
to force the voter to view all contest choices by scrolling through all of the choices in 
the contest. Leave this check box blank if you do not want to force the voter to view 
all contest choices before submitting a vote.

Reference: See Electionware Volume IV: Deliver User’s Guide, Chapter 7: AutoMARK 
Security, or Chapter 8: AutoMARK Settings for information about configuring the 
AutoMARK.

Note: The election code is dependent on the strength set in the Setup module. AutoMARK 
security codes are limited to Capital letters, lower case letters and numbers. Security codes 
are case sensitive.

Note: If this option is selected, the voter must scroll through the screens if there are more 
contest choices to view. 

Note: If this option is selected, the ES&S ExpressVote will not advance to the next contest/
question if there is more text to view.
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5. Enable the Deselect Straight Party Candidates in Contest if manually re-voted to 
deselect a straight party selection if the voter selects a candidate manually.

Terminal Properties

6. From the Use Party Graphics drop-down menu, select from the following:

• None - No party graphics will be displayed on the ExpressVote terminal.

• Straight-Party Only - Only straight-party graphics will be displayed on the 
ExpressVote terminal.

• All Party Candidates - All party graphics will be displayed on the ExpressVote 
terminal.

Audio Properties

7. Select Non-Audio Election to deactivate audio for this election. When selected, 
audio files will not be required during export, and the ExpressVote will not attempt 
to play audio files.

Print Properties

8. From the Size drop-down menu, select the size of the print that will be placed on 
the card (Large, Medium, and Small).

9. From the Spacing drop-down menu, select the spacing that will be used on the 
card. Select None for no spacing, or Blank Line for blank lines to be placed between 
items.

10. From the Format drop-down menu, select the print format to be used on the card. 
Select Standard for the standardized printing format, or Compressed to compress 
the information printed on the card.

Once you have configured the ExpressVote for this election, select Save if you want to 
save these parameters. Select Refresh to discard all changes made on the screen and 
reset the values to those last saved, or select Close to exit the screen.

If you close the ExpressVote Settings screen prior to saving, a prompt will appear asking 
you if you want to save. Click Yes to save and exit the screen. Click No to close the 
prompt and the ExpressVote Settings screen without saving. Or, click Cancel to return 
to the ExpressVote Settings screen.

Add Contest Groups

Use contest groups to group select contests for reporting purposes. To add contest 
groups to the election, follow the steps below.

Note: The Alert Voter if all Contest Choices have not been Displayed and Force Voter 
to View All Contest Choices options are mutually exclusive. Both cannot be selected for 
an election simultaneously. However, they may both be left unselected.
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1. From the Manage menu, select Add Contest Groups.

The Add Contest Group screen appears.

1. Enter the name of the contest group in the Contest Group Name field.

2. From the Assign Contests to Contest Group section of the screen, select the 
contests to be assigned to the contest group by clicking on the check box next to 
the appropriate contests.

3. When finished, click Save to save the contest group.

Generate Election Files

Both the Generate DS Election Data and Generate Accessible Equipment Election Data 
options are found in the Configure Equipment module. These options enable you to 
create the election files for both DS and accessible equipment types. Note that election 
files will have to be regenerated for any changes made to the election data after these 
options are utilized.

1. From the Modules menu, select Deliver and click Configure Equipment.

2. From the Tools menu, select Generate DS Election Data or Generate Accessible 
Equipment Election Data.

Accessible Ballot Module

Preview Ballot

After generating equipment election files, you can then preview the accessible ballot in 
the Accessible Ballot module. This preview enables you to emulate the AutoMARK and 
ExpressVote equipment. This emulation enables you to proof the “on-screen” ballot for 
potential errors.

1. From the Modules menu, select Design and click Accessible Ballot.

2. From the Navigator pane, select the Ballot Style Names button. 

3. Select the appropriate ballot style from the Navigator Pane.

Reference: See Electionware Volume IV: Deliver User’s Guide, Chapter 12: Generate DS 
Election Data, or Chapter 13: Generate Accessible Equipment Election Data for information 
about generating election data.
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4. From the Manage menu, click either Preview AutoMARK Ballot, or Preview 
ExpressVote Ballot.

5. The Preview Ballot viewer is an external window, and will overlay Electionware. You 
must close the viewer to return to Electionware.

6. Review the screen details, system screen prompts, system audio prompts, visual 
election elements, and election audio files to verify that all audio and translation 
linking are correct.

7. Return to the correlating steps to edit any of the visual or audio options in your 
election. 

8. Close the ballot preview for the specified equipment type to return to Electionware.

Package Module

The Package module is where you create media for 
the election. The options found in this module 
enable you to create Qualification, Election, and 
Reporting media. Depending on the equipment 
being used, all three media types must be created 
for the election. In addition, the ballot file can be 
created for the PollBook as well.

Create DS200 Election Media

The ES&S DS200 Election media contains the election definition required by the ES&S 
DS200, including election related images, and folders for result collections. Before 
creating ES&S DS200 media, you must have the codes and configuration settings 
defined and the files generated. You must also first create the EQC media device before 
creating Poll Place media.

1. Insert the memory device into a USB port on your computer.

Reference: See Electionware Volume III: Design User’s Guide, Chapter 30: Preview Ballot or 
Chapter 31: Preview ExpressVote Ballot for information about previewing and navigating 
the AutoMARK ballot.

Note: You must select Ballot Style Names from the Navigator pane for the Preview Ballot 
option to become available. 

Caution: Ensure that DS200 Poll Place USB memory devices are correctly partitioned 
and properly formatted to the FAT32 file system prior to loading devices with election 
configuration files.
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2. In the Navigator pane, select the poll or polls for which to create media. 

3. From the Manage menu, point to Create DS200 Election Media. 

• Or, right click on the appropriate DS200 poll place in the Navigator pane and 
click Create DS200 Election Media.

The DS200 Poll Place window appears.

4. From the Select Device drop-down menu, select your memory device drive.

5. Click Create Media. If there is data on the memory device, you will be prompted to 
clear the device. Click Yes to clear this device. Click Yes To All to clear all memory 
devices inserted into the machine. Or, click No to exit the Poll Place Media process.

6. Once you have cleared the memory device and created the media, a message will 
appear stating that the DS200 Poll Place Media has been created.

7. Remove the memory device from your PC.

8. Click OK to return to Electionware.

9. Repeat steps 1-10 for every piece of DS200 Poll Place Media you need to create.

Create DS850 Election Media

The ES&S DS850 Election Media memory device contains the election definition 
required by the ES&S DS850, including election related images, and folders for result 
collections. Before creating ES&S DS850 media, you must have the codes and 
configuration settings defined and the files generated. You must also first create the 
EQC media device before creating ES&S DS850 Election Media.

1. Insert the memory device into a USB port on your computer.

2. In the Navigator pane, select the poll or polls for which to create media. 

3. From the Manage menu, point to Create DS850 Election Media. 

Note: You must create media in the order displayed on the menu; Qualification Media, then 
DS200 Election Media, then DS850 Election Media, then Reporting Key Media. Creating 
media out of order can cause errors with time and date stamping. If you attempt to create a 
media device out of order, you will be prompted to return to the appropriate menu option. 

Note: If your device drive does not appear in the list, click Refresh to update the available 
selections, then select the memory device drive.

Caution: Ensure that DS850 Poll Place USB memory devices are correctly partitioned 
and properly formatted to the FAT32 file system prior to loading devices with election 
configuration files.
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• Or, right click on the DS850 icon in the Navigator pane and click Create DS850 
Election Media.

The DS850 Poll Place window appears.

4. From the Select Device drop-down menu, select your memory device drive.

5. Click Create Media. If there is data on the memory device, you will be prompted to 
clear the device. Click Yes to clear this device. Click Yes To All to clear all memory 
devices inserted into the machine. Or, click No to exit the Poll Place Media process.

6. Once you have cleared the memory device and created the media, a message will 
appear stating that the DS850 Poll Place Media has been created.

7. Remove the memory device from your PC.

8. Click OK to return to Electionware.

9. Repeat steps 1-9 for every piece of DS850 Poll Place Media you need to create.

Create AutoMARK Election Media

The AutoMARK Election Media is a compact flash card containing information for 
polling places within a jurisdiction. Code and configuration settings need to be set and 
processed prior to AutoMARK media creation.

1. Insert the ES&S AutoMARK compact flash card into the compact flash reader/writer.

2. From the Manage menu, point to Create AutoMARK Election Media. 

The AutoMARK Poll Place window appears:

3. From the Select Device drop-down menu, select your memory device drive. 

Note: You must create media in the order displayed on the menu; Qualification Media, 
then DS200 Election Media, then DS850 Election Media, then Reporting Key Media. 
Creating media out of order can cause errors with time and date stamping. If you attempt 
to create a media device out of order, you will be prompted to return to the appropriate 
menu option. 

Note: If your device drive does not appear in the list, click Refresh to update the available 
selections, then select the memory device drive.

Note: The Compact Flash drive must be plugged into the computer prior to creating ES&S 
AutoMARK media.

Note: If your device drive does not appear in the list, click Refresh to update the available 
selections, then select the memory device drive.
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4. Click Create Media. If there is data on the memory device, you will be prompted to 
clear the device. Click Yes to clear this device. Click Yes To All to clear all memory 
devices inserted into the machine. Or, click No to exit the Poll Place Media process.

5. Once you have cleared the memory device and created the media, a message will 
appear stating that the AutoMARK Poll Place Media has been created.

6. Remove the memory device from your PC.

7. Click OK to return to Electionware.

8. Repeat steps 1-9 for every piece of AutoMARK Poll Place Media you need to create.

Create ExpressVote Election Media

The ES&S ExpressVote Election media contains the election definition required by the 
ExpressVote, including election related images. Before creating ExpressVote media, you 
must have the codes and configuration settings defined and the files generated. You 
must also first create the EQC media device before creating ExpressVote election 
media.

1. Insert the memory device into a USB port on your computer.

2. In the Navigator pane, select the poll or polls for which to create media. 

3. From the Manage menu, point to Create ExpressVote Election Media. 

• Or, right click on the appropriate ExpressVote poll place in the Navigator pane 
and click Create ExpressVote Election Media.

The ExpressVote Poll Place window appears.

4. From the Select Device drop-down menu, select your memory device drive.

5. Click Create Media. If there is data on the memory device, you will be prompted to 
clear the device. Click Yes to clear this device. Click Yes To All to clear all memory 
devices inserted into the machine. Or, click No to exit the Poll Place Media process.

6. Once you have cleared the memory device and created the media, a message will 
appear stating that the ExpressVote Poll Place Media has been created.

7. Remove the memory device from your PC.

8. Click OK to return to Electionware.

Caution: Ensure that ExpressVote USB memory devices are correctly partitioned and 
properly formatted to the FAT32 file system prior to loading devices with election 
configuration files.

Note: If your device drive does not appear in the list, click Refresh to update the available 
selections, then select the memory device drive.
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9. Repeat steps 1-10 for every piece of ExpressVote Poll Place Media you need to 
create.

Create Reporting Key Media

The Reporting Key Media contains the key and time stamp files for use with ERM. This 
enables ERM to check the digital signatures on the results from the ES&S DS200, and 
DS850. It also ensures that the Reporting Key Media device and the poll place data 
come from the same election and generation in Electionware.

1. Insert the memory device into a USB port on your computer.

2. From the Manage menu, point to Create Reporting Key Media. 

The Reporting Device window appears.

3. From the Select Device drop-down menu, select your memory device drive. 

4. Click Create Media. If there is data on the memory device, you will be prompted to 
clear the device. Click Yes to clear this device. Click Yes To All to clear all memory 
devices inserted into the machine. Or, click No to exit the Poll Place Media process.

5. Once you have cleared the memory device and created the media, a message will 
appear stating that the Reporting Key Media has been created.

6. Remove the memory device from your PC.

7. Click OK to return to Electionware.

Import Results and View Data

After the election, the Acquire Module is used to load election results from the 
election’s media devices into the Electionware database. Additional Acquire functions 
are used to review, export and report media device related data. When results have 
been loaded, the Produce Module is used to filter, view and export ballot data, print 
ballot scan images and facsimiles, view ballot scan images and cast vote records and 
generate the Election Results Summary report.

Note: Reporting Key Media should be created after all of the poll place devices are 
created. If a poll place device is created after the ERM device, the ERM device should be 
recreated.

Note: If your device drive does not appear in the list, click Refresh to update the available 
selections, then select the memory device drive.
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Import Results Data 

1. From the Modules menu, point to Results and click Acquire.

2. From the Manage menu, select Load Results.

3. Browse to the repository that contains the results files generated by Election 
Reporting Manger. Then click the Start Load button to import the data into 
Electionware

4. Use the Poll Place Navigator to display poll place/media device records in table view 
as required. Export records as required.

5. Generate and print or save Media Status and Machine Log Reports as required.

View, Print and Export Ballot Data

1. From the Modules menu, point to Results and click Produce.

2. Use filter options to filter the display of ballot records. 

3. Print ballot images and facsimiles and export ballot records from table view as 
required.

4. View and print ballot scan images and Cast Vote Records from the Ballot Viewer as 
required.

5. Generate and print or save the Election Results Summary report.

General Timeline for Election Preparation

Reference: See Electionware Volume V: Results User’s Guide, Chapter 1: Acquire Module, 
for detailed information about Acquire related functions. 

Reference: See Electionware Volume V: Results User’s Guide, Chapter 2: Produce Module, 
for detailed information about Produce related functions. 

90 Days Submit site support request to ES&S

63 Days All forms are due to ES&S (excluding Candidate forms)

56 Days Candidate forms due to ES&S

46 Days Last day to give ballot proofs to Counties (strictly for 
military or overseas voting).

45 Days Absentee Voting begins

42 Days Certification Deadline
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28 Days All ballot proofs must be signed off

21 Days Last day to deliver Election Day ballots

20 Days Advance or early voting begins

18 Days Last day for ES&S to ship coding materials

10 Days Software Installation for pre-election procedures

1 Day Early voting ends

Reference: See the Personnel Deployment and Training Requirements document for more 
information.
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Part 2: Setup

The Setup module of the Manage group enables you to manage elements such as user 
information and status, as well as jurisdictions. Manage contains information about the 
following topics:

 Chapter 12: Introduction to the Manage Module

 Chapter 13: Setup Navigator

 Chapter 14: Manage Jurisdictions

 Chapter 15: Manage Users

 Chapter 16: Set User Password Policies

 Chapter 17: Database Maintenance

 Chapter 18: Customize Labels

 Chapter 19: Set Election Code Strength

 Chapter 20: Setup Reports
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Chapter 12: Introduction to the Manage Module

Use the commands in Setup to manage user and jurisdiction information. Here you can 
perform actions such as adding and editing users, as well as adding and editing 
jurisdictions. Although this module is the last in the menu tree, the functions utilized 
here are some of the first steps you will take while using Electionware.

From the Modules menu, point to Manage and click Setup.

• Or, from the Modules pane, click Manage, and then click the 
Setup icon. 

The Setup Module is now active in the Electionware Workspace.

Note: The Manage module can be accessed only by users with administrator status.
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Setup Toolbar Icons

In addition to the default 
Electionware icons, Setup has a 
unique set of icons in the toolbar 
as well. Use these icons as 
shortcuts to Electionware menu 
options.

Setup Status

The Setup Status screen includes information regarding the current status of the setup 
module. This information includes the Number of Users, Last User, and time and date 
stamping for the Last Edit Time. The time and date stamp is updated to reflect the most 
recent time and date that the Setup module was accessed.

Reference: For information 
regarding the default 
software icons, see Chapter 
10: Default Electionware 
Icons.

Setup Toolbar Icons

Icon Action Name Description

Add User
Add a new user 
to Electionware.

Set User Password 
Policies

Set the number 
of days until the 
user password 
expires.

Set Election Code 
Strength

Adjust the 
Election Code 
Strength for the 
ES&S DS200, 
DS850, and 
AutoMARK.

Add State
Add a state to 
Electionware.

Add County
Add a county to 
Electionware.
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The Setup Status screen is 
displayed when you access the 
Setup module. 
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Chapter 13: Setup Navigator

As mentioned in the Introduction, the Navigator pane changes in conjunction with the 
selected module. The following information delineates functionality in the Navigator 
pane, as it is utilized in the Setup module.

Upon selecting the Setup module, note the two navigation buttons at the bottom of the 
Navigator pane: Users and Jurisdictions. The navigation buttons open a specific view in 
the Navigator pane, and work in conjunction with menu selections in the Jurisdiction 
and Manage menus. Please review the following for more information regarding these 
views or menu options.

Users

Use the Users Navigator button to open the users view in the 
Navigator pane. The users view enables you to add users, edit 
users, and change the status of users in Electionware. It also 
enables you to produce a User Report. 

Note: The navigator pane view corresponds to the highlighted button in the Navigator 
pane.

Reference: See Chapter 20: Setup Reports for information 
about the User Report, instructions on how to generate the 
User Report, and a sample User Report.
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By utilizing the Navigator toolbar 
icons in conjunction with 
right-clicking elements in the 
navigator tree, you will be able to 
perform many of the functions 
normally performed through the 
Electionware menu tree.

Jurisdictions

Use the Jurisdictions Navigator button to open the 
jurisdictions view in the Navigator pane. The jurisdictions view 
enables you to add, edit, and delete states and counties from 
Electionware.

Reference: More 
information about adding 
and editing users can be 
found in Chapter 15: 
Manage Users.

User Icons

Icon Action Name Description

Add User/Edit 
User

When Users is 
selected, this icon 
adds users. 

When a specific 
user is selected, 
this icon edits 
users.

Make User Inactive
Make the 
selected user 
inactive.
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By utilizing the Navigator toolbar 
icons in conjunction with 
right-clicking elements in the 
navigator tree, you will be able to 
perform many of the functions 
normally performed through the 
Electionware menu tree.

Reference: More 
information about adding, 
editing, and deleting 
jurisdictions can be found 
in Chapter 14: Manage 
Jurisdictions.

Jurisdiction Icons

Icon Action Name Description

Add State

When 
Jurisdictions is 
selected, this icon 
adds states. 

Add County
When a state is 
selected, this icon 
adds counties.

Edit State/Edit 
County

When a state is 
selected, this icon 
edits states. 

When a county is 
selected, this icon 
edits counties.

Delete State/
Delete County

When a state is 
selected, this icon 
deletes states. 

When a county is 
selected, this icon 
deletes counties.
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Chapter 14: Manage Jurisdictions

The Jurisdiction menu enables you to edit items as they relate to your jurisdiction. Use 
the Add State feature to add states to Electionware. Use the Add County feature to 
add counties to the selected state.

Add State

Use the Add State option to add a state to Electionware.

1. From the Jurisdiction menu, click Add State. 

• Or, right click Jurisdictions in the Navigator pane and select Add 
State.

The Add State screen appears in the work pane.

2. Enter your state’s name in the 
State Name field.

3. Enter additional jurisdictional 
text that may be required for 
your elections in the Additional 
Text field.

4. After you have entered the 
state information, select Save if 
you want to save this state’s 
information. Select Clear to 
discard all changes made on the 
screen, or select Close to exit 
the screen.

If you close the Add State screen prior to saving, a prompt will appear asking you if you 
want to save. Click Yes to save and exit the screen. Click No to close the prompt and the 
Add State screen without saving. Or, click Cancel to return to the Add State screen.

The state information you added will appear in the 
navigator pane.

Note: The Jurisdictions button must be selected to add or edit jurisdiction information.

Note: The Electionware State and County are defaulted 
to be incorporated with any new install of Electionware. 
These entities cannot be deleted.
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Edit State

The Edit State feature enables you to edit states already created in Electionware. Use 
the following steps to edit a state.

1. Right-click the appropriate state and select Edit State. 

• Or, from the Navigator pane, select the Edit State 
icon.

The Edit State screen appears in the work pane.

2. Make the necessary changes 
to the state’s information, and 
then click Save. Click Refresh 
to discard all changes made on 
the screen and to reset the 
values to those last saved. 
Click Close to close the Edit 
State screen without saving 
any changes made to the 
screen.

Delete State

The Delete State feature enables you to delete states already created in Electionware. 
Use the following steps to delete a state.

1. To delete a state, right-click on the desired state and 
click Delete State. 

• Or, select the appropriate state and click the Delete 
State Navigator icon.

A prompt appears requesting that you confirm the deletion 
of the state.
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2. Click Yes to confirm the deletion of the state, or click No to cancel the deletion and 
return to the main Electionware window.

If you click Yes, a message is displayed to inform you that the selected state has 
been deleted. Click OK to close the message window.

Add County

Use the Add County feature to add counties to Electionware. 

1. From the Navigator pane, select the state to which you wish to add a county.

2. From the Jurisdiction menu, click Add County. 

• Or, right-click the state you want to add a county to in the 
Navigator pane and click Add County.

The Add County screen appears in the work pane.

3. Enter your county name in the 
County Name field.

4. Enter any additional text that 
pertains to your county in the 
Additional Text field.

5. After you have entered the 
county information, select Save 
if you want to save this county’s 
information. Select Clear to 
discard all changes made on the 
screen, or select Close to exit 
the screen.

If you close the Add County screen prior to saving, a prompt will appear asking you if 
you want to save. Click Yes to save and exit the screen. Click No to close the prompt 
and the Add County screen without saving. Or, click Cancel to return to the Add County 
screen.

Note: Prior to deleting a state, any counties listed under that state must be deleted first.

Note: A state must be selected to add a county.
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The county information you added will appear below 
your state in the navigator pane.

Edit County

The Edit County feature enables you to edit counties already created in Electionware. 
Use the following steps to edit a county.

1. Right-click the appropriate county and select Edit 
County. 

• Or, select the appropriate county and click the 
Edit County Navigator icon.

The Edit County screen appears in the work pane.

2. Make the necessary changes 
to the county’s information, 
and then click Save. Click 
Refresh to discard all 
changes made on the screen 
and to reset the values to 
those last saved. Click Close 
to close the Edit County 
screen without saving any 
changes made to the screen.

Delete County

The Delete County feature enables you to delete counties already created in 
Electionware. Use the following steps to delete a county.

1. To delete a county, right-click on the appropriate 
county and select Delete County. 

• Or, select the appropriate county and click the 
Delete County Navigator icon.

A prompt appears requesting that you confirm the 
deletion of the county.

Note: The Electionware State and County are 
defaulted to be incorporated with any new install of 
Electionware. These entities cannot be deleted.
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2. Click Yes to confirm the deletion of the county, or click No to cancel the deletion 
and return to the main Electionware window.

If you click Yes, a message is displayed to inform you that the selected county has 
been deleted. Click OK to close the message window.
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Chapter 15: Manage Users

The Manage menu enables you to add users to Electionware and set user password 
policies and the Election Code strength. This chapter covers the user-related functions. 
Subsequent chapters cover setting the user password policies and the Election Code 
strength.

Add User

The Add User menu option enables you to add users to Electionware. To add users to 
Electionware, follow the steps below.

1. From the Manage menu, click Add User. 

The Add User screen appears in the work pane.

2. Type the new user’s name in 
the First Name and Last Name 
fields.

3. In the Login ID field, type the 
ID the new user will use to log 
in to Electionware.

4. From the Access Level list, 
select whether the new user 
will be an Administrator, 
Ballot Producer, Media 
Creator, Ballot Reviewer, or a 
User.

Note: The Users button must be selected to add or edit user information.

Note: All users must have their own login for multiple user functionality in Electionware.
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• An Administrator has access to all functionality in Electionware.

• A User has access to most of the functionality in Electionware except the 
Manage module. This limited access will not allow an individual with User level 
access to print the audit log.

• A Ballot Producer has limited access and can only print BOD ballots in 
Electionware.

• A Media Creator has limited access and can only create media in Electionware.

• A Ballot Reviewer has limited access and can only review ballots in 
Electionware.

5. In the Password field, enter the password the new user will use to access 
Electionware.

6. Re-enter the same password in the Confirm Password field.

The password you enter will be obscured, it must be at least eight characters, and it 
must contain at least one character from three of the following four classes.

• Upper case letters (A-Z)

• Lower case letters (a-z)

• Numerals (0-9)

• Punctuation symbols ‘ ~ ! @ # $ % ^ & * ( ) = + , . / < > ? ; : “ [ ] { } | 

If the password does not meet these criteria, you will be prompted to re-enter a 
password that meets these criteria. Click OK and enter a password in the Password 
and Confirm Password fields that meets these requirements. The password you 
enter in the Confirm Password field must match the password you entered in the 
Password field. After you enter a password in the Confirm Password field that 
matches the password you entered in the Password field, the red “X” to the right of 
the Confirm Password field changes to a green check mark.

7. From the Status list, select whether the user is active or inactive.

• Active identifies a person who is currently eligible to use Electionware.

• Inactive means the person is not currently eligible to use Electionware.

For example, if an employee is terminated, you can change the user’s Status from 
Active to Inactive to prevent the terminated employee from logging in to 
Electionware. (You cannot delete a user.) If you have an employee taking an 
extended leave, you might set the user’s Status to Inactive when the employee 
leaves and then set it to Active again when the employee returns. 

8. After you have entered the user’s information, select Save if you want to save the 
new user in Electionware. Select Clear to discard all changes made on the screen, or 
select Close to exit the screen.

Note: During installation, a default administrator is added to Electionware to enable you to 
log in and add other users.
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If you close the Add User screen prior to saving, a prompt will appear asking you if you 
want to save. Click Yes to save and exit the screen. Click No to close the prompt and the 
Add User screen without saving. Or, click Cancel to return to the Add User screen.

Edit a User

Use the list of users in the Navigator pane to edit existing users. To edit a user, follow 
the steps listed below:

1. Right-click on an existing user in the Navigator pane 
and select Edit User. 

The user screen for that user will open.

Make the necessary changes to the 
user’s information, and then click 
Save. Click Refresh to discard all 
changes made on the screen and to 
reset the values to those last saved. 
Click Close to close the user screen 
without saving any changes made to 
the screen.

Make a User Inactive

Electionware users cannot be deleted. Instead, they can be made inactive. Use the list 
of users in the Navigator pane to make a user active or inactive. To make a user inactive, 
follow the steps listed below:

Note: You cannot change the login ID of any user, including the default administrator. You 
cannot change the access level and/or status of the default administrator. You cannot 
change your own status to inactive.
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1. Right-click on an active user in the Navigator pane. From 
the menu, click Make User Inactive.

A prompt appears asking you to confirm that you want to 
make the user inactive.

2. Click Yes to confirm making the user inactive, or click No to cancel making the user 
inactive and return to the main Electionware window.

Making a user inactive will change the icon so that a red ‘no’ 
symbol will appear on the user icon, next to the user name.

Make a User Active

Depending on the situation, you may be required to make an inactive user active once 
again. Follow the steps below to make an inactive user active in Electionware:

1. To make an inactive user active again, right-click on an 
inactive user, and select Make User Active.

A prompt appears asking you to confirm that you want to make the user active.

2. Click Yes to confirm making the user active, or click No to cancel making the user 
active and return to the main Electionware window.

Note: You cannot change the default administrator’s status or 
your own personal status to inactive.

Note: You can also change the status of a user by using the Status option on the user 
screen.

Note: You can also change the status of a user by using the Status option on the user 
screen.
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Chapter 16: Set User Password Policies

Electionware enables you to set password policies for users. This option enables you to 
specify the number of days for user password expiration. When an administrator assigns 
a password to a user or when a user changes his/her password, the user is able to use 
that password to log in to Electionware for the specified number of days. When the 
specified number of days has elapsed, the user’s password expires. When the user 
attempts to log in to Electionware again, he/she is forced to change his/her password 
before he/she can log in. To set user password policies, follow the steps below:

1. From the Modules menu, select Manage and click Setup.

2. From the Manage menu, select Set User Password 
Policies.

The User Password Policies 
screen appears in the work 
pane.

3. In the Number of days before 
expiration field under Security 
Setting, enter the number of 
days for the user password to 
remain valid.

• Or, use the up and down arrows to manually select a number of days.

After you have entered the number of days for the password expiration, select Save if 
you want to save the setting. Select Clear to discard the change made on the screen 
and reset the value to the one last saved, or select Close to exit the screen.

If you close the User Password Policies screen prior to saving, a prompt will appear 
asking you if you want to save. Click Yes to save and exit the screen. Click No to close 
the prompt and exit the User Password Policies screen without saving. Or, click Cancel 
to return to the User Password Policies screen.

Note: If you set the Number of days before expiration field to zero, the user passwords 
will never expire.
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Chapter 17: Database Maintenance

When a large amount of data is deleted from an election, the database may leave 
significant amounts of empty space that the system defines as relevant. As this space is 
actually comprised of placeholders left for the deleted information, these spaces can be 
reclaimed by using the options found under Database Maintenance.

Vacuum Analyze

The Vacuum Analyze option, enables Electionware to inspect the database for empty 
placeholders. Use this option prior to the Vacuum Full option, as this will enable the 
system to recognize empty placeholders prior to removing them.

To run the Vacuum Analyze option, use the following steps:

1. From the Tools menu, point to Database Maintenance and then select Vacuum 
Analyze.

The system automatically starts the database analysis. You will be prompted when the 
process is complete. To check for messages, be sure to scan the Output-Events portion 
of the screen for any important information.

Vacuum Full

The Vacuum Full option goes through the database and eliminates all of the empty 
placeholders found during the Vacuum Analyze scan performed previously. Use this 
option after deleting information from the election to clean out empty placeholders, 
thereby freeing up space within the database, and helping to prevent potential errors.

To run the Vacuum Full option, use the following steps:

1. From the Tools menu, point to Database Maintenance and then select Vacuum Full.

The system automatically starts the vacuum process. You will be prompted when the 
process is complete. To check for messages, be sure to scan the Output-Events portion 
of the screen for any important information.

Note: The Vacuum Analyze option is only enabled if an election is open.

Note: The Vacuum Full option is only enabled if an election is open.
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Chapter 18: Customize Labels

For jurisdictions that do not utilize the terms “precinct” or “split,” Electionware contains 
a feature that enables you to change the name of these jurisdictional entities at any 
time. Use the Customize Labels option found under the Tools menu to customize this 
naming convention.

(Example: New York City utilizes the term “Election District” rather than precinct. Users 
in this jurisdiction would customize this name in order to conform to local naming 
conventions.)

Use the steps below to customize precinct/split labels:

1. From the Tools menu, select Customize Labels.

The Label Customization screen appears.

2. Enter the new name for the list of available items in the New Label column.

For instance, in the New Label column, enter Election District in the cell adjacent to 
Precinct.

In the cell next to Precincts, enter the term Election Districts to represent the 
pluralized form of the term.

3. Proceed through the list until all necessary labels have been customized.

4. When finished, click the Save button to save your changes.

Warning: Election Labels must be customized prior to creating the election. Once the 
election is created, these labels cannot be changed.
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Chapter 19: Set Election Code Strength

Set Election Code Strength enables you to set the election code strength for ES&S 
DS200, ES&S DS850, ES&S ExpressVote, and ES&S AutoMARK. Follow the steps below 
to access the Election Code Strength screen.

1. From the Manage menu, click Set Election Code Strength. 

The Election Code Strength screen appears in the work pane.

2. Use the slider bar at the 
left-hand side of the 
screen to adjust the 
Election Code strength.

3. The slider bar allows for 
three settings: High, 
Medium, and Low. 

 High: The Election Code 
you define must contain 
8-16 characters and have 
at least three of the four 
listed characteristics:

• Upper case letters 
(A-Z)

• Lower case letters (a-z)

• Numerals (0-9)

• Punctuation symbols ‘ ~ ! @ # $ % ^ & * ( ) = + , . / < > ? ; : “ [ ] { } | 

 Medium: The Election Code must contain 6-16 characters and at least one letter and 
one number.

 Low: The Election Code must contain 4-16 characters.

After you have selected your Election Code strength, click Save if you want to save the 
new Election Code Strength setting. Select Refresh to discard the change made on the 
screen and reset the value to the one last saved, or select Close to exit the screen.

Note: In order to access the Set Election Code Strength feature, an election must be 
selected.

Note: The ‘-’ (hyphen) is the only symbol available for the ES&S AutoMARK Election Code.



 Chapter 19: Set Election Code Strength 109

EVS5200_DOC_SOP_EW01ADMIN
 Software Version 4.6

 Published: April 24, 2014

If you close the Election Code Strength screen prior to saving, a prompt will appear 
asking you if you want to save. Click Yes to save and exit the screen. Click No to close 
the prompt and the Election Code Strength screen without saving. Or, click Cancel to 
return to the Election Code Strength screen.

Note: While a user is setting the Election Code Strength for an election, no other user can 
access that election. 
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Chapter 20: Setup Reports

Use the Reports menu in Setup to access the report options for that module. 

User Report

Use the User Report option to access information about users that have been entered 
into the Electionware system. The User Report includes specific information about each 
user. This information includes the User ID, First Name, Last Name, whether the user is 
active, when the user account was created, and the last login of the user. The time and 
date stamp is updated to reflect the most recent time and date the user accessed 
Electionware.

To run this report, from the Reports menu click User Report.

The User Report appears:

Use the Report Screen Toolbar to Print, Save, change the current page, or change the 
view of the displayed report.

Reference: See Report Screen Toolbar for further information regarding Report Screen 
Toolbar functions.



 Chapter 20: Setup Reports 111

EVS5200_DOC_SOP_EW01ADMIN
 Software Version 4.6

 Published: April 24, 2014

Admin Audit Events Report

Use the Admin Audit Events Report option to access detailed audit information. This 
report includes information regarding all administrator events in Electionware. This 
information includes the type of Event, an event Description, the event’s Timestamp, 
the User ID, and the module in which the event occurred. The time and date stamp is 
updated to reflect the most recent audit event.

To run this report, from the Reports menu click Admin Audit 
Events Report.

An Admin Audit Events Report Criteria window opens.

Use the options in the Admin Audit Events 
Report Criteria window to define the criteria 
for the report you wish to run.

 Use the From Date field to enter a start 
date for the report. (Example: The date on 
which you started creating the current 
election.)

 Use the To Date field to enter an end date 
for the report. 

 Use the Event Type drop-down menu to 
choose the type of events to display in the report. Available options are listed 
below:

• Fatal: The Fatal option will report only the fatal error messages that were 
displayed to the administrator between the selected dates.

• Debug: The Debug option will report only the debug messages displayed to the 
administrator between the selected dates.

• Verbose: The Verbose option will report only the verbose messages displayed 
to the administrator between the selected dates.

• Info: The Info option will report only the information related messages displayed 
to the administrator between the selected dates.

• Warning: The Warning option will report only the warning related messages 
displayed to the administrator between the selected dates.

• Error: The Error option will report only the error related messages displayed to 
the administrator between the selected dates.

• All: The All option will report every message displayed to the administrator 
between the selected dates.

 Use the Date-Ascending or Date-Descending option button to sort the events by 
ascending date (chronological) or descending date (reverse chronological) order. 
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When you have finished selecting the report criteria, click Run Report. 

• Or, to exit the window without running a report, click Cancel.

The Admin Audit Events Report appears:

Use the Report Screen Toolbar to Print, Save, change the current page, or change the 
view of the displayed report.

Election Audit Events Report

Use the Election Audit Events Report option to access detailed audit information. This 
report includes information regarding events in Electionware for the open election. 
Information in this report includes the type of Event, an event Description, the event’s 
Timestamp, the User ID, and the module in which the event occurred. The time and 
date stamp is updated to reflect the most recent audit event.

Reference: See Report Screen Toolbar for further information regarding Report Screen 
Toolbar functions.

Note: An election must be open in order to run the Election Audit Events Report.
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To run this report, from the Reports menu click Election Audit 
Events Report.

An Election Audit Events Report Criteria window opens.

Use the options in the Election Audit Events 
Report Criteria window to define the criteria 
for the report you wish to run.

 Use the From Date field to enter a start 
date for the report. (Example: The date on 
which you or other users started creating 
the current election.)

 Use the To Date field to enter an end date 
for the report. 

 Use the Event Type drop-down menu to 
choose the type of events to display in the report. Available options are listed 
below:

• Fatal: The Fatal option will report only the fatal error messages that were 
displayed to the user for the open election between the selected dates.

• Debug: The Debug option will report only the debug messages displayed to the 
user for the open election between the selected dates.

• Verbose: The Verbose option will report only the verbose messages displayed 
to the user for the open election between the selected dates.

• Info: The Info option will report only the information related messages displayed 
to the user for the open election between the selected dates.

• Warning: The Warning option will report only the warning related messages 
displayed to the user for the open election between the selected dates.

• Error: The Error option will report only the error related messages displayed to 
the user for the open election between the selected dates.

• All: The All option will report every message displayed to the user for the open 
election between the selected dates.

 Use the Date-Ascending or Date-Descending option button to sort the events by 
ascending date (chronological) or descending date (reverse chronological) order. 

When you have finished selecting the report criteria, click Run Report. 

• Or, to exit the window without running a report, click Cancel.
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The Election Audit Events Report appears:

Use the Report Screen Toolbar to Print, Save, change the current page, or change the 
view of the displayed report.

Reference: See Report Screen Toolbar for further information regarding Report Screen 
Toolbar functions.



 Chapter 20: Setup Reports 115

EVS5200_DOC_SOP_EW01ADMIN
 Software Version 4.6

 Published: April 24, 2014

Access Codes Report

Use the Access Codes Report option to access information about user codes. This 
information includes the Code Type, the Code, and the last time the code was saved. 
The time and date stamp is updated to reflect the most recent code activity.

To run this report, from the Reports menu click Access Codes 
Report.

The Access Codes Report appears:

Use the Report Screen Toolbar to Print, Save, change the current page, or change the 
view of the displayed report.

Reference: See Report Screen Toolbar for further information regarding Report Screen 
Toolbar functions.
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Chapter 21: Shortcut Keys

Module and Function Shortcut Keys Tool Tip

Home Ctrl+Shift+H Create and open elections and 
election templates

Capture Ctrl+Shift+C Create, import, and manage 
election data

Element Library Ctrl+Shift+E Import and export system 
translations, audio, and graphics

Paper Ballot Ctrl+Shift+B Create and edit print layouts for 
ballots

Accessible Ballot Ctrl+Shift+A
Manage ballot content for 
accessible equipment and preview 
AutoMARK ballots

Configure Ctrl+Shift+F Manage the election equipment 
settings and security

Package Ctrl+Shift+K Create election media for 
equipment

Print Ctrl+Shift+P View and print Ballot on Demand 
(BOD) ballots

Acquire Ctrl+Shift+Q Import election results for 
adjudication procedures.

Produce Ctrl+Shift+U
View ballots and cast vote records 
in order to facilitate the 
adjudication process.

Setup Ctrl+Shift+T Manage jurisdictions, security code 
strength, and Electionware users
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Chapter 22: General Information

Report Screen Toolbar

Each module within Electionware offers its own collection of individual reports. These 
reports appear in the work space, and can be saved, viewed and printed all by utilizing 
the report screen toolbar. Use the report screen toolbar to save, print, scroll through 
pages, and change the view of the report currently displayed. Use the following 
information for reference on how to use the Report Screen Toolbar.

Saving and Printing Reports

To access the Report Screen Toolbar, use the Reports menu to produce reports specific 
to the module you are currently using.

Upon displaying the report in the work space, the report screen toolbar becomes 
available:

At the top left of the Report Screen 
Toolbar are the Print and Save icons.

Use the Save icon to save the report 
currently displayed in the Report Screen. Electionware reports may be saved as (.pdf, 
.rtf, .odt, .html, .xls or .csv) formats. Click the Save icon.

Note: An election must be selected before trying to access a report.

Note: Reports are defaulted to save in the (.pdf) format.
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A browser window appears. Enter a file name that describes the report in the File name 
field, and click Save Report File.

Use the Print icon to print a hardcopy of a 
report. The Print window appears:

Select the printer of your choice from the 
Name drop-down menu.

You can choose to print all pages by selecting 
All from the print range window. Or, you can 
select a specific page range by selecting 
Pages, and entering the desired page 
numbers in the from and to fields.

Select the number of copies you wish to print 
from the Number of copies cell. You may enter the number of copies you wish 
manually, or you can use the up or down arrows to increase or decrease the number of 
copies respectively.

Select Collate if you wish the report pages to print in sequential order.

Click Cancel to cancel the print job and close the Print window. Or, click OK to accept 
the print job and return to the Electionware window.

Page Selection Arrows

Use the page selection arrows to navigate through the report pages sequentially, or to 
jump to the beginning or end of the report. 

Click the Previous Page arrow to move one page backward in the report. 

Click the Next Page arrow to move one page forward in the report.

Note: The print option can be used to create soft copies of a report as well. Use the Name 
drop-down list to select Adobe PDF option if Adobe 9.0 or higher is installed. Otherwise 
select Print to file from the drop-down menu.
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Click the First Page arrow to skip to the first page. 

Click the Last Page arrow to skip to the last page.

Or, use the Go To Page field to skip to a specific 
page in the report. You can also use this field to 
check the number of the currently displayed 
page.

Changing the On screen Report View

Use the page size and zoom icons to change the way that the on screen report is 
currently displayed. 

Use the Actual Size icon to view the report in its actual size.

Use the Fit Page icon to make the report fit the page to the size of the current screen.

Use the Fit Width icon to make the report fit to the width of the current screen.

Use the Zoom In icon to zoom in on the report.

Use the Zoom Out icon to zoom out of the report.

Use the Zoom Ratio drop-down menu to manually select the size of the report on 
screen. The Zoom Ratio ranges from 50% to 800%. Select from the available 
percentages, or enter a manual percentage in the box.
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Chapter 23: System Messages

Message ID Message Message Type Solution

10340007 --------------------------------------------------------
---------

Informational 
Message

Contact ES&S.

10720128 ”Alert Voter if all [item name] Choices 
have not been Displayed” and “Force 
Voter to View all [item name] 
Choices” cannot both be checked.

Error Message Click OK to continue. Verify the 
necessary parameters and then 
retry the action.

10720137 ”Alert Voter to Listen to all [item 
name] Choices” and “Force Voter to 
Listen to all [item name] Choices” 
cannot both be checked.

Error Message Click OK to continue. Verify the 
necessary parameters and then 
retry the action.

10240044 [Custom] Informational 
Message

Click OK to continue. 

10020032 [Custom] Error Message Click OK to continue.

10020035 [Custom] Error Message Click OK to continue.

10030010 [Custom] Warning 
Message

Click OK to continue.

10040008 [Custom] Informational 
Message

Click OK to continue.

10840009 [Custom] formatting saved 
successfully.

Informational 
Message

Click OK to continue.

10240059 [Custom] attributes were displayed 
for [Custom].

Informational 
Message

Click OK to continue. 

10220175 [District ID] cannot contain a 
pre-defined ID of COU, PRC, or APC

Error Message Click OK to continue. Remove 
any invalid prefixes from the 
District ID and click Save.

10220182 [Custom] cannot have a cross 
endorsement number greater than 0.

Error Message Click OK to continue. Check for 
any invalid parameters and then 
retry the action.

11740014 [Custom] exported for [Custom] into 
the following files: [file name]

Informational 
Message

Click OK to continue.

11730001 [Custom] exported for [Custom] into 
the following files: 

Warning: [number] ballots did not 
have images and were not included in 
the export.

Warning 
Message

Click OK to continue. Check for 
any invalid parameters and then 
retry the action.

10220168 [Custom] field is required. Please 
provide a value.

Error Message Click OK to continue. Provide 
the appropriate value and retry 
the action.

10240106 [Custom] generated for [Custom]. Informational 
Message

Click OK to continue. 

10240085 [Custom] generated. Informational 
Message

Click OK to continue. 
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10740011 [Custom] settings have been updated. Informational 
Message

Click OK to continue. 

10340002 [Custom] Ballot styles generated 
successfully.

Informational 
Message

Click OK to continue. 

10340008 [Number] Ballot styles generated 
successfully.

Informational 
Message

Click OK to continue. 

10340006 [Number] Ballot styles generated 
successfully.

Number of warnings:  [Number].

Informational 
Message

Click OK to continue.

10340009 [Number] Ballot styles generated 
successfully.

Number of warnings:  [Number].

Informational 
Message

Click OK to continue.

10640016 [Custom] Ballot zip file created: 
[Filename]

Informational 
Message

Click OK to continue.

10720122 [Code name] code contains spaces. 
Please remove the spaces.

Error Message Remove any spaces from the 
specified code and then retry 
the action.

10720130 [Code name] code has invalid 
characters. The only allowed symbols 
are dashes.

Error Message Remove any invalid characters 
from the specified code and 
then retry the action.

10720132 [Code name] code has invalid 
characters.

Spaces, pipe symbols, double quotes 
and colons are not allowed.

Error Message Remove any spaces or invalid 
characters from the specified 
code and then retry the action.

10720123 [Code name] code is blank. Please 
enter a value.

Error Message Enter a code in the specified 
field and then retry the action.

10720124 [Code name] code is too long. Please 
change the value so that it does not 
exceed [number] characters.

Error Message Reduce the number of 
characters in the code and then 
retry the action.

10720121 [Code name] code is too short. Please 
enter at least [number] characters for 
this value.

Error Message Enter at least the minimum 
number of characters and then 
retry the action.

10720126 [Code name] code matches [Code 
name] code.

Please make sure all codes are unique 
before saving.

Error Message Verify that the entered codes 
are not identical and then retry 
the action.

10720129 [Code name] code must contain at 
least one character from 3 of the 
following 4 classes: [Class type]

Error Message Verify that the code meets the 
necessary character criteria and 
then retry the action.

10720131 [Code name] code must contain at 
least one character from 3 of the 
following 4 classes: [Class type]

Error Message Verify that the code meets the 
necessary character criteria and 
then retry the action.

Message ID Message Message Type Solution
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10720133 [Code name] code must contain at 
least one letter and one number.

Error Message Verify that the code contains at 
least one letter and one number 
and then retry the action.

10720134 [Code name] code must contain at 
least one number or letter.

Error Message Verify that the code contains at 
least one letter and one number 
and then retry the action.

10720120 [Code name] codes do not match. Error Message Verify that the code field and 
the confirmation field match. 
Click Save to save the code.

11530001 [Code name] codes must be entered.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Enter the 
necessary codes and then retry 
the action.

11530009 [Code name] codes must be entered.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Enter the 
necessary codes and then retry 
the action.

10740025 [Code name] codes updated. Informational 
Message

Click OK to continue.

11530006 [Custom] data cannot be processed 
until style data has been updated 
from Paper Ballot.

Would you like to go to the Paper 
Ballot Equipment module?

Warning 
Message

Click Yes to go to the Paper 
Ballot module. Update the data 
style and re-finalize the ballot 
layout to continue.

11530014 [Election Name] data cannot be 
processed until style data has been 
updated from Paper Ballot.

Would you like to go to the Paper 
Ballot Equipment module?

Warning 
Message

Click Yes to go to the Paper 
Ballot module. Update the data 
style and re-finalize the ballot 
layout to continue.

11530005 [Election Name] data must be 
processed again, since [Code name] 
codes have been updated.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Regenerate 
data for the appropriate 
equipment type and then retry 
the action.

11530013 [Election Name] data must be 
processed again, since [Code name] 
codes have been updated.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Regenerate 
data for the appropriate 
equipment type and then retry 
the action.

11530004 [Election Name] data must be 
processed again, since [Setting name] 
settings have been updated.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Regenerate 
the election data for all 
equipment and then retry the 
action.
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11530012 [Election Name] data must be 
processed again, since [Setting name] 
settings have been updated.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Regenerate 
the election data for all 
equipment and then retry the 
action.

11530003 [Election Name] data must be 
processed again, since a re-import of 
election data has occurred.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Regenerate 
the election data for all 
equipment and then retry the 
action.

11530011 [Election Name] data must be 
processed again, since a re-import of 
election data has occurred.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Regenerate 
the election data for all 
equipment and then retry the 
action.

11530008 [Election Name] data must be 
processed again, since style settings 
have been updated in Accessible 
Ballot.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Regenerate 
the election data for all 
equipment and then retry the 
action.

11530016 [Election Name] data must be 
processed again, since style settings 
have been updated in Accessible 
Ballot.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Regenerate 
the election data for all 
equipment and then retry the 
action.

11530007 [Election Name] data must be 
processed again, since style settings 
have been updated in Paper Ballot.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Regenerate 
the election data for all 
equipment and then retry the 
action.

11530015 [Election Name] data must be 
processed again, since style settings 
have been updated in Paper Ballot.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Regenerate 
the election data for all 
equipment and then retry the 
action.

11530002 [Election Name] data must first be 
processed.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Generate 
the election data for all 
equipment and then retry the 
action.

11530010 [Election Name] data must first be 
processed.

Would you like to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module. Generate 
the election data for all 
equipment and then retry the 
action.
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10540008 [Item name] Deleted: [Number] Informational 
Message

Click OK to continue.

10230143 Do you want to continue? Warning 
Message

Click Yes to continue.

10640005 [Equipment Type] Election Media 
created for [Poll Name].

Please remove the device.

Informational 
Message

Remove the device to continue.

11740013 [Item name] export canceled by user. Informational 
Message

Click OK to continue.

10220169 [Field Name] field is required. Please 
provide a value.

Error Message Enter a value in the specified 
field and then retry the action.

10240105 [Process Name] generation 
successfully canceled.

Informational 
Message

Click OK to continue.

10120054 [Item name] has already been 
updated by another user or module.

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen and then make your 
changes.

Error Message Click the Refresh button to 
refresh the information on the 
screen, and then retry the 
action.

10120064 [Item name] has already been 
updated by another user or module.

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen and then make your 
changes.

Error Message Click the Refresh button to 
refresh the information on the 
screen, and then retry the 
action.

10220147 [Item Name] ID is required. Please 
provide a value.

Error Message Enter the appropriate 
information and then retry the 
action.

10220148 [Item Name] ID is too long. Please 
change the value so that it does not 
exceed [Number] characters.

Error Message Reduce the number of 
characters in the specified ID 
field and then retry the action.

10220149 [Item Name] ID must be exactly 
[Number] characters.

Error Message Enter the designated number of 
characters in the specified ID 
field and then retry the action.

10230112 [Item Name] ID not in ascending 
numeric order. 

Is that OK?

Warning 
Message

Click Yes to continue with the 
process, or No to cancel it.

10220151 [Item Name] ID should be between 
[Number] and [Number].

Error Message Verify the specified parameters 
and then retry the action.

10720141 [Item Name] is not valid or cannot be 
validated due to the following reason: 

[Reason]

Error Message Click OK to continue. If 
possible, correct the specified 
issue and then retry the action.

10220132 [Item Name] is required. Please 
provide a value.

Error Message Enter a value in the specified 
field and then retry the action.
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10720016 [Item Name] is required. Please 
provide a value.

Error Message Enter a value in the specified 
field and then retry the action.

11021018 [Item Name] is required. Please 
provide a value.

Error Message Enter a value in the specified 
field and then retry the action.

10220145 [Item Name] is too long. Please 
change the value so that it does not 
exceed [Number] characters.

Error Message Reduce the number of 
characters in the specified item 
and then retry the action.

10720018 [Item Name] is too long. Please enter 
a value that does not exceed 
[Number] characters.

Error Message Reduce the number of 
characters in the specified item 
and then retry the action.

10520047 [Item Name] is too long. Please enter 
a value that does not exceed 
[Number] characters.

Error Message Reduce the number of 
characters in the specified item 
and then retry the action.

10720017 [Item Name] is too short. Please enter 
at least [Number] characters for this 
value.

Error Message Increase the number of 
characters in the specified item 
and then retry the action.

11740002 [Number] Items Displayed Informational 
Message

Click OK to continue.

10220167 [Candidate Name] Last Name field is 
required. Please provide a value.

Error Message
Message

Enter the candidate’s last name 
and then retry the action.

11340009 [Item Name] log file not exported 
[Custom]

Informational 
Message

Click OK to continue.

11540001 [User Name] logged in. Informational 
Message

Click OK to continue.

11540002 [User Name] logged out. Informational 
Message

Click OK to continue.

10640002 [Media Type] Media created.

Please remove the device.

Informational 
Message

Click OK to continue. Remove 
the specified device before 
proceeding.

10040002 [Module Name] module activated. Informational 
Message

Click OK to continue.

10720127 [Item Name] must be between 
[Number] and [Number].

Error Message Enter the appropriate number 
of characters for the specified 
item, and then retry the action.

10120027 [Item Name] Name already exists. 
Please enter a unique value.

Error Message Enter a unique name for the 
specified item, and then retry 
the action.

10220181 [Item Name] Name already exists. Error Message Click OK to continue.

10230142 [Item Name] Name already exists. Do 
you want to continue with the same 
name?

Warning 
Message

Click Yes to proceed and keep 
the specified name.

10220141 [Item Name] Name is required. Please 
provide a value.

Error Message Enter a value for the specified 
item, and then retry the action.
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10720019 [Item Name] Name is required. Please 
provide a value.

Error Message Enter a value for the specified 
item, and then retry the action.

10220142 [Item Name] Name is too long. Please 
change the value so that it does not 
exceed [Number] characters.

Error Message Reduce the number of 
characters for the specified 
item, and then retry the action.

10720021 [Item Name] Name is too long. Please 
enter a value that does not exceed 
[Number] characters.

Error Message Enter a value that does not 
exceed the specified number of 
characters, and then retry the 
action.

10720020 [Item Name] Name is too short. 
Please enter at least [Number] 
characters for this value.

Error Message Enter a value of at least the 
specified number of characters, 
and then retry the action.

10840007 [Number] of [Number] election audio 
files imported from file [Filename].

Informational 
Message

Click OK to continue.

11041009 [Number] of [Number] system prompt 
audio files imported from file 
[Filename].

Informational 
Message

Click OK to continue.

11041008 [Number] of [Number] system prompt 
translations imported from file 
[Filename].

Informational 
Message

Click OK to continue.

10840025 [Item Name] Phonetic Phrase Informational 
Message

Click OK to continue.

10840024 [Item Name] Phrase Informational 
Message

Click OK to continue.

11540014 [Process Name] process cannot 
complete because of Data Validation 
errors.

Informational 
Message

Go to the Accessible Ballot 
module to review the Validation 
Errors report. Correct any noted 
errors and retry the action.

11540010 [Item Name] processed election data 
is valid and up to date.

Informational 
Message

Click OK to continue.

11540016 [Item Name] processed election data 
is valid and up to date.

Informational 
Message

Click OK to continue.

11041011 [Equipment Type] Screen Definitions 
successfully imported. Remember to 
thoroughly test the [Equipment Type] 
prior to your election in order to 
verify the screen changes.

Informational 
Message

Click OK to continue.

10830024 [Item Name] selection is required. 
Please provide a value.

Warning 
Message

Enter a value in the specified 
field and retry the action.

10220139 [Item Name] selection is required. 
Please provide a value.

Error Message Enter a value in the specified 
field and retry the action.

10830023 [Item Name] selection is required. 
Please select a [Item Name].

Warning 
Message

Select the appropriate item and 
then retry the action.

10740010 [Equipment Type] settings have been 
updated.

Informational 
Message

Click OK to continue.
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10720022 [Value] should be numeric. Error Message Enter a numeric value and then 
retry the action.

10220178 [Text Title] text title field is required. 
Please provide a value.

Error Message Enter a value in the text title 
field and then retry the action.

10220131 [Text Title] Title field is required. 
Please provide a value.

Error Message Enter a value in the text title 
field and then retry the action.

10230059 [Equipment Type] translations will be 
replaced in the database.

Do you want to update Electionware 
with the [Equipment Type] 
translations for ballots?

Warning 
Message

Click Yes to update the election 
database with the new ballot 
translations.

11031002 [Equipment Type] Translations will be 
replaced in the database.

Do you want to update Electionware 
with the [Equipment Type] 
Translations for system prompts?

Warning 
Message

Click Yes to update the election 
database with the new system 
prompt translations.

10220153 [Item Name] type is required. Please 
provide a value.

Error Message Enter the appropriate 
information in the specified 
field and then retry the action.

10440010 [User Name] viewed password 
information.

Informational 
Message

Click OK to continue.

11520020 [Item Name]: [Item Name] Error Message Contact ES&S Customer 
Support.

10220062 [Item Name]: [Item Name] already 
exists. Please enter a unique value.

Error Message Enter a unique value and then 
retry the action.

10230091 [Item Name]: [Item Name] is already 
assigned to [Item Name]: [Item Name] 
.

Do you want to continue?

Warning 
Message

Click Yes to continue with the 
action.

10041005 [Item Name]/[Item Name] Informational 
Message

Click OK to continue.

10220087 [Item Name]/[Item Name]: [Item 
Name] cannot be assigned to more 
than [Number] [Item Name].

Error Message Verify that the specified item is 
not assigned more than once, 
and then retry the action.

10020022 [Item Name] Field already exists. 
Please enter a unique value.

Error Message Enter a unique value in the 
specified field and then retry 
the action.

10740020 [Equipment Type] settings for the 
[Election Name] election have been 
updated.

Informational 
Message

Click OK to continue.

10240095 [Item name]:Found Fields [Item 
Name].

Informational 
Message

Click OK to continue.

Message ID Message Message Type Solution



 Chapter 23: System Messages 130

EVS5200_DOC_SOP_EW01ADMIN
 Software Version 4.6

 Published: April 24, 2014

10121015 A [Item Name] already exists. You can 
have only one [Item Name] in an 
election.

Error Message Verify that only one specified 
item exists in the election, and 
then retry the action.

10520063 A jurisdiction must be selected in the 
[Navigator Name] tree to restore.

Error Message Select a jurisdiction in the 
specified Navigator tree and 
then retry the action.

10421015 A new password is required. Please 
provide a value.

Error Message Enter a new password and then 
retry the action.

10830029 A problem exists with the excel file 
being imported.

A more detailed technical explanation 
can be viewed in the Output 
Exceptions Window.

Warning 
Message

Review the explanation within 
the Output Exceptions Window. 
If possible, correct the error and 
retry the action.

10220165 A problem exists with the excel file 
being imported.

A more detailed technical explanation 
can be viewed in the 
Window->Output->Exceptions 
window.

Error Message Review the explanation within 
the Output Exceptions Window. 
If possible, correct the error and 
retry the action.

11021029 A problem exists with the excel file 
causing a database error.

A more detailed technical explanation 
can be viewed in the Output 
Exceptions Window.

Error Message Review the explanation within 
the Output Exceptions Window. 
If possible, correct the error and 
retry the action.

11021031 A problem exists with the import of 
the excel file.

A more detailed technical explanation 
can be viewed in the Output 
Exceptions Window.

Error Message Review the explanation within 
the Output Exceptions Window. 
If possible, correct the error and 
retry the action.

10730019 Access codes updated successfully.

Please recreate the DS qualification 
media, reporting key media, and all of 
the election media.

Please repeat the ballot scanner 
preparation process if those steps 
have already been taken.

If you do not recreate your media and 
repeat the scanner preparation, you 
will not be able to open or run this 
election on your scanners.

Warning 
Message

Using the steps listed in the 
warning, recreate all of the DS 
media, and any ballot scanner 
readying processes completed 
prior to updating the access 
codes. 

10730013 Accessible Equipment Election Data 
has been reprocessed.

Please recreate the election media.

If you fail to recreate your media, any 
changes that have been made will not 
be passed to the Accessible 
Equipment.

Warning 
Message

Recreate all election media for 
the accessible equipment.
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11540009 Accessible Equipment process cannot 
complete because of Data Validation 
errors.

Informational 
Message

Go to the Accessible Ballot 
module to review the Validation 
Errors report. Correct any noted 
errors and retry the action.

11720012 Acquire error - [Error Code] Error Message Contact ES&S Customer 
Support.

10421023 Additional Text is too long. Please 
enter a value that does not exceed 
255 characters.

Error Message Reduce the number of 
characters entered in the 
Additional Text field and then 
retry the action.

11240001 Adjudicated Ballot ID [Ballot ID]. 
Status - [Item Name] - [Item Name]

Informational 
Message

Click OK to continue.

11240003 Adjudicating ballot [Ballot ID]. Informational 
Message

Click OK to continue.

10440008 Administrator activated user [User 
Name].

Informational 
Message

Click OK to continue.

10440007 Administrator inactivated user [User 
Name].

Informational 
Message

Click OK to continue.

10440006 Administrator viewed user 
information for [User Name].

Informational 
Message

Click OK to continue.

10720112 Affidavit type is required. Please 
provide a value.

Error Message Enter the affidavit type in the 
appropriate field and then retry 
the action.

11430005 All results data will be deleted from 
the database. Do you want to 
continue?

Warning 
Message

Click Yes to delete all results 
data in the database.

10720007 All text areas must be filled out with a 
numeral values.

Error Message Verify that all text areas are 
filled out with numerical values 
and the retry the action.

10840023 Alternate File Name Informational 
Message

Click OK to continue.

10840021 Alternate ID1 Informational 
Message

Contact ES&S Customer 
Support.

10520033 An [Item Name] cannot be restored as 
an [Item Type].

Error Message Verify that the entity is being 
restored appropriately and then 
retry the action. 

10431015 An election must be open to change 
its code strength.

Would you like to go to the Home 
module?

Warning 
Message

Click Yes to return to the Home 
module. Next, open an election, 
then change the election code 
strength from the Setup 
module.

10421024 An election must be open to run the 
Access Codes Report.

Error Message Open an election from the 
Home module, then retry 
running the report.
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10421025 An election must be opened to run 
the Election Audit Events Report.

Error Message Open an election from the 
Home module, then retry 
running the report.

10220155 An error occurred creating the script. Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11520011 An error occurred while activating 
user [User Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10420004 An error occurred while activating 
user [User Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10520012 An error occurred while assigning 
existing users to the election. [User 
Name]

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11320019 An error occurred while building 
property sheet list [Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10620002 An error occurred while burning the 
device.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11420004 An error occurred while clearing 
results.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11320006 An error occurred while closing 
callable statement [Statement Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11320005 An error occurred while closing row 
iterator [Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720097 An error occurred while concurrent 
task failed

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720076 An error occurred while converting 
[(.xml) Name].xml Document to a 
byte.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720072 An error occurred while converting 
PromptTranslations.xml to data store 
type

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720073 An error occurred while converting 
Translations.xml Document to a byte.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720039 An error occurred while creating 
[(.xml) File Name] XML file for [Item 
Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.
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10720090 An error occurred while creating 
[(.xml) File Name] Settings XML file 
for election [Election Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720084 An error occurred while creating 
[(.xml) File Name] Settings XML file 
for polling place [Poll Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10520016 An error occurred while creating 
backup. [Backup File Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720050 An error occurred while creating 
ballot XML file for ballot [Ballot ID].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10620025 An error occurred while creating 
ballot zip file for [Ballot ID].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10420014 An error occurred while creating 
county [County Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720043 An error occurred while creating 
election XML

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720045 An error occurred while creating 
election XML

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720057 An error occurred while creating 
election XML file

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10520006 An error occurred while creating 
election. [Election Name]

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10620029 An error occurred while creating 
Export Results Server Validation File.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720093 An error occurred while creating 
Jurisdiction XML file

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10420013 An error occurred while creating state 
[State Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720066 An error occurred while creating the 
directory: [Directory Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11520007 An error occurred while creating user Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.
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11520008 An error occurred while creating user 
[User Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10420001 An error occurred while creating user 
[User Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11520004 An error occurred while creating user 
key pair.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11520009 An error occurred while creating user 
keys for [User Name]

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10420003 An error occurred while deactivating 
user [User Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10420012 An error occurred while decrypting 
passwords in the Access Codes 
Report.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10520009 An error occurred while deleting 
election.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11021004 An error occurred while deleting 
generated [Election Name] election 
data after updating settings

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720004 An error occurred while deleting 
generated [Election Name] election 
data after updating settings.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720009 An error occurred while deleting 
generated [Election Name] election 
data after updating settings.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720082 An error occurred while deleting 
previously generated Settings XML

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720088 An error occurred while deleting 
previously generated Settings XML

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720037 An error occurred while deleting 
previously generated XML

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720049 An error occurred while deleting 
previously generated ballot style XML

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720056 An error occurred while deleting 
previously generated business XML

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.
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10720048 An error occurred while deleting 
previously generated election XML

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720092 An error occurred while deleting 
previously generated Jurisdiction 
XML

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220078 An error occurred while deleting VAT 
Import data for [Election Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11021010 An error occurred while displaying 
emblem for [Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220177 An error occurred while enabling or 
disabling the import/export ballot 
translations action.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220172 An error occurred while enabling or 
disabling the rotation exception 
action.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11720009 An error occurred while establishing a 
connection to the Acquire Server.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11720015 An error occurred while exporting 
ballot images: [File Name]

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10830011 An error occurred while exporting file 
[File Name].

Warning 
Message

Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220157 An error occurred while exporting file 
[File Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11021023 An error occurred while exporting the 
file [File Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11021025 An error occurred while exporting the 
file [File Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10020024 An error occurred while exporting the 
table to file: [File Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11720008 An error occurred while fetching filter 
results.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720040 An error occurred while formatting 
[(.xml) File Name] XML for [Item 
Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.
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10720085 An error occurred while formatting 
[(.xml) File Name] Settings XML for 
election [Election Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720078 An error occurred while formatting 
[(.xml) File Name] Settings XML for 
polling place profile [Poll Place 
Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720052 An error occurred while formatting 
ballot XML for ballot [Ballot ID]

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10620024 An error occurred while formatting 
BOD manifest xml.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720058 An error occurred while formatting 
business XML

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720046 An error occurred while formatting 
election XML

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720094 An error occurred while formatting 
Jurisdiction XML

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10620006 An error occurred while formatting. Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10520010 An error occurred while generate the 
keys.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720075 An error occurred while generating 
[Equipment Type] election data: 
[Election Name]

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720068 An error occurred while generating 
[Equipment Type] election data.

Please verify Paper Ballot changes 
have been updated to the database.

Error Message Verify that the database has 
been updated with Paper Ballot 
Changes. If the error persists, 
contact ES&S Customer 
Support.

11420008 An error occurred while generating 
[Report Name] report data.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720032 An error occurred while generating 
[(.xml) Election Name] XML for 
[Election Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220122 An error occurred while generating 
[Item Name]: [Item Name]

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.
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10220083 An error occurred while generating 
[Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10720081 An error occurred while generating 
[(.xml) File Name] Settings XML for 
[Election Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10320006 An error occurred while generating 
ballot styles.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10620020 An error occurred while generating 
BOD manifest xml.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11520006 An error occurred while generating 
report [Report Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10820022 An error occurred while getting 
[Number] Ballot ID for the [Equipment 
Type] Previewer

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11520005 An error occurred while hashing the 
code.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220089 An error occurred while importing 
election data: [Data Type]

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10830010 An error occurred while importing file 
[File Name].

Warning 
Message

Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220058 An error occurred while importing file 
[File Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11021015 An error occurred while Importing 
System Translations for [Equipment 
Type].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11021024 An error occurred while importing the 
file [File Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11021026 An error occurred while importing the 
file [File Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220008 An error occurred while importing the 
XML file.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220014 An error occurred while importing the 
XML file. Please check log for details. 

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.
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10220011 An error occurred while importing the 
XML file. Please check log for details. 

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11021012 An error occurred while importing. 
Verify your [Item Name] and file 
associations and try again.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220127 An error occurred while importing. 
Verify your [Item Name] and file 
associations and try again.

Also verify that the Entity Text IDs in 
the import file match the Entity Text 
IDs in the export file.

Error Message Verify that the Entity Text Id in 
the import file matches the 
Entity Text IDs in the export file. 
Then retry the action. If the 
error persists, contact ES&S 
Customer Support.

10820009 An error occurred while importing.

Please make sure directory and file 
name is valid and try again.

Error Message Verify the directory and 
filename and retry the action. If 
the error persists, contact ES&S 
Customer Support.

11520012 An error occurred while inactivating 
user [User Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11220001 An error occurred while initializing 
Acquire server

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11320024 An error occurred while initializing 
Acquire server - [Server Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10520027 An error occurred while initializing 
the help system.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220073 An error occurred while inserting 
[Item Name] Affiliation data for [Item 
Name] for [Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220082 An error occurred while inserting 
[Item Name] Cross Reference data for 
[Item Name], Alternate ID [Alternate 
ID Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220081 An error occurred while inserting 
[Item Name] Cross Reference data for 
[Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220074 An error occurred while inserting 
[Item Name] data for [Item Name] ID: 
[Item Name] Alternate ID: [Item 
Name] Alternate ID: [Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220070 An error occurred while inserting 
[Item Name] data for [Item Name], 
Alternate ID [Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.
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10220069 An error occurred while inserting 
[Item Name] data for [Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220075 An error occurred while inserting 
[Item Name] Controlling [Item Name] 
data for [Item Name] for [Item Name]: 
[Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220076 An error occurred while inserting 
[Item Name] Controlling [Item Name] 
data for [Item Name] for Controlling 
[Item Name]: [Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220065 An error occurred while inserting 
[Item Name] data for [Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220066 An error occurred while inserting 
[Item Name] data for [Item Name], 
Alternate ID [Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220003 An error occurred while inserting 
[Item Name] data for [Item Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220072 An error occurred while inserting 
Ballot [Ballot ID] data for [Item 
Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220077 An error occurred while inserting 
Ballot [Ballot ID] Controlling data for 
[Item Name] for [Item Name]: [Item 
Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11021020 An error occurred while inserting new 
[Equipment Type] screen definitions

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220080 An error occurred while inserting VAT 
election ballot spec data for [Ballot 
ID]

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10220068 An error occurred while inserting 
WriteIn data for [Ballot ID].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10820010 An error occurred while launching 
[Equipment Type] Previewer. Please 
reinstall [Equipment Type] Preview.

Error Message Reinstall the equipment type 
previewer in the error message. 
If after the reinstall the error 
persists, contact ES&S 
Customer Support.

11320025 An error occurred while loading [Item 
Name] counters for batch - [Batch 
Name]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11220005 An error occurred while loading ballot Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.
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11320014 An error occurred while loading Ballot 
Sheet ID [Ballot ID]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11220006 An error occurred while loading batch Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11320015 An error occurred while loading 
Contest ID [Contest Name]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11320023 An error occurred while loading 
election qualification code - 
[Qualification Code]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11720002 An error occurred while loading 
export XML data

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11420002 An error occurred while loading 
media data - [Media ID] 

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11320031 An error occurred while loading Poll 
Media

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11320032 An error occurred while loading Poll 
Media for batch [Batch Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11320021 An error occurred while loading 
private key [Item Name]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11320012 An error occurred while loading 
public key

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11720006 An error occurred while loading 
report - [Report Name]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11420007 An error occurred while loading 
report - [Report Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11220004 An error occurred while loading 
report [Report Name] report

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10520036 An error occurred while locking the 
election in order to renumber [Item 
Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10220013 An error occurred while parsing the 
election day timestamp.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.
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10220012 An error occurred while parsing the 
election import document.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11420003 An error occurred while posting batch 
- [Batch Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10820021 An error occurred while preparing 
ballot data for [Equipment Type] 
Previewer.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11720007 An error occurred while printer 
initializing

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11720005 An error occurred while printing [Item 
Name]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11720004 An error occurred while printing 
ballot(s): [Ballot IDs]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11420001 An error occurred while processing 
archive file [File Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10220009 An error occurred while processing 
ballot data.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10220006 An error occurred while processing 
Election Options data.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10220015 An error occurred while processing 
graphic data.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10020009 An error occurred while reading the 
help file [File Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720042 An error occurred while reading 
version information from the 
database

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11021011 An error occurred while reading/
writing emblem graphic.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10620028 An error occurred while resetting 
election media status.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10520032 An error occurred while restoring 
election.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.
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10720063 An error occurred while retrieving 
[Party Name] affiliation for [Item 
Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720034 An error occurred while retrieving 
[Item Name] details for [Item Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720060 An error occurred while retrieving 
[Item Name] data for business XML 
creation

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10220001 An error occurred while retrieving 
[Item Name] data for iso code [Code].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720035 An error occurred while retrieving 
[Item Name] for [Item Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10620021 An error occurred while retrieving 
[Item Name] for BOD manifest xml.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720033 An error occurred while retrieving 
[Item Name] options for [Item Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720038 An error occurred while retrieving 
[File Name] XML file for [Item Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720087 An error occurred while retrieving 
[Item Name] options for election 
[Election Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720080 An error occurred while retrieving 
[Item Name] options for polling place 
profile [Poll ID].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720089 An error occurred while retrieving 
[File Name] Settings XML for election 
[Election Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720083 An error occurred while retrieving 
[Item Name] Settings XML for polling 
place [Poll ID].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11120001 An error occurred while retrieving 
ballot image data

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720065 An error occurred while retrieving 
ballot style data for business XML 
creation

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10620023 An error occurred while retrieving 
ballot styles for BOD manifest xml.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.
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10220085 An error occurred while retrieving 
ballot styles.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720051 An error occurred while retrieving 
ballot XML for ballot [Ballot ID].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11320004 An error occurred while retrieving 
column [Column ID]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720096 An error occurred while retrieving 
controlling reference data

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720054 An error occurred while retrieving 
data for ballot XML creation

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720055 An error occurred while retrieving 
data for business XML creation

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720091 An error occurred while retrieving 
data for Jurisdiction XML creation

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720044 An error occurred while retrieving 
election XML

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720064 An error occurred while retrieving 
logical ballot style data for business 
XML creation

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720077 An error occurred while retrieving 
polling place data for Business XML 
creation

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10820015 An error occurred while retrieving the 
[Item Name] summary.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10820014 An error occurred while retrieving the 
default summary.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10820016 An error occurred while retrieving the 
font colors.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10820012 An error occurred while retrieving the 
label’s attributes.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10420005 An error occurred while retrieving 
user [User Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.
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11220007 An error occurred while saving ballot Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11220010 An error occurred while saving ballot 
image [Ballot Image Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11720014 An error occurred while saving ballot 
images: [Ballot Images Names]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11220008 An error occurred while saving batch Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11720003 An error occurred while saving export 
HTML/XML data

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720067 An error occurred while saving 
process status entry

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10520017 An error occurred while saving the 
election template.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10520018 An error occurred while saving the 
election template. Please check log 
for details. [Log Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10520008 An error occurred while saving the 
election. [Election Name]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10220186 An error occurred while setting image 
for [Item Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11320013 An error occurred while setting status 
for Contest ID [Contest Name] Ballot 
Sheet ID [Ballot ID].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11720016 An error occurred while setting up 
filter panel - [Item Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720069 An error occurred while storing 
[Equipment Type] CF file contents: 
[Election Data] for Election ID: 
[Election Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720074 An error occurred while storing 
[Equipment Type] Process Status for 
Election ID: [Election Name]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720041 An error occurred while storing [File 
Name] XML for [Election Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.
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10720086 An error occurred while storing [Item 
Name] Settings XML for election 
[Election Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720079 An error occurred while storing [Item 
Name] Settings XML for polling place 
profile [Poll ID].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720098 An error occurred while storing [Item 
Name] file contents: [File Name] for 
Election ID: [Election Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720053 An error occurred while storing ballot 
XML for ballot [Ballot ID].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10220088 An error occurred while storing BSG 
Status for [Election Name]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720059 An error occurred while storing 
business XML

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720047 An error occurred while storing 
election XML

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720095 An error occurred while storing 
Jurisdiction XML

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11220009 An error occurred while tallying ballot Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11720001 An error occurred while transforming 
export XML data

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10220071 An error occurred while updating 
[Item Name] ID.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10220005 An error occurred while updating 
[Item Name] data for [Item Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720001 An error occurred while updating 
[Equipment Type] settings. 

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720006 An error occurred while updating 
[Equipment Type] settings. 

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10720008 An error occurred while updating 
[Equipment Type] settings. 

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.
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10220042 An error occurred while updating 
[Item Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10820004 An error occurred while updating 
Audio [Audio ID].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11021016 An error occurred while updating 
audio [Audio ID].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11021009 An error occurred while updating 
emblem for [Item Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11720011 An error occurred while updating 
print status for Ballot ID - [Ballot ID]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11720010 An error occurred while updating 
provisional disposition status for 
Ballot ID - [Balllot ID]

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10421010 An error occurred while updating the 
county.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11520001 An error occurred while updating the 
data validation status.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10520014 An error occurred while updating the 
display name.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10820011 An error occurred while updating the 
label’s attributes.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10420019 An error occurred while updating the 
Security Policy.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10421009 An error occurred while updating the 
state.

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10820013 An error occurred while updating the 
summary for [Item Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11520010 An error occurred while updating user 
[User Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10420002 An error occurred while updating user 
[User Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

Message ID Message Message Type Solution



 Chapter 23: System Messages 147

EVS5200_DOC_SOP_EW01ADMIN
 Software Version 4.6

 Published: April 24, 2014

10220079 An error occurred while updating VAT 
Configuration Defaults data for 
[Election Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10520023 An error occurred while validating 
[Item Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

11320028 An error occurred while validating file 
- [File Name].

Error Message Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10010016 An unexpected error occurred. If the 
problem persists, please restart the 
application.

Critical Error 
Message

Restart Electionware as 
instructed. If the error persists, 
contact ES&S Customer 
Support.

10830028 An unexpected Java error occurred.

A more detailed technical explanation 
can be viewed in the Output 
Exceptions Window.

Warning 
Message

Review the log file for more 
information. If possible, correct 
the issue and retry the action. If 
the error persists, contact ES&S 
Customer Support.

11021030 An unexpected Java error occurred.

A more detailed technical explanation 
can be viewed in the Output 
Exceptions Window.

Error Message Review the Output Exceptions 
Window for more information. If 
possible, correct the issue and 
retry the action. If the error 
persists, contact ES&S 
Customer Support.

10220164 An unexpected Java error occurred.

A more detailed technical explanation 
can be viewed in the 
Window->Output->Exceptions 
window.

Error Message Review the Output Exceptions 
Window for more information. If 
possible, correct the issue and 
retry the action. If the error 
persists, contact ES&S 
Customer Support.

10020033 Another user or process has deleted 
an association specified by this 
record. Refresh to get the latest 
record from the database.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, retry 
the action.

10020030 Another user or process has deleted 
the [Item Name], you can no longer 
use this [Item Name].

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. Review the 
updated content to see the 
associated deletion.

10121011 Another user or process has deleted 
the [Item Name]. You can no longer 
use this [Item Name].

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. Review the 
updated content to see the 
associated deletion.
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10020034 Another user or process has deleted 
the associated [Item Name] specified 
by this [Item Name].

This [Item Name] is no longer valid.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. Review the 
updated content to see the 
associated deletion.

10020028 Another user or process has deleted 
this record. You can no longer use this 
record.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. Review the 
updated content to see the 
associated deletion.

10720003 Another user or process has modified 
the [Equipment Type] settings.

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen and then make your 
changes.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, retry 
the action.

10720005 Another user or process has modified 
the [Equipment Type] settings.

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen and then make your 
changes.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, retry 
the action.

10720011 Another user or process has modified 
the [Equipment Type] settings.

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen and then make your 
changes.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, retry 
the action.

10020029 Another user or process has modified 
the [Item Name].

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen and then make your 
changes.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, retry 
the action.

10121010 Another user or process has modified 
the [Item Name].

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen and then make your 
changes.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, retry 
the action.

10431014 Another user or process has modified 
the code strength.

You must refresh the screen and 
re-enter your changes to update.

Would you like to refresh this screen?

Warning 
Message

Click Yes to Refresh the screen. 
After refreshing the 
information, retry adjusting the 
code strength.
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10730001 Another user or process has modified 
the Codes.

You must refresh the screen and 
re-enter your changes to update.

Would you like to refresh this screen?

Warning 
Message

Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, 
reenter your changes.

10420016 Another user or process has modified 
the county. 

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen and then make your 
changes.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, 
reenter your changes.

10520015 Another user or process has modified 
the display name.

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen, and then make your 
changes.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, 
reenter your changes.

10820019 Another user or process has modified 
the display settings.

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen and then make your 
changes.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, 
reenter your changes.

11021007 Another user or process has modified 
the emblem.

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen and then make your 
changes.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, 
reenter your changes.

10420015 Another user or process has modified 
the state. 

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen and then make your 
changes.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, 
reenter your changes.

11520014 Another user or process has modified 
the user record. 

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen and then make your 
changes.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, 
reenter your changes.

10020027 Another user or process has modified 
this record.

Please click the ‘Refresh’ button at 
the bottom of the screen to update 
the screen and then make your 
changes.

Error Message Refresh the information by 
using the button at the bottom 
center of the screen. After 
refreshing the information, 
reenter your changes.
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10130001 Any [Item Name] linked to this group 
will be unlinked.

Are you sure you want to continue?

Warning 
Message

Click Yes to complete the 
action.

10240012 Applying Paper Ballot style sheet 
updates to Accessible Ballot labels

Informational 
Message

No action required.

10030006 Are you sure you want to delete [Item 
Name]?

Warning 
Message

Click Yes to complete the 
action.

10030007 Are you sure you want to delete the 
[Item Name] selected [Item Name]?

Warning 
Message

Click Yes to complete the 
action.

10240086 Assign [Item Name] to [Item Name]. Informational 
Message

Click Yes to complete the 
action.

10030005 At least one item must be selected. Warning 
Message

Click OK to continue. Select an 
associated item and retry the 
action.

10220146 At least one [Item Name] should be 
selected to exclude.

Error Message Click OK to continue. Select an 
associated item and retry the 
action. If the error persists, 
contact ES&S Customer 
Support.

10830018 At least one navigator item must be 
selected.

Warning 
Message

Click OK to continue. Select an 
associated item and retry the 
action.

10421028 At least one navigator item must be 
selected.

Error Message Click OK to continue. Select an 
associated item and retry the 
action.

11140001 Attempting to print [Item Name]. Informational 
Message

No action required.

11140002 Attempting to print all ballot styles. Informational 
Message

No action required.

10220140 Audio [Audio ID] name is required. 
Please provide a value.

Error Message Enter a value for the audio item 
and then retry the action.

10010010 Auto Commit Status get error: [Error 
Name].

Critical Error 
Message

Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10010011 Auto Commit Status set error: [Error 
Name].

Critical Error 
Message

Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10540027 Backing up election database on 
[Computer/Drive Name].

Informational 
Message

No action required.

10540043 Backup Election has been canceled. Informational 
Message

No action required.

10540028 Backup initiated for election: [Election 
Name]

Informational 
Message

No action required.
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11320035 Ballot [Ballot ID] does not have 
scanned images, displaying 
generated ballot artwork instead.

Error Message Verify that associated images 
are present. If the error 
continues, contact ES&S 
Customer Support.

10620015 Ballot File code contains spaces. 
Please remove spaces.

Error Message Remove the any spaces from 
the Ballot File code, and then 
retry the action.

10620012 Ballot File code is required. Please 
provide a value.

Error Message Enter the Ballot File code, and 
then retry the action.

10620016 Ballot File code is too long. Please 
change the value so that it does not 
exceed [Number] characters.

Error Message Reduce the length of the Ballot 
File code, and then retry the 
action.

10620014 Ballot File code is too short. Please 
enter at least [Number] characters for 
this value.

Error Message Increase the length of the Ballot 
File code, and then retry the 
action.

10620017 Ballot File code must contain at least 
one character from 3 of the following 
4 classes:

Error Message Review the classes highlighted 
in the error message. Verify that 
the Ballot File Code contains at 
least one character from three 
of the four classes, and then 
retry the action.

10620018 Ballot File code must contain at least 
one letter and one number.

Error Message Verify that the Ballot File Code 
contains at least one letter and 
one number, and then retry the 
action.

10620019 Ballot File code must contain at least 
one number or letter.

Error Message Verify that the Ballot File Code 
contains at least one letter or 
one number, and then retry the 
action.

10620011 Ballot File path is required. Please 
provide a value.

Error Message Enter a Ballot File path and then 
retry the action.

10840015 Ballot Previewer window must be 
closed to use Electionware.

Informational 
Message

Close the Ballot Previewer to 
continue.

10720140 Ballot Styles need to be generated 
and Paper Ballot needs to be finalized 
after Ballot Styles are generated.

Error Message Make sure that ballot styles 
have been generated in 
Capture, and that ballot layout 
has been finalized in Paper 
Ballot, and then retry the 
action.

10220159 Ballot Translations could not be 
uploaded because there are identical 
terms being translated in different 
ways.

Those duplicate terms are located in 
the Output Events Window. This 
Window can be accessed by the top 
menu: Windows->Output->Events.

Error Message Edit the translations to ensure 
that duplicate terms are being 
translated using duplicate 
verbiage. Once the changes 
have been made, retry the 
action.
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11340007 Batch ID [Batch ID] posted. Number 
of Ballots - [Number] , adjudicated - 
[Number], spoiled - [Number], require 
adjudication - [Number]

Informational 
Message

Review the information and 
then click OK to continue.

10040003 Cancel requested. Informational 
Message

No action required.

11240002 Canceled changes for batch [Batch 
ID].

Informational 
Message

No action required.

10421008 Cannot deactivate or downgrade user 
[User Name] because they are the 
only administrator in the system.

Error Message Verify that at least one other 
administrator is set within the 
system, and then retry the 
action.

10240026 Cannot delete the Non Partisan [Item 
Name].

Informational 
Message

Verify that any associated links 
have been removed, and that 
the selected item is not 
defaulted. If the error persists, 
contact ES&S Customer 
Support.

10240021 Cannot delete the Primary [Item 
Name].

Informational 
Message

Verify that any associated links 
have been removed, and that 
the selected item is not 
defaulted. If the error persists, 
contact ES&S Customer 
Support.

10720100 Cannot generate [Equipment Type] 
election data. There are no [Item 
Name].

Error Message Verify that the associated item 
exists within the election. If the 
error persists, contact ES&S 
Customer Support.

10720101 Cannot generate [Equipment Type] 
election data. There are no [Item 
Name].

Error Message Verify that the associated item 
exists within the election. If the 
error persists, contact ES&S 
Customer Support.

11520016 Cannot modify username, access 
level, or status of admin.

Error Message Change the associated 
individual to a User in order to 
modify them. 

10240077 Changes will be applied to all [Item 
Name] for [Item Name].

Informational 
Message

No action required.

10520035 Changing to system generated will 
cause all your [Item Name] to be 
renumbered. 

Do you want to continue?

Error Message Click Yes to complete the 
action.

10650005 Cleaning up Verbose 
Message

No action Required.

11240005 Cleared votes for [Item Name]. Informational 
Message

No action required.
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10520064 Close the current election and select 
a jurisdiction from the election tree 
before restoring.

Error Message Select a jurisdiction from the 
navigator in order to restore an 
election.

10140020 CodeBank Initialization Error. 
CodeBank enumerations have not 
been initialized.

Informational 
Message

Retry the action and if the error 
persists, contact ES&S 
Customer Support.

10140018 CodeBank Initialization Error. 
Enumeration not found for the 
following code bank IDs: [Code Bank 
IDs]

Informational 
Message

Review the information 
provided and attempt to 
correct the issue if possible. If 
the error persists, contact ES&S 
Customer Support.

10140017 CodeBank Initialization Error. 
Enumeration not found for the 
following code type IDs: [Code Type 
IDs]

Informational 
Message

Review the information 
provided and attempt to 
correct the issue if possible. If 
the error persists, contact ES&S 
Customer Support.

10140019 CodeBank Initialization Error. Invalid 
enumeration for Class: [Class Name], 
Type: [Type Name].

Informational 
Message

Review the information 
provided and attempt to 
correct the issue if possible. If 
the error persists, contact ES&S 
Customer Support.

10730017 Codes have changed.

Please recreate the accessible 
equipment election media.

If you fail to recreate your media, 
equipment settings will not be passed 
to the [Item Name].

Warning 
Message

Review the information 
provided and attempt to 
correct the issue if possible. If 
the error persists, contact ES&S 
Customer Support.

10020025 Column definition not found for class: 
[Class Name], row: [Row Number].

Error Message Contact ES&S Customer 
Support.

10010012 Commit transaction error: [Error 
Code].

Critical Error 
Message

Contact ES&S Customer 
Support.

10240101 Committed successfully. Informational 
Message

No action required.

10740035 Committing [Number] updates to the 
database

Informational 
Message

No action required.

10740038 Committing Accessible Equipment 
updates to the database

Informational 
Message

No action required.

11340003 Committing new Batch [Batch Name] 
ID [Batch ID] Number of Ballots 
[Number]

Informational 
Message

No action required.

10240013 Committing updates to the database Informational 
Message

No action required.

10620013 Confirmation code does not match. 
Please provide a matching value.

Error Message Re-enter the code and then 
retry the action.

10520053 Confirmation code does not match. 
Please provide matching values.

Error Message Re-enter the code and then 
retry the action.
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11320026 CoNG Error: [Error Code] Error Message Contact ES&S Customer 
Support.

11320033 CoNG Error: An error occurred while 
initializing tally engine with static 
election definition {0}.

Error Message Contact ES&S Customer 
Support.

10050001 Connecting... Verbose 
Message

No action required.

10010015 Connection close failure: [Error Code]. Critical Error 
Message

Contact ES&S Customer 
Support.

10830030 Could not completely read file [File 
Name].

Warning 
Message

Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10021005 Could not delete because the [Item 
Name] has active [Item Name].

Error Message Verify the associations and then 
eliminate them if possible. 
ONce the associations are 
broken, retry the deletion.

10420018 Could not delete because the county 
has active elections.

Error Message Delete all of the active 
elections, and then delete the 
county. (Note: It is advised that 
all elections are backed up prior 
to deletion.)

10420017 Could not delete because the state 
has active counties.

Error Message Delete all of the active 
elections, and then delete the 
associated counties. Once all of 
the counties have been deleted, 
retry the deletion of the state. 
(Note: It is advised that all 
elections are backed up prior to 
deletion.)

10421027 County Name is required. Please 
provide a value that does not exceed 
255 characters.

Error Message Reduce the length of the county 
name, and then retry the action.

10441020 County: [County Name] deleted. Informational 
Message

Click OK to continue.

10441023 Created county with ID [County ID]. 
Name: [County Name].

Informational 
Message

No action required.

10250028 Created Default [Item Name] Verbose 
Message

No action required.

10441021 Created state with ID [State ID]. 
Name: [State Name].

Informational 
Message

No action required.

10440002 Created user with ID [User ID]. 
Username: [User Name], Name: 
[Name].

Informational 
Message

No action required.

10840018 Created: [Item Name] Informational 
Message

No action required.
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10540047 Creating [Template Name] template 
database completed.

Informational 
Message

No action required.

10240104 Creating [Item Name]. Informational 
Message

No action required.

10240014 Creating database Informational 
Message

No action required.

10540040 Creating database Informational 
Message

No action required.

10540033 Creating election template Informational 
Message

No action required.

10650001 Creating temp directory Verbose 
Message

No action required.

10540034 Creating template database Informational 
Message

No action required.

10640018 Creating the ballot style files. Informational 
Message

No action required.

10010008 Creating the Database instance 
connection to the database failed: 
[Error Code].

Critical Error 
Message

Contact ES&S Customer 
Support.

10240081 Cross Endorsement Number is invalid. 
Please enter a smaller value.

Informational 
Message

Reduce the number of 
characters in the Cross 
Endorsement Number, and then 
retry the action.

11540006 Data Validation completed 
successfully.

Informational 
Message

No action required.

11540008 Data Validation has found errors. Informational 
Message

Review the errors associated 
with the Data Validation. If 
possible, correct the indicated 
errors and then rerun the Data 
Validation process.

10020018 Datatype mismatch. Error Message Contact ES&S Customer 
Support.

10840022 Default File Name Informational 
Message

No action required.

10441028 Deleted [Number] Counties. Informational 
Message

No action required.

10441027 Deleted [Number] States. Informational 
Message

No action required.

10041002 Deleted [Item Name] Informational 
Message

No action required.

10230123 Deleting [Item Name] will also delete 
[Item Name]. Do you want to 
continue?

Warning 
Message

Click Yes to complete the 
action.
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11340002 Deleting Batch [Batch Name] ID 
[Batch ID] Number of Ballots 
[Number]

Informational 
Message

No action required.

10550001 Deleting Election... Verbose 
Message

No action required.

10530002 Deleting the [Item Name] will also 
delete all the audit logs related to 
this [Item Name].

Warning 
Message

Click Yes to complete the 
action.

10650011 Device [Number] of [Number]. Verbose 
Message

No action required.

10620033 Device is not ready. Please make sure 
the flash device is properly inserted.

Error Message No action required.

10620030 Device no longer available: [Device 
Name].

Make sure a device is inserted and 
press the ‘Refresh’ button.

Error Message No action required.

10630004 Digital Scan Codes have not been 
entered.

Do you want to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module and enter 
the codes. Once the codes have 
been entered, retry the action.

10730008 Digital Scan Codes have not been 
entered.

Would you like to open the Digital 
Scan security screen?

Warning 
Message

Click Yes to go to the Configure 
Equipment module and enter 
the codes. Once the codes have 
been entered, retry the action.

10430027 Do you want to activate [Item Name]? Warning 
Message

Click Yes to complete the 
action.

11430003 Do you want to clear results for 
[Election Name]? This operation 
cannot be undone, Media results will 
be lost.

Warning 
Message

Click Yes to complete the 
action.

10431025 Do you want to delete [Number] 
Counties?

Warning 
Message

Click Yes to complete the 
action.

10431024 Do you want to delete [Number] 
States?

Warning 
Message

Click Yes to complete the 
action.

10230027 Do you want to delete [Item Name]? Warning 
Message

Click Yes to complete the 
action.

10431023 Do you want to delete County: 
[County Name]?

Warning 
Message

Click Yes to complete the 
action.

10431022 Do you want to delete State: [State 
Name]?

Warning 
Message

Click Yes to complete the 
action.

10230028 Do you want to delete the selected 
items?

Warning 
Message

Click Yes to complete the 
action.

10230109 Do you want to delete the selected 
rotation exceptions?

Warning 
Message

Click Yes to complete the 
action.
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10730039 Do you want to delete the selected 
signatures?

Warning 
Message

Click Yes to complete the 
action.

10430026 Do you want to inactivate [User 
Name]?

Warning 
Message

Click Yes to complete the 
action.

10430001 Do you want to reload the user 
information and overwrite pending 
changes?

Warning 
Message

Click Yes to complete the 
action.

11430004 Do you want to reset results for these 
[Media Type] media? This operation 
cannot be undone, Media results will 
be lost.

Warning 
Message

Click Yes to complete the 
action.

10050003 Done. Verbose 
Message

No action required.

10730015 DS Election information has been 
reprocessed.

Please recreate the DS election media 
and reporting key media.

If you fail to recreate your media, any 
changes that have been made will not 
be passed to the tabulators or 
reporting software.

Warning 
Message

As the DS Election Media has 
changed, any burned media is 
now invalid. In order to ensure 
election validity, all media must 
be recreated.

Failure to recreate election 
media will lead to errors in the 
tabulation process.

10020007 Duplicate Tree ID. Error Message Contact ES&S Customer 
Support.

10520044 Election [Item Name] is required. 
Please provide a value.

Error Message Enter the appropriate value and 
then retry the action.

10540026 Election backup file created:

[File Name]

Informational 
Message

No action required.

10520060 Election backup path is required. 
Please provide a value.

Error Message Enter the election backup file 
path, and then retry the action.

11540003 Election Closed: [Item Name] Informational 
Message

No action required.

10540002 Election Closed: [Item Name] Informational 
Message

No action required.

10441016 Election code strength set to [Code 
Strength] for election: [Election 
Name].

Informational 
Message

No action required.

10520048 Election county name is required. 
Please provide a value.

Error Message Enter a value for the county 
name, and then retry the action.

10220123 Election Day [Item Name] already 
exist.

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10520021 Election display name already exists. 
Please enter a unique value.

Error Message Enter a unique value for the 
election display name, and then 
retry the action.
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10520002 Election Display Name is required. 
Please provide a value.

Error Message Enter a value for the election 
display name, and then retry the 
action.

10520004 Election Display Name is too long. 
Please enter a value that does not 
exceed [Number] characters.

Error Message Reduce the number of 
characters in the election 
display name, and then retry the 
action.

10520003 Election Display Name is too short. 
Please enter at least [Number] 
characters for this value.

Error Message Increase the number of 
characters in the election 
display name, and then retry the 
action.

10520040 Election Folder Name is invalid. 
Please provide a valid value.

Error Message Enter an appropriate value for 
the election folder name, and 
then retry the action.

10520039 Election Folder Name is required. 
Please provide a value.

Error Message Enter a value for the election 
folder name, and then retry the 
action.

11420006 Election ID does not match current 
Election - [Election Name].

Error Message Verify the election ID, and then 
retry the action. If the error 
persists, contact ES&S 
Customer Support.

10240002 Election import completed Informational 
Message

No action required.

10720136 Election information is incomplete. 
Please import election data before 
continuing.

Error Message Import a complete set of 
election data, and then retry the 
action.

10420011 Election is currently open by [User 
Name]. Unable to save change to 
code strength.

Error Message Verify that the specified user is 
logged out of Electionware, and 
then retry the action.

11320017 Election is not closed or missing Poll 
Place collection file.

Error Message Verify that the election is not 
closed. If the error persists, 
contact ES&S Customer 
Support.

10540012 Election keys created. Informational 
Message

No action required.

10520045 Election Name is required. Please 
provide a value.

Error Message Enter an election name, and 
then retry the action.

10540001 Election Opened: [Election Name] Informational 
Message

No action Required.

10520067 Election Type is required. Please 
provide a value.

Error Message Select an election type from the 
available menu, and then retry 
the action.

10140025 Election Updated: ID: [Election 
Name]New [Number] Old [Number].

Informational 
Message

No action Required.

10040006 Electionware login attempt. User: 
[User Name]

Informational 
Message

No action Required.
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10940003 Electionware Paper Ballot closed. Informational 
Message

No action Required.

10940002 Electionware Paper Ballot launched. Informational 
Message

No action Required.

11041005 Emblem updated for [Item Name]. Informational 
Message

No action Required.

10240020 Equipment selections successfully 
saved.

Informational 
Message

No action Required.

10730021 Equipment settings have changed.

Please re-generate the Accessible 
Equipment election data.

If you fail to re-generate the 
Accessible Equipment election data, 
equipment settings will not be passed 
to the [Equipment Type].

Warning 
Message

Regenerate the associated data, 
and then retry the action. 

If data is not regenerated as 
specified, errors with the 
tabulation process will occur.

10730023 Equipment settings have changed.

Please re-generate the DS election 
data.

If you fail to re-generate the DS 
election data, equipment settings will 
not be passed to the tabulators or 
reporting software.

Warning 
Message

Regenerate the associated data, 
and then retry the action. 

If data is not regenerated as 
specified, errors with the 
tabulation process will occur.

11320041 Error decrypting file [File Name] Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

11320029 Error Election ID mismatch Error Message Contact ES&S Customer 
Support.

11320039 Error incorrect ballot count found 
[Number] expected [Number].

Error Message Verify the ballot count 
mismatch, and then contact 
ES&S Customer Support.

11320038 Error loading CVR [File Name]. Error Message Contact ES&S Customer 
Support.

11320040 Error missing file [File Name]. Error Message Contact ES&S Customer 
Support.

11320037 Error missing log file Error Message Contact ES&S Customer 
Support.

11320030 Error missing readme file Error Message Contact ES&S Customer 
Support.

11320042 Error parsing ballot XML for ballot id - 
[Ballot ID]

Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10020006 Error reading file: [File Name]. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.
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10220179 Error Retrieve [Item Name] Count Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10520065 Error retrieving election support data. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10020017 Error retrieving list of devices. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10120081 Error updating Security Policy Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10120088 Error updating System Object Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10120089 Error updating Vat Cf Lang Files 
Object

Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10320003 Error: [Item Name] [Choice Selection]. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10320005 Error: [Item Name] [Choice Selection]. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10320009 Error: [Item Name] [Choice Selection]. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10220113 Error: [Contest Name] has more 
write-ins than allowed vote for 
number.

Error Message Verify that the number of 
write-in selections is equal to, or 
less than the number of allowed 
vote for responses. When 
corrected, retry the action.

10220114 Error: [Item Name] specified for [Item 
Name] is not linked to any [Item 
Name].

Error Message Contact ES&S Customer 
Support.

10320019 Error: [Item Name] does not have any 
[Item Name] linked to it. You must link 
at least one [Item Name] to the [Item 
Name] before you can generate [Item 
Name].

Error Message Verify that the associated items 
are linked as specified, and then 
retry the action. If the error 
persists, contact ES&S 
Customer Support.

10320002 Error: [Item Name] [Choice Selection]. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10320010 Error: [Item Name] ID must be 
numeric for [Item Name].

Error Message Verify that the specified value is 
numeric, and then retry the 
action.
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10320001 Error: [Item Name] IDs are not in 
ascending order. You must put [Item 
Name] IDs in ascending order before 
you can generate ballot styles.

Error Message Verify that the associated items 
are ascending order, and then 
retry the action.

10320023 Error: [Item Name] does not have any 
associated [Item Name]. You must 
have at least one [Item Name] 
associated with the [Item Name].

Error Message Verify that the associated items 
are linked as specified, and then 
retry the action. If the error 
persists, contact ES&S 
Customer Support.

10320020 Error: [Item Name] in [Item Name] 
cannot have more [Item Name] than 
the allowed vote for number: [Vote 
For Number]. [Item Name] is linked to 
[Item Name] and this will result in an 
automatic over vote.

Error Message Verify that the number of items 
is equal to, or less than the 
number of allowed vote for 
responses. When corrected, 
retry the action.

10320022 Error: [Item Name] is not in correct 
order. [Item Name] should be placed 
above its controlled [Item Name].

Error Message Verify that the associated items 
are in the proper order, and 
then retry the action.

10220124 Error: [Item Name] does not link to a 
valid [Item Name].

Error Message Verify that the associated items 
are properly linked, and then 
retry the action.

10220115 Error: [Item Name] is not a valid 
Integer.

Error Message Enter a new value and then 
retry the action.

10220107 Error: [Item Name]: Incorrect number 
of columns.

Error Message Verify the number of columns is 
correct, and then retry the 
action. If the error persists, 
contact ES&S Customer 
Support.

10220108 Error: [Item Name]: Field [Field Name] 
cannot contain the value(s) [Value].

Error Message Verify and/or correct the values 
currently entered in the 
associated fields, and then retry 
the action. If the error persists, 
contact ES&S Customer 
Support.

10220099 Error: [Language Name] can only have 
one audio language.

Error Message Verify that the associated 
language only has one audio 
language and then retry the 
action. If the error persists, 
contact ES&S Customer 
Support.

10220091 Error: [Item Name]: The selected 
delimiter was not found in file: 
[Delimiter Character], no columns 
names can be found.

Error Message Verify that either the correct 
delimiter character has been 
selected, or that the associated 
character is located in the input 
file. Once corrected, retry the 
action.

10220096 Error: [Item Name]: Missing required 
field [Field Name] for Import ID: [Item 
Name].

Error Message Verify that the associated items 
are in the required fields, and 
then retry the action.
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10220092 Error: [Item Name]: Missing required 
fields in the header: [Header Name].

Error Message Verify that the necessary values 
are in their associated fields, 
and then retry the action.

10220093 Error: [Item Name]: Missing data for 
[Item Name].

Error Message Verify that the necessary 
information is present, and then 
retry the action.

10220130 Error: [Item Name]: The selected 
delimiter was not found in file [File 
Name], file will not be processed.

Error Message Verify that the selected 
delimiter is in the import file, 
and then retry the action.

10220102 Error: [Item Name]: Invalid value [Item 
Name] for field [Field Name].

Error Message Verify that the associated values 
are correct, and then retry the 
action.

10220097 Error: [Item Name]: [Item Name] 
should be a maximum of [Number] 
characters for [Item Name].

Error Message Verify that the number of 
characters for the associated 
item is correct, and then retry 
the action.

10220120 Error: [Item Name] already defined as 
type [Type] cannot change to type 
[Type].

Error Message Verify the type association for 
the item, and then retry the 
action.

10220105 Error: [Item Name]: Invalid [Item 
Name] specified for [Item Name].

Error Message Verify the association for the 
item, and then retry the action.

10220110 Error: [Item Name]: Value for field 
[Field Name] for [Item Name] should 
be within the range of [Number] to 
[Number].

Error Message No action required.

10220100 Error: All audio [Audio Type] need to 
have a valid parent [Language], but 
the audio [Audio Type] does not.

Error Message Verify that the necessary audio 
files exist, and then retry the 
action.

10220126 Error: Cannot import partisan [Item 
Name] in to a General Election. Set 
the election type to a primary 
election and re-import the data.

Error Message Some items are only available 
for specific election types. 
Verify that the associated item 
and election type are 
compatible, and then retry the 
action.

10220112 Error: Duplicate value [Value Name] 
for [Item Name] in the list of [Item 
Name].

Error Message Enter a unique alternate id in 
the appropriate field, and then 
retry the action.

10220125 Error: File [File Name]: line [Line 
Number]: Missing or invalid file [File 
Name] specified for field [Field 
Name].

Error Message Contact ES&S Customer 
Support.

10220104 Error: Import folder is empty or no 
valid files were found.

Error Message Verify that the folder contains 
the associated files, and that 
those files are valid. Once the 
files have been verified, retry 
the action.
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10220117 Error: Invalid [Item Name] image 
[Image Name] for Import [Item Name] 
ID.

Error Message Verify that the image is valid, 
and then retry the action.

10220111 Error: Mismatch in [Item Name] for 
[Item Name].

Error Message Contact ES&S Customer 
Support.

10220119 Error: Missing required [Item Name] 
field for Import Precinct ID [Precinct 
ID].

Error Message Enter the necessary information 
in the associated field, and then 
retry the action.

10320018 Error: No Equipments selected. You 
must have at least one Election Day 
or Absentee/Early equipment 
selected.

Error Message Select at least one early vote 
piece 

10320021 Error: No Replacement [Candidate 
Name] linked to Recall Question: 
[Contest Name]. You must have a 
Replacement [Candidate] for a Recall 
Question before you can generate 
[Ballot Style].

Error Message Verify that a replacement 
candidate has been entered for 
the recall election, and then 
retry the action.

10220106 Error: Read error when importing 
[Item Name].

Error Message Retry the action. If the error 
persists, contact ES&S.

10220109 Error: The [Item Name] ID should be 
within the range 0001 to 9900.

Error Message Verify that the item is within the 
specified range, and then retry 
the action.

10220098 Error: The non-primary [Item Name] 
cannot have the order 1.

Error Message Increase the associated item 
name’s integer, and then retry 
the action.

10220121 Error: The primary [Item Name] must 
have the order of 1, and no other 
[Item Name] can have the order of 1.

Error Message Verify that the password meets 
the criteria for valid passwords, 
and contains no spaces at either 
the beginning or end of the 
password

11320036 Error: Unknown results file type [File 
Name]

Error Message Contact ES&S Customer 
Support.

10320015 Error: You have not created an 
Absentee [Item Name]. You must have 
at least one Absentee [Item Name] to 
generate [Item Name] for Absentee 
[Item Name].

Error Message Verify that Absentees have the 
associated item and then retry 
the action.

10320011 Error: You have not created an 
Election Day [Item Name]. You must 
have at least one Election Day [Item 
Name] to generate [Item Name] for 
Election Day [Item Name].

Error Message Verify that Election Day has the 
associated item and then retry 
the action.

10320024 Error: You have not created an 
Election Day [Item Name]. You must 
have at least one Election Day [Item 
Name] to generate [Item Name].

Error Message Verify that Election Day has the 
associated item and then retry 
the action.
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10320017 Error: You have not created an 
Election Day/Absentee [Item Name]. 
You must have at least one [Item 
Name] of type Election day or 
Absentee to generate [Item Name].

Error Message Verify that Election Day/
Absentee has the associated 
item and then retry the action.

10320016 Error: You have not selected 
Absentee/Early equipment. You must 
have at least one type of Absentee 
equipment selected to generate [Item 
Name] for the Absentee [Election 
Name]. Select equipment in the home 
module under the Tools menu.

Error Message Select an Absentee/Election 
Day equipment type, and then 
retry the action.

10320013 Error: You have not selected Election 
Day equipment. You must have at 
least one type of Election Day 
equipment selected to generate [Item 
Name] for the Election Day [Election 
Name]. Select equipment in the home 
module under the Tools menu.

Error Message Select an Election Day 
equipment type, and then retry 
the action.

10320012 Error: You must have a [Item Name] 
that is set to type Absentee (or) Both 
to generate [Item Name] for 
Absentee [Election Name].

Error Message Set the associated item to 
Absentee or Both, and then 
retry the action.

10320014 Error: You must have a [Item Name] 
that is set to type Election Day (or) 
Both to generate [Item Name] for 
Election Day [Election Name].

Error Message Set the associated item to 
Election Day or Both, and then 
retry the action.

11021013 Export Folder Name is required. 
Please provide a value.

Error Message Enter a name for the Export 
folder and then retry the action.

10220156 Export Location is required. Please 
provide a value.

Error Message Provide a value for the export 
location, and then retry the 
action.

10640021 Export Results Server Validation File 
created successfully.

Informational 
Message

No action required.

10041007 Export table [Table Name] to file [File 
Name] completed.

Informational 
Message

No action required.

10121018 Failed to decrypt RAS key. Error Message Contact ES&S Customer 
Support.

10021002 Failed to delete [Item Name]. Error Message Verify that associated links are 
broken, and then retry the 
action. If the error persists, 
contact ES&S Customer 
Support.

10121002 Failed to delete [Item Name] Error Message Verify that associated links are 
broken, and then retry the 
action. If the error persists, 
contact ES&S Customer 
Support.
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10121003 Failed to delete [Item Name]. Error Message Verify that associated links are 
broken, and then retry the 
action. If the error persists, 
contact ES&S Customer 
Support.

10120012 Failed to display [Item Name] image 
[Image Name].

Error Message Verify both the location and the 
linking of the associated image 
file, and then retry the action.

10120090 Failed to display [Item Name] image 
[Image Name].

Error Message Verify both the location and the 
linking of the associated image 
file, and then retry the action.

10121017 Failed to encrypt RAS key. Error Message Contact ES&S Customer 
Support.

10120028 Failed to insert [Item Name]. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10021000 Failed to insert [Item Name]. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10121000 Failed to insert [Item Name]. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10021003 Failed to load [Item Name]. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10021001 Failed to update [Item Name]. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10121001 Failed to update [Item Name] Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10120053 Failed to update voter counts for 
[Item Name].

Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10010001 Failed writing to file [File Name]. Critical Error 
Message

Retry the action. If the error 
persists, contact ES&S 
Customer Support.

11520018 Field [Field Name] is required. Please 
provide a value.

Error Message Enter a value in the associated 
field, and then retry the action.

10121016 Field [Field Name] already exists. 
Please enter a unique value.

Error Message Enter a unique value in the 
associated field, and then retry 
the action.

11520019 Field Name [Field Name] and [Item 
Name] is too long.

Error Message Reduce the amount of 
characters, and then retry the 
action.

Message ID Message Message Type Solution



 Chapter 23: System Messages 166

EVS5200_DOC_SOP_EW01ADMIN
 Software Version 4.6

 Published: April 24, 2014

10840008 File export to [File Name] was 
successful.

File name should not be changed.

Informational 
Message

Click OK to continue.

10230053 File export to [File Name] was 
successful.

File name should not be changed.

Warning 
Message

Click OK to continue.

11041006 File export to [File Name] was 
successful.

File name should not be changed.

Informational 
Message

Click OK to continue.

10230067 File import of [File Name] was 
successful.

File name should not be changed.

Warning 
Message

Click OK to continue.

11030018 File selected either does not exist or 
has the wrong extension.

Do you want to select a different file?

Warning 
Message

Click Yes to select a different 
file.

11740012 Filter reset. Informational 
Message

Click OK to continue.

11740011 Filtering canceled. Informational 
Message

Click OK to continue.

10340005 Finalizing Ballot Styles for [Ballot ID]. Informational 
Message

Click OK to continue.

11440006 Finished Load of Results [Batch 
Name].

Informational 
Message

Click OK to continue.

11440008 Finished looking for Results in [Batch 
Name].

Informational 
Message

Click OK to continue.

10421017 First Name is required. Please provide 
a value that does not exceed 
[Number] characters.

Error Message Reduce the number of 
characters in the first name, and 
then retry the action.

10830015 Font color is required. Please provide 
a value.

Warning 
Message

Select a font color, and then 
retry the action.

10830014 Font size is required. Please provide a 
value.

Warning 
Message

Select a font size, and then retry 
the action.

10830016 Font style is required. Please provide 
a value.

Warning 
Message

Select a fonts style, and then 
retry the action.

10650012 Formatting Device Verbose 
Message

No action required.

10240094 Found Import File for: [Election 
Name].

Informational 
Message

Click OK to continue.

10421006 From Date is required. Please provide 
a value.

Error Message Enter the From Date, and retry 
the action.

10730028 Generated incorrect number of files.

Would you like to continue?

Warning 
Message

Click Yes to complete the 
action.
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10740033 Generating [Item Name] Informational 
Message

Click OK to continue.

10750002 Generating [File Name] XML for 
[Election Name].

Verbose 
Message

No action required.

10240084 Generating [Item Name]... Informational 
Message

Click OK to continue.

10750008 Generating [Item Name] Settings XML 
for [Election Name].

Verbose 
Message

No action required.

10750009 Generating [Item Name] Settings XML 
for [Election Name].

Verbose 
Message

No action required.

10740039 Generating Accessible Equipment 
files for [Equipment Type].

Informational 
Message

Click OK to continue.

10750016 Generating audio ballot files Verbose 
Message

No action required.

10750017 Generating audio ballot files for 
[Election Name]

Verbose 
Message

No action required.

10640015 Generating Ballot Manifest File Informational 
Message

Click OK to continue.

10750012 Generating Ballot Style XML for 
[Election Name].

Verbose 
Message

No action required.

10340001 Generating Ballot Styles for [Election 
Name].

Informational 
Message

Click OK to continue.

10320007 Generating ballot styles has been 
canceled.

Error Message Click OK to continue.

10750001 Generating Business XML Verbose 
Message

No action required.

10750013 Generating Business XML {0} and 
ballot style content

Verbose 
Message

No action required.

10750007 Generating Business XML complete Verbose 
Message

No action required.

10740040 Generating business XML has been 
canceled.

Informational 
Message

Click OK to continue.

10740034 Generating data for memory devices 
complete

Informational 
Message

Click OK to continue.

10750005 Generating Election XML Verbose 
Message

No action required.

10750006 Generating Election XML complete Verbose 
Message

No action required.

10750010 Generating Jurisdiction XML Verbose 
Message

No action required.

10750011 Generating Jurisdiction XML 
complete

Verbose 
Message

No action required.
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10050002 Generating Report... Verbose 
Message

No action required.

10740036 Generation successfully canceled Informational 
Message

Click OK to continue.

10730011 Generation successfully canceled.

There are [Item Name] assigned to 
more than one Election Day [Item 
Name].

Warning 
Message

Verify the assignment of items, 
and then retry the action.

10220176 Group Number field is required. 
Please provide a value.

Error Message Enter a value in the associated 
field, and then retry the action.

10220043 Group number: [Group Number] 
already exists. Please enter a unique 
value.

Error Message Enter a unique group number, 
and then retry the action.

10220044 Group Number: [Group Number] does 
not exist.

You need to add a [Item Name] with 
Group Number: [Group Number] to 
add [Item Name] for that group.

Error Message Enter a Group Number for the 
specified group, and then retry 
the action.

10120091 Group Number: [Group Number] does 
not exist.

You need to add a [Item Name] with 
Group Number: [Group Number] to 
add [Item Name] for that group.

Error Message Enter a Group Number for the 
specified group, and then retry 
the action.

10340004 Grouping Ballot Styles for [Ballot ID] Informational 
Message

Click OK to continue.

10220160 Import of file [File Name] failed on the 
[File Name] sheet, which seems to be 
missing. 

Please make sure you are using a valid 
excel translation document with a 
sheet for each [Language].

Error Message Verify that the Excel 
spreadsheet you are trying to 
import is valid, and then retry 
the action. If the error persists, 
contact ES&S Customer 
Support.

11021027 Import of the file [File Name] failed on 
the [File Name] sheet, which seems to 
be missing.

Please make sure you are using an up 
to date excel translation document 
with a sheet for each [Language].

Error Message Verify that the Excel 
spreadsheet you are trying to 
import is up to date, and then 
retry the action. If the error 
persists, contact ES&S 
Customer Support.

10240092 Import process is complete.

Note: Please generate ballot styles in 
Capture and re-finalize ballot styles in 
Paper ballot before generating 
election data in Configure.

Informational 
Message

Generate ballot styles and 
re-finalize ballot layout in Paper 
Ballot before generating 
election data. 

Failure to follow these steps will 
lead to errors during tabulation.

Click OK to continue.

10230133 Import process is complete.

Number of warnings: [Number]

Warning 
Message

Review the listed warnings, and 
correct any potential errors.
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10220103 Import process stopped due to 
errors.

Number of errors: [Number]

Number of warnings: [Number]

Error Message Review the listed errors and 
warnings, and correct any 
potential issues before 
continuing.

10240008 Import successfully canceled Informational 
Message

Click OK to continue.

11030012 Importing [Equipment Type] screen 
definitions will change the screens 
that appear to voters on the 
[Equipment Type]. Make sure to 
thoroughly test the [Equipment Type] 
prior to your election in order to 
verify the screen changes.

Do you want to continue?

Warning 
Message

Click Yes to complete the 
action. 

10850001 Importing [Item Name]... Verbose 
Message

No action required.

11050002 Importing [Item Name]... Verbose 
Message

No action required.

10240001 Importing Election... Informational 
Message

Click OK to continue.

10250005 Importing XML: [File Name] Verbose 
Message

No action required.

10250021 Importing XML: [File Name] Verbose 
Message

No action required.

10250002 Importing XML: Ballot Options / 
Election

Verbose 
Message

No action required.

10250014 Importing XML: Ballot Style Verbose 
Message

No action required.

10250015 Importing XML: Ballot Style and [Item 
Name] cross reference

Verbose 
Message

No action required.

10240004 Importing XML: Committing updates 
to the database

Informational 
Message

Click OK to continue.

10240005 Importing XML: Completed parsing 
Election Import Document

Informational 
Message

Click OK to continue.

10250027 Importing XML: Controlling [Contest 
Name] and [Item Name].

Verbose 
Message

No action required.

10250017 Importing XML: Data existing in 
Electionware that is not also 
contained in the import file will be 
deleted.

Verbose 
Message

No action required.

10250019 Importing XML: Graphic Verbose 
Message

No action required.

10240003 Importing XML: Parsing Election 
Import Document

Informational 
Message

Click OK to continue.
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10250001 Importing XML: Parsing Election 
Import Document

Verbose 
Message

No action required.

10250016 Importing XML: Poll Verbose 
Message

No action required.

10250018 Importing XML: Version Verbose 
Message

No action required.

10250013 Importing XML: Write In {0} Verbose 
Message

No action required.

10550002 Initializing Verbose 
Message

No action required.

10041000 Inserted [Item Name] Informational 
Message

Click OK to continue.

10020019 Instance connection to the database 
failed: [Database Name].

Error Message Contact ES&S Customer 
Support.

10620026 Insufficient security access. Error Message Verify the security access of the 
user, and then retry the action.

10620010 Insufficient storage available on 
specified device.

Error Message Verify the storage capacity of 
the specified device, and then 
retry the action.

10220163 Internal database error occurred.

A more detailed technical explanation 
can be viewed in the 
Window->Output->Exceptions 
window.

Error Message Review the additional 
information, and then contact 
ES&S Customer Support.

10830027 Internal database errors occurred.

A more detailed technical explanation 
can be viewed in the Output 
Exceptions Window.

Warning 
Message

Review the additional 
information, and then contact 
ES&S Customer Support.

10021004 Internal error. Business rule message 
not found.

Error Message Contact ES&S Customer 
Support.

11320001 Internal Error

Line: [Item Name]

Error Message Contact ES&S Customer 
Support.

10020008 Internal processing error. Error Message Contact ES&S Customer 
Support.

10810000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

10820000 Internal System Error Error Message Contact ES&S Customer 
Support.

10830000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

10840000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.
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10850000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

10860000 Internal System Error Debug Message Contact ES&S Customer 
Support.

11410000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

11420000 Internal System Error Error Message Contact ES&S Customer 
Support.

11430000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

11440000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

11450000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

11460000 Internal System Error Debug Message Contact ES&S Customer 
Support.

10410000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

10420000 Internal System Error Error Message Contact ES&S Customer 
Support.

10430000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

10440000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

10450000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

10460000 Internal System Error Debug Message Contact ES&S Customer 
Support.

11110000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

11120000 Internal System Error Error Message Contact ES&S Customer 
Support.

11130000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

11140000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

11150000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

11160000 Internal System Error Debug Message Contact ES&S Customer 
Support.

10310000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.
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10320000 Internal System Error Error Message Contact ES&S Customer 
Support.

10330000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

10340000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

10350000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

10360000 Internal System Error Debug Message Contact ES&S Customer 
Support.

10210000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

10220000 Internal System Error Error Message Contact ES&S Customer 
Support.

10230000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

10240000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

10250000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

10260000 Internal System Error Debug Message Contact ES&S Customer 
Support.

11510000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

11520000 Internal System Error Error Message Contact ES&S Customer 
Support.

11530000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

11540000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

11550000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

11560000 Internal System Error Debug Message Contact ES&S Customer 
Support.

10710000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

10720000 Internal System Error Error Message Contact ES&S Customer 
Support.

10730000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

10740000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.
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10750000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

10760000 Internal System Error Debug Message Contact ES&S Customer 
Support.

10010000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

10020000 Internal System Error Error Message Contact ES&S Customer 
Support.

10030000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

10040000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

10050000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

10060000 Internal System Error Debug Message Contact ES&S Customer 
Support.

10110000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

10120000 Internal System Error Error Message Contact ES&S Customer 
Support.

10130000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

10140000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

10150000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

10160000 Internal System Error Debug Message Contact ES&S Customer 
Support.

11010000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

11020000 Internal System Error Error Message Contact ES&S Customer 
Support.

11030000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

11040000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

11050000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

11060000 Internal System Error Debug Message Contact ES&S Customer 
Support.

10610000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.
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10620000 Internal System Error Error Message Contact ES&S Customer 
Support.

10630000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

10640000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

10650000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

10660000 Internal System Error Debug Message Contact ES&S Customer 
Support.

10910000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

10920000 Internal System Error Error Message Contact ES&S Customer 
Support.

10930000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

10940000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

10950000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

10960000 Internal System Error Debug Message Contact ES&S Customer 
Support.

11710000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

11720000 Internal System Error Error Message Contact ES&S Customer 
Support.

11730000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

11740000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

11750000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

11760000 Internal System Error Debug Message Contact ES&S Customer 
Support.

11210000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

11220000 Internal System Error Error Message Contact ES&S Customer 
Support.

11230000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

11240000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.
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11250000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

11260000 Internal System Error Debug Message Contact ES&S Customer 
Support.

11310000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

11320000 Internal System Error Error Message Contact ES&S Customer 
Support.

11330000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

11340000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

11350000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

11360000 Internal System Error Debug Message Contact ES&S Customer 
Support.

10510000 Internal System Error Critical Error 
Message

Contact ES&S Customer 
Support.

10520000 Internal System Error Error Message Contact ES&S Customer 
Support.

10530000 Internal System Error Warning 
Message

Contact ES&S Customer 
Support.

10540000 Internal System Error Informational 
Message

Contact ES&S Customer 
Support.

10550000 Internal System Error Verbose 
Message

Contact ES&S Customer 
Support.

10560000 Internal System Error Debug Message Contact ES&S Customer 
Support.

10920003 Internal System Error launching 
Electionware Paper Ballot. Error 
connecting to database, return code 
[Error Code].

Error Message Contact ES&S Customer 
Support.

10920004 Internal System Error launching 
Electionware Paper Ballot. Invalid 
election reference, return code [Error 
Code].

Error Message Contact ES&S Customer 
Support.

10920001 Internal System Error launching 
Electionware Paper Ballot. Invalid 
launch parameters, return code [Error 
Code].

Error Message Contact ES&S Customer 
Support.

10920002 Internal System Error. Electionware 
Paper Ballot exited abnormally.

Error Message Restart the Paper Ballot 
module. If the error persists, 
contact ES&S Customer 
Support.
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11520015 Invalid characters in username. Error Message Verify that the characters in the 
user name are valid, and retry 
the action.

10520022 Invalid code. Unable to decrypt 
restore package. Please provide a 
valid code.

Error Message Enter a valid restore code, and 
retry the action.

11021006 Invalid election or file. Error Message Click OK to continue.

10220063 Invalid Entity Text ID [Item Name] 
found. Make sure you are using an 
up-to-date translation script 
corresponding to the election.

Error Message Verify that the translation script 
is up to date, and then retry the 
action. If the error persists, 
contact ES&S Customer 
Support.

10020021 Invalid file extension, must be ‘jrxml’ 
or ‘jasper’: [File Name]

Error Message Contact ES&S Customer 
Support.

11021008 Invalid file format. Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11320003 Invalid Header File Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11520013 Invalid Login ID. Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11030020 Invalid signature or invalid file format 
while updating Equipment Type] 
screen definitions.

Do you want to select a different file?

Warning 
Message

Click Yes to select a different 
file.

11320010 IO Exception [Error Code] Error Message Contact ES&S Customer 
Support.

10520046 Jurisdiction code length is required to 
be [Number] - [Number] characters.

Error Message Verify that the number of 
characters in the Jurisdiction 
Code fall within the specified 
range.

10840019 Label ID Informational 
Message

Click OK to continue.

10830020 Label types do not match. Try editing 
labels one at a time.

Warning 
Message

Edit the labels singularly, and 
retry the action.

10840020 Label-[Label Name] ID Informational 
Message

Click OK to continue.

10421018 Last Name is required. Please provide 
a value that does not exceed 
[Number] characters.

Error Message Verify that the number of 
characters in the Last Name do 
not exceed the specified value.

10840014 Launching Ballot Previewer in 
separate window.

Informational 
Message

Click OK to continue.
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10020015 Link in report failed: [Report Name]. Error Message Contact ES&S Customer 
Support.

10020013 Load Report failed: Report Name. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10421019 Login ID [Login ID] contains invalid 
characters.

Error Message Verify that the Login ID contains 
only those characters specified, 
and then retry the action.

11520017 Login ID already exists for [Login ID] Error Message Enter a unique Login ID and 
retry the action.

10421016 Login ID is required. Please provide a 
value that does not exceed [Number] 
characters.

Error Message Verify the number of characters 
in the Login ID do not exceed 
the specified limit, and then 
retry the action.

11430006 Media is being loaded, please wait 
for it to finish before closing.

Warning 
Message

Closing the window prior to 
media being loaded may cause 
serious errors. It is strongly 
advised that you let media load 
before closing out the window.

11021005 Missing or Invalid file [File Name]. Error Message Verify the file location, and retry 
the location. If the error 
persists, contact ES&S 
Customer Support.

11420005 Missing or Invalid file [File Name]. 
Please provide a valid file.

Error Message Verify the file location, and retry 
the location. If the error 
persists, contact ES&S 
Customer Support.

10869999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

11469999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

10469999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

11169999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

10369999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

10269999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

11569999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

10769999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

10069999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.
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10169999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

11069999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

10669999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

10969999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

11769999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

11269999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

11369999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

10569999 Missing Resource String: [Item Name] Debug Message Contact ES&S Customer 
Support.

10041004 Moved [Item Name]: from position 
[Position Number] to [Position 
Number].

Informational 
Message

Click OK to continue.

10640011 Multiple [Equipment Type] device 
creation canceled.

Informational 
Message

Click OK to continue.

10640012 Multiple [Equipment Type] device 
creation complete.

Informational 
Message

Click OK to continue.

10520066 New election concurrent connection 
error.

Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10540003 New Election created with ID: 
[Election ID] Name: [Election Name].

Informational 
Message

Click OK to continue.

10520038 New Election creation canceled. 
Deleting Election with ID: [Election 
ID] Name: [Election Name].

Error Message Click OK to continue.

10540005 New Election has been canceled. Informational 
Message

Click OK to continue.

10540032 New Election Template [Template 
Name] Created.

Informational 
Message

Click OK to continue.

11740004 New results filter applied: [Batch 
Name].

Informational 
Message

Click OK to continue.

10220170 New rotation field is required. Please 
provide a value.

Error Message Enter a value in the rotation 
field, and then retry the action.

10220150 No [Item Name] were selected for the 
[Item Name].

Error Message Make a selection for the 
corresponding item, and then 
retry the action.
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10220138 No [Item Name} are assigned to [Item 
Name]. Please assign [Item Name] to 
[Item Name] or choose a different 
[Item Name].

Error Message Assign a selection to the 
corresponding item, and then 
retry the action.

11140003 No ballot images were found. Informational 
Message

Click OK to continue.

10440011 No election opened. An election must 
be open to use this function.

Informational 
Message

Click OK to continue.

10520050 No election opened. An election must 
be open to view its status.

Error Message Open an election, and then 
retry the action.

10020016 No pages in report failed: [Report 
Name].

Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10220174 Not all [Item Name] have the same 
[Item ID] ID for [Item Name]

Error Message Make sure that the associated 
items have matching IDs, and 
retry the action.

10840017 Null message Informational 
Message

Confirm that you wish to 
continue, and lose the currently 
imported audio files.

10320004 Number of critical errors: [Number] 

Number of warnings: [Number].

Error Message Review both the errors and 
warnings. If possible correct any 
issues, and then re-run the 
Validation Errors process.

10441029 Number of days before expiration set 
to [Number].

Informational 
Message

Click OK to continue.

10240100 Number of Files processed: [Number] Informational 
Message

Click OK to continue.

10720111 Number of Lines is required. Please 
provide a value.

Error Message Enter a value, and then retry the 
action.

10240097 Number of Records added: [Number]. Informational 
Message

Click OK to continue.

10240099 Number of Records deleted: 
[Number]

Informational 
Message

Click OK to continue.

10240098 Number of Records updated: 
[Number].

Informational 
Message

Click OK to continue.

10220135 Number of Write-ins field should be 
numeric.

Error Message Verify that the characters in the 
Write-in field are numeric, and 
then retry the action.

10830019 Only one ballot style can be selected 
for preview.

Warning 
Message

Select only one ballot style to 
preview, and then retry the 
action.

10550003 Open Election: Finding Customer... Verbose 
Message

No action required.
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10550005 Open Election: Finding Election... Verbose 
Message

No action required.

10550004 Open Election: Finding Jurisdiction... Verbose 
Message

No action required.

10041006 Operation canceled by user Informational 
Message

Click OK to continue.

11320009 Operation not supported [Operation 
Name].

Error Message Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

10650004 Packaging files Verbose 
Message

No action required.

10421022 Password cannot start or end with a 
space.

Error Message Remove spaces from the 
password, and retry the action.

10421012 Password is too long. Please enter a 
value that does not exceed 16 
characters.

Error Message Enter a value less than 16 
characters and then retry the 
action.

10421014 Password is too short. Please enter at 
least 8 characters for this value.

Error Message Enter a value with at least 8 
characters and then retry the 
action.

10421021 Password must contain at least one 
character from 3 of the following 4 
classes:

Error Message Enter a password with 
characters from at least 3 of the 
4 displayed classes.

10421013 Passwords do not match. Please 
provide values that match.

Error Message Verify that the passwords 
match, and then retry the action

10720138 Please Finalize the Ballot Layout in 
Paper Ballot before attempting to 
generate election data.

Error Message Finalize ballot layout in Paper 
Ballot before generating 
election data.

10720099 Please generate ballot styles in 
Capture and re-finalize ballot styles in 
Paper ballot before generating 
election data in Configure

Error Message Generate ballot styles and 
finalize ballot layout before 
generating election data.

10421011 Please select a state in the navigator 
view to add a county.

Error Message Select a state, and then retry 
the action.

10720139 Please select accessible equipment 
before attempting to generate the 
election data.

Error Message Select accessible equipment, 
and then retry the action.

10520049 Please select an election to save it as 
a template.

Error Message Select an election, and then 
retry the action.

11320002 Please select an existing directory. Error Message Select an existing directory, and 
then retry the action.

10720107 Prefixes formatted to numbers, 
commas and pound signs(#) only.

Error Message Verify that all characters in the 
Prefix field are numbers, 
commas, or pound signs, and 
then retry the action.
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10650014 Preparing [Number] Files for Ballot 
Preview

Verbose 
Message

No action required.

10650019 Preparing [Number] Files for Ballot 
Preview

Verbose 
Message

No action required.

10840012 Preparing Election Data for Ballot 
Previewer.

Informational 
Message

Click OK to continue.

10840011 Preparing environment to launch 
Ballot Previewer for [Equipment 
Type].

Informational 
Message

Click OK to continue.

10720104 Primary I.P. address must be entered 
in the following format. 
(###.###.###.###)

Error Message Verify that all I.P. addresses 
match the displayed format, 
and then retry the action.

10720105 Primary I.P. address must be 
formatted correctly 
(###.###.###.###).

Please enter a correctly formatted 
value.

Error Message Verify that all I.P. addresses 
match the displayed format, 
and then retry the action.

10720102 Primary Phone Number formatted to 
numbers, commas, and pound 
signs(#) only.

Error Message Verify that all characters in the 
Primary Phone Number field are 
numbers, commas, or pound 
signs, and then retry the action.

10720108 Primary phone number must be 
entered for land lines

Error Message Enter a land line for the primary 
phone number, and then retry 
the action.

10020011 Print Report failed: [Report Name]. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

11740009 Printing canceled by user. Informational 
Message

Click OK to continue.

11740007 Printing facsimile Ballot [Ballot ID] 
from [File Location].

Informational 
Message

Click OK to continue.

11740006 Printing official Ballot [Ballot ID] from 
[File Location].

Informational 
Message

Click OK to continue.

10040005 Printing report: [Report Name] Informational 
Message

Click OK to continue.

11740008 Printing scanned Ballot Ballot ID] from 
[File Location].

Informational 
Message

Click OK to continue.

11340005 Processed unknown ballot sheet 
[Ballot ID]

Informational 
Message

Click OK to continue.

10240096 Processing [Item Name] data Informational 
Message

Click OK to continue.

10230061 Processing file [File Name] Warning 
Message

Click OK to continue.
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11050001 Processing file [File Name] Verbose 
Message

Click OK to continue.

10830025 Provide a [Item Name] value and 
select a valid import file for that [Item 
Name].

Warning 
Message

Provide the appropriate value 
and then select a valid import 
file. When complete, retry the 
action.

10220161 Provide a [Item Name] value and 
select a valid import file for that [Item 
Name].

Error Message Provide the appropriate value 
and then select a valid import 
file. When complete, retry the 
action.

11740001 Provisional status for ballot [Ballot ID] 
changed to [Item Name].

Informational 
Message

Click OK to continue.

11440009 Queuing for results processing: Informational 
Message

Click OK to continue.

10720113 RAS Password must be entered and 
be confirmed.

Please enter a RAS Password and 
confirm it.

Error Message Enter the RAS password, and 
then retry the action.

10240007 Re-import successfully canceled Informational 
Message

Click OK to continue.

10240093 Reading [Item Name] Informational 
Message

Click OK to continue.

10020023 Refresh called on a non supported 
table model. Table model must be a 
‘ListTableModel’

Error Message Verify that the table model is 
valid, and then retry the action. 
If the error persists, contact 
ES&S Customer Support.

10010006 Releasing connection failed: [Error 
Code]. Please review the output 
window for details.

Critical Error 
Message

Review the information, and 
then contact ES&S Customer 
Support.

10030004 Reload data and overwrite pending 
changes?

Warning 
Message

Click Yes to complete the 
action.

11440012 Reloading media with images, Poll ID 
[Poll ID]Media ID [Media ID]Machine 
SN [Machine Serial Number].

Informational 
Message

Click OK to continue.

10840026 Repeated Informational 
Message

Click OK to continue.

10640020 Reporting Key Media created.

Please remove the device.

Informational 
Message

Click OK to continue.

10650016 Resetting Election Media Status Verbose 
Message

No action required.

10220173 Response name field is required. 
Please provide a value.

Error Message Enter a value in the Response 
Name Field, and then retry the 
action.
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10520055 Restore election code contains 
spaces. Please remove any spaces.

Error Message Remove spaces from the restore 
code, and then retry the action.

10520052 Restore election code is required. 
Please provide a value.

Error Message Enter a Restore Code in the 
associated field, and then retry 
the action.

10520056 Restore election code is too long. 
Please enter a value that does not 
exceed [Number] characters.

Error Message Reduce the number of 
characters in the Restore Code, 
and then retry the action.

10520054 Restore election code is too short. 
Please enter at least [Number] 
characters for this value.

Error Message Increase the number of 
characters in the Restore Code, 
and then retry the action.

10520057 Restore election code must contain at 
least one character from 3 of the 
following 4 classes:

Error Message Verify that at least one 
character from 3 of the 4 classes 
is used in the Restore Code, and 
then retry the action.

10520058 Restore election code must contain at 
least one letter and one number.

Error Message Verify that at least one letter 
and one number is used in the 
Restore Code, and then retry 
the action.

10520059 Restore election code must contain at 
least one number or letter.

Error Message Verify that at least one letter or 
one number is used in the 
Restore Code, and then retry 
the action.

10540044 Restore Election has been canceled. Informational 
Message

Click OK to continue.

10520020 Restore file version [Restore File 
Version] does not match current 
database version [Database Version].

Error Message Verify the restore file and 
database version correspond. If 
they do and the error persists, 
contact ES&S Customer 
Support.

10550006 Restored election [Election Name] 
from machine [Machine ID]

Verbose 
Message

No action required.

10540041 Restoring election data Informational 
Message

Click OK to continue.

11430007 Results already loaded, Poll ID [Poll 
Name] Media ID [Media ID] Machine 
SN [Machine Serial Number].

Warning 
Message

Click OK to continue

11440013 Results Clearing Canceled by user Informational 
Message

Click OK to continue.

11740005 Results filter reset to default. Informational 
Message

Click OK to continue.

10520043 Results Folder Name is required. 
Please provide a value.

Error Message Enter a value in the Results 
Folder Name field, and then 
retry the action.

11440005 Results successfully cleared Informational 
Message

Click OK to continue.
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10650008 Retrieving keys Verbose 
Message

No action required.

11240004 Reverted votes for [Poll Place]. Informational 
Message

Click OK to continue.

10010013 Rollback transaction error: [Item 
name].

Critical Error 
Message

Contact ES&S Customer 
Support.

10340003 Rotating Ballot Styles for [Poll ID] Informational 
Message

Click OK to continue.

10020010 Run Report failed: [Report Name]. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10040004 Running report: [Report Name] Informational 
Message

Click OK to continue.

10020012 Save Report failed: [Report Name]. Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10240011 Save successful. Any format changes 
made in Paper Ballot will also be 
applied in Accessible Ballot. You will 
need to click the ‘Refresh’ button on 
any format screens currently open in 
Accessible Ballot to view the changes.

Informational 
Message

Click OK to continue.

10650010 Saving [Number] files Verbose 
Message

No action required.

10650020 Saving [Number] files Verbose 
Message

No action required.

10650015 Saving audio ballot files Verbose 
Message

No action required.

10650009 Saving auth file Verbose 
Message

No action required.

10250003 Saving Ballots Verbose 
Message

No action required.

10750015 Saving Business XML to the database Verbose 
Message

No action required.

10540035 Saving Election Template has been 
canceled.

Informational 
Message

Click OK to continue.

10041003 Saving report: [Report Name] Informational 
Message

Click OK to continue.

10250020 Saving Style Sheets Verbose 
Message

No action required.

10650003 Saving system objects Verbose 
Message

No action required.
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10650002 Saving XML files Verbose 
Message

No action required.

10830001 Script Related Error Warning 
Message

Contact ES&S Customer 
Support.

10220166 Script Related Error Error Message Contact ES&S Customer 
Support.

11021022 Script Related Error Error Message Contact ES&S Customer 
Support.

10720106 Secondary I.P. address must be 
formatted correctly 
(###.###.###.###).

Please enter a correctly formatted 
value.

Error Message Verify that the Secondary I.P. 
address matches the displayed 
format, and then retry the 
action.

10720103 Secondary Phone Number formatted 
to numbers, commas, and pound 
signs(#) only.

Error Message Verify that all characters in the 
Secondary Phone Number field 
are numbers, commas, or pound 
signs, and then retry the action.

10420020 Security Setting should be 0 to not 
expire or any number between 1 and 
999 (days).

Error Message Set the Security Setting to one 
of the specified values, and then 
retry the action.

10240109 Selecting the [Item Name] will now 
require setup of a [Item Name].

Informational 
Message

Click OK to continue.

10720110 Signature is required. Please provide 
a value.

Error Message Enter a valid signature, and 
then retry the action.

10650007 Signing files Verbose 
Message

No action required.

11430008 Skipping out of date batch, Poll ID 
[Poll ID] Media ID [Media ID] Machine 
SN [Machine Serial Number].

Warning 
Message

Click OK to continue. If the 
error persists, contact ES&S 
Customer Support.

11320007 SQL Exception [SQL Error] Error Message Contact ES&S Customer 
Support.

10020001 SQL Query execution, [Query Name] 
failed: [SQL Error].

Error Message Contact ES&S Customer 
Support.

11340001 Starting Acquire Server. Informational 
Message

Click OK to continue.

11440002 Starting Load of Results [Batch Name] Informational 
Message

Click OK to continue.

11440007 Starting to look for Results in [Batch 
Name].

Informational 
Message

Click OK to continue.

10421026 State Name is required. Please 
provide a value that does not exceed 
255 characters.

Error Message Enter a state name with the 
specified number of characters, 
and then retry the action.

10441019 State: [State Name] deleted. Informational 
Message

Click OK to continue.
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10220171 Static/Flow field is required. Please 
provide a value.

Error Message Enter a value in the Static/Flow 
field, and then retry the action.

11340010 Stopping Acquire Server. Informational 
Message

Click OK to continue.

10020002 Stored procedure [Item Name] failed: 
[Error Code].

Error Message Retry the action. If the error 
persists, contact ES&S 
Customer Support.

10720109 Tape Text is required. Please provide 
a value.

Error Message Enter a value in the Tape Text 
field, and then retry the action.

10520024 Template Name is required. Please 
provide a value.

Error Message Enter a Template Name and 
then retry the action.

10520026 Template Name is too long. Please 
enter a value that does not exceed 
[Number] characters.

Error Message Reduce the number of 
characters in the Template 
Name, and then retry the 
action.

10520025 Template Name is too short. Please 
enter at least [Number] characters for 
this value.

Error Message Increase the number of 
characters in the Template 
Name, and then retry the 
action.

10220134 Term Number is invalid. Please enter 
a value greater than zero.

Error Message Click OK to continue.

10830017 Text alignment is required. Please 
provide a value.

Warning 
Message

Click OK to continue.

10620027 The [Equipment Type] Ballot File 
cannot be created until all BOD data 
has been generated from Paper 
Ballot.

Error Message Generate all BOD data prior to 
attempting to create the Ballot 
File.

10730009 The [Equipment Type] Codes have not 
been entered.

Would you like to open the 
[Equipment Type] security screen?

Warning 
Message

Click Yes to open the 
appropriate equipment type 
security screen and enter the 
necessary codes.

10640019 The [Equipment Type Media] has been 
reset.

Informational 
Message

Click OK to continue.

10630005 The ballot file already exists.

Do you want to overwrite the file?

Warning 
Message

Click Yes to complete the 
action.

10220007 The ballot style: [Ballod ID] is not 
valid.

Error Message Correct any potential ballot 
errors and retry the action. If 
the error persists, contact ES&S 
Customer Support.

10230117 The changes you have made to [Item 
Name] will also delete the following:

Warning 
Message

Click Yes to complete the 
action.

10441030 The Custom Labels have been 
Updated.

Informational 
Message

Click OK to continue.
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10220025 The data import file is not a valid 
EDM XML file.

Error Message Contact ES&S Customer 
Support.

10220024 The data import file is required. 
Please provide a value.

Error Message Provide a location and file name 
for the data import file, and 
retry the action.

10630001 The device contains data. Do you 
want to clear the device and 
continue?

Warning 
Message

Click Yes to clear the device and 
continue.

10620007 The format command was 
interrupted.

Error Message Click OK to continue.

10230034 The generated [Item Name] has 
changed.

Do you want to replace the text for 
the [Field Name] field?

Warning 
Message

Click Yes to go to replace the 
existing text.

10030008 The generated text for the [Field 
Name] field has changed to [Custom].

Do you want to replace the text for 
field [Field Name]?

Warning 
Message

Click Yes to go to replace the 
existing text.

10030009 The generated text of the [Item 
Name] has changed.

Do you want to replace the text for 
these fields?

Warning 
Message

Click Yes to go to replace the 
existing text.

10520041 The image file [File Name] is missing.

Ensure the image file is with the 
backup file or uncheck the “Include 
Ballot Images” check box.

Error Message Verify that the image file is in 
the same folder as the backup 
file, or uncheck the “Include 
Ballot Images” option.

10230014 The paper ballot layout was 
previously finalized.

Language changes must be made 
BEFORE the paper ballot layout is 
created.

The existing layout will become 
invalid.

A new paper ballot layout and 
database update will be required.

Do you want to continue?

Warning 
Message

Verify that you want to make 
language changes to the 
election, and then click Yes to 
complete the action. 

Note that any media burned 
prior to this act is now invalid. 
Ballot Styles will have to be 
regenerated in Capture, and 
ballot layout will have to be 
re-finalized in Paper Ballot.

10120087 The Parent [Item Name] has been 
deleted. 

Please close the screen and reopen it.

Then make your changes.

Error Message Close the current screen and 
reopen it in order to refresh the 
current information.

10620032 The Qualification Media has not been 
created.

Please create the Qualification Media 
before creating any [Equipment Type] 
Media.

Error Message Create the Qualification media 
before creating any of the other 
media types.
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10720114 The RAS password must be at least 12 
characters in length.

Error Message Increase the RAS password to at 
least 12 characters, and then 
retry the action.

10720115 The RAS password must contain at 
least one character from 3 of the 4 
following character groups: 
Alphabetic Uppercase, Alphabetic 
lowercase, numbers, allowed special 
characters. 

The following special characters are 
prohibited: (space), (pipe), (colon), 
and (double quotes).

Error Message Verify that the RAS password 
contains characters from 3 of 
the 4 specified character 
groups, excluding those 
specifically prohibited in the 
error message. 

After verifying the content of 
the RAS password, retry the 
action.

11520003 The report service type was not 
specified. Specify the report service 
type for the report you are trying to 
create.

Error Message Enter the report service type, 
and then retry the action.

10220129 The same Cross Endorsement Id has 
been used by another [User Name] in 
this [Election Name].

Error Message Refresh the data, and then 
verify that only unique cross 
endorsement IDs are used.

10830021 The summary text for [Contest Name] 
contains more characters than are 
allowed.

Must be less than 10240 characters.

Warning 
Message

Reduce the number of 
characters in the summary text, 
and then retry the action.

11520002 The Validate Data process was unable 
to complete.

Error Message Contact ES&S Customer 
Support.

10730046 There are [Item Name] associated 
with more than one Election Day 
[Item Name].

Do you want to continue?

Warning 
Message

Click Yes to complete the 
action.

10730010 There are [Item Name] that are not 
assigned to any [Item Name].

Would you like to continue?

Warning 
Message

Click Yes to complete the 
action.

10230031 There are other same named [Item 
Name] in this [Election Name] with a 
different Cross Endorsement ID.

Do you want to continue (Yes/No)?

Warning 
Message

Click Yes to complete the 
action.

10030003 There are pending changes. Do you 
want to save?

Warning 
Message

Click Yes to save the current 
data.

10830026 There are problems reading or writing 
the file or directory you have 
specified.

A more detailed technical explanation 
can be viewed in the Output 
Exceptions Window.

Warning 
Message

Review the technical data, and if 
possible, correct any errors. 
Otherwise, contact ES&S 
Customer Support.
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11021028 There are problems reading or writing 
the file or directory you have 
specified.

A more detailed technical explanation 
can be viewed in the Output 
Exceptions Window.

Error Message Review the technical data, and if 
possible, correct any errors. 
Otherwise, contact ES&S 
Customer Support.

10220162 There are problems reading or writing 
the file or directory you have 
specified.

A more detailed technical explanation 
can be viewed in the 
Window->Output->Exceptions 
window.

Error Message Review the technical data, and if 
possible, correct any errors. 
Otherwise, contact ES&S 
Customer Support.

10030001 There are unsaved changes. Do you 
want to continue?

Warning 
Message

Click Yes to complete the 
action.

10520042 There are unsaved changes. Please 
close any unsaved forms before 
backing up the election.

Error Message Close all unsaved screens 
before backing up the election.

10320008 There are unsaved changes. Please 
close any unsaved forms before 
generating ballot styles.

Error Message Close all unsaved screens 
before generating ballot styles.

10220118 There are unsaved changes. Please 
close any unsaved forms before 
importing election data.

Error Message Close all unsaved screens 
before generating ballot styles.

10530001 There are unsaved changes. Please 
close any unsaved forms.

Warning 
Message

Close all unsaved screens 
before making changes.

10220128 There are unsaved changes. Please 
close or refresh any unsaved forms.

Error Message Close or refresh all unsaved 
screens before making changes.

10630003 This election must be successfully 
generated.

Do you want to go to the Configure 
Equipment module?

Warning 
Message

Click Yes to go to the Configure 
Equipment module and 
generate election data.

10630006 This media was already used to create 
a [Item Name] for this election. If you 
proceed you will need to re-create 
the [Item Name].

Do you want to continue?

Warning 
Message

Click Yes to continue. Note, you 
will need to re-create the item 
mentioned in the warning 
message.

10630007 This will reset the media status to 
“not-created”.

You will have to re-create selected 
media if you proceed.

Do you want to continue?

Warning 
Message

Resetting media status requires 
that all media be recreated. 
Click Yes to continue.

10421007 To Date is required. Please provide a 
value.

Error Message Enter a To Date, and retry the 
action.
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11430002 Too many records to load. Please 
review report filter criteria.

Warning 
Message

Review the report filter criteria, 
and verify that the number of 
records meets these 
requirements.

11740010 Too many records. Informational 
Message

Click OK to continue.

10220143 Translated Name is required. Please 
provide a value.

Error Message Enter a value for the Translated 
Name, and then retry the 
action.

10220144 Translated Name is too long. Please 
change the value so that it does not 
exceed [Number] characters.

Error Message Reduce the number of 
characters in the Translated 
Name, and then retry the 
action.

11440010 Un-queuing for results processing: 
[Item Name]

Informational 
Message

Click OK to continue.

10120024 Unable to add Audio [Language]. You 
can only add one Audio [Language] 
for each Screen [Language].

Error Message Verify that you are only adding 
one audio item per screen 
language and retry the action.

10121013 Unable to assign existing users to 
election. [Election Name]

Error Message Contact ES&S Customer 
Support.

10520061 Unable to backup election.

The election is in use by other users:

[User Name]

Please try again later.

Error Message Verify that the user(s) have 
logged out of the election, and 
then retry the action.

10140012 Unable to continue.

The election is locked by another 
user:

[User Name]

Please try again later.

Informational 
Message

Verify that the user has logged 
out of the election, and then 
retry the action.

11021033 Unable to create script.

The election is in use by other users:

[User Name]

Please try again later.

Error Message Verify that the user(s) have 
logged out of the election, and 
then retry the action.

10140024 Unable to delete election.

The election is in use by other users:

[User Name]

Please try again later.

Informational 
Message

Verify that the user(s) have 
logged out of the election, and 
then retry the action.

10840016 Unable to export system audio.

The election is in use by other users:

[User Name]

Please try again later.

Informational 
Message

Verify that the user(s) have 
logged out of the election, and 
then retry the action.
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10220183 Unable to generate Ballot Styles.

The election is in use by other users:

[User Name]

Please try again later.

Error Message Verify that the user(s) have 
logged out of the election, and 
then retry the action.

10220180 Unable to generate data.

The election is in use by other users:

[User Name]

Please try again later.

Error Message Verify that the user(s) have 
logged out of the election, and 
then retry the action.

10720135 Unable to generate election data.

The election is in use by other users:

[User Name]

Please try again later.

Error Message Verify that the user(s) have 
logged out of the election, and 
then retry the action.

10120003 Unable to hash code for encryption. Error Message Contact ES&S Customer 
Support.

11021032 Unable to import audio files.

The election is in use by other users:

[User Name]

Please try again later.

Error Message Verify that the user(s) have 
logged out of the election, and 
then retry the action.

10840027 Unable to import ballot audio.

The election is in use by other users:

[User Name]

Please try again later.

Informational 
Message

Verify that the user(s) have 
logged out of the election, and 
then retry the action.

10220158 Unable to import data.

The election is in use by other users:

[User Name]

Please try again later.

Error Message Verify that the user(s) have 
logged out of the election, and 
then retry the action.

11021034 Unable to import translation files.

The election is in use by other users:

[User Name]

Please try again later.

Error Message Verify that the user(s) have 
logged out of the election, and 
then retry the action.

10940001 Unable to launch Electionware Paper 
Ballot.

The election is in use by other users:

[User Name]

Please try again later.

Informational 
Message

Verify that the user(s) have 
logged out of the election, and 
then retry the action.

11430001 Unable to load results.

Results are being loaded by another 
user:

[User Name].

Warning 
Message

Verify that the user has logged 
out of the election, and then 
retry the action.
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10240010 Unable to re-import election data.

The election is in use by other users:

[User Name]

Please try again later.

Informational 
Message

Verify that the user(s) have 
logged out of the election, and 
then retry the action.

10520062 Unable to save election as template.

The election is in use by other users:

[User Name]

Please try again later.

Error Message Verify that the user(s) have 
logged out of the election, and 
then retry the action.

10121014 Unable to update admin election 
map.

Error Message Contact ES&S Customer 
Support.

10120009 Unable to update field text data for 
entity [Item Name] tables.

Error Message Contact ES&S Customer 
Support.

11120002 Unable to view ballot image Error Message Contact ES&S Customer 
Support.

10240087 Unassign [Item Name] from [Item 
Name]

Informational 
Message

Contact ES&S Customer 
Support.

11320008 Unexpected end of result set Error Message Contact ES&S Customer 
Support.

10930001 Unknown return code from 
Electionware Paper Ballot.

Warning 
Message

Contact ES&S Customer 
Support.

10650013 Unmounting Device Verbose 
Message

No action required.

10041001 Updated [Item Name] Informational 
Message

Click OK to continue.

10441024 Updated county with ID [County ID]. 
Name: [County Name].

Informational 
Message

Click OK to continue.

10240064 Updated Registered Voter Counts Informational 
Message

Click OK to continue.

10441022 Updated state with ID [State ID]. 
Name: [State Name].

Informational 
Message

Click OK to continue.

10440003 Updated user with ID [User ID]. 
Username: [User Name], Name: 
[Name].

Informational 
Message

Click OK to continue.

11340004 Updating Batch [Batch Name] ID 
[Batch ID] Number of Ballots 
[Number] Revision [Number]

Informational 
Message

Click OK to continue.

10750014 Updating generation status Verbose 
Message

No action required.

10030002 User Response: [Item Name] Warning 
Message

Click OK to continue.

10840013 Using temporary memory to access 
Election Data for Ballot Previewer.

Informational 
Message

Click OK to continue.
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11540007 Validating Data Informational 
Message

Click OK to continue.

10540039 Validating restore data Informational 
Message

Click OK to continue.

10020014 View Report failed: [Report Name]. Error Message Contact ES&S Customer 
Support.

11740003 Viewing ballot [Ballot ID] from poll 
[Poll ID].

Informational 
Message

Click OK to continue.

10220133 Vote For Number is invalid. Please 
enter a value greater than zero.

Error Message Enter a Vote For response 
greater than zero, and retry the 
action.

10330006 Warning: [Item Name] order is 
different than [Item Name] order.

Warning 
Message

Click OK to continue.

10330005 Warning: [Item Name] does not have 
any associated [Item Name]. Each 
[Item Name] in the [Election Name] 
must have at least one partisan [Item 
Name].

Warning 
Message

Ensure that the specified 
associations are in place, and 
then retry the action.

10230140 Warning: [Item Name]: line [Line 
Item]: [Item Name] is assigned to 
more than one district of the same 
[District Type]

Warning 
Message

Verify that the linking is 
accurate, and click OK to 
continue.

10230132 Warning: [Item Name]: Ignoring fields 
[Field Name].

Warning 
Message

Click OK to continue.

10230131 Warning: [Item Name]: Unknown data 
type [Data Type].

Warning 
Message

Contact ES&S Customer 
Support.

10230136 Warning: Duplicate value [Item Name] 
for [Item Name] in the list of [Item 
Name].

Warning 
Message

Verify the information and 
correct any errors. Click OK to 
continue.

10230137 Warning: File [File Name]: line [Line 
Item]: [Item Name] is assigned to 
more than one [Item Name] of a same 
[Item Name] Poll Type.

Warning 
Message

Verify that the linking is 
accurate, and click OK to 
continue.

10230141 Warning: Non sequential numbers for 
[Item Name]

Warning 
Message

Verify the sequence order, and 
click OK to continue.

10730044 Warning: Please return to Paper 
Ballot module and setup a panel for 
Write-in Recognition in the Write-in 
style sheet.

Warning 
Message

Return to Paper Ballot and 
create a panel for Write-in 
Recognition in the write-in style 
sheet.

10230009 Warning: Re-importing the election 
xml will delete the Paper and 
Accessible Ballot format changes you 
have made.

Do you want to re-import the election 
xml?

Warning 
Message

Click Yes to complete the 
action.
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10230139 Warning: Since there are [Contest 
Name] with write-ins and the “Enable 
Write-ins” option is unchecked the 
[Equipment Type] media will not work 
on the tabulators.

This option is to enable the printing 
of sample ballots without Write-ins 
only.

Warning 
Message

In order to correct the issue, 
return to the Capture module 
and enable write-ins.

10230138 Warning: System Generated 
[Number] options are turned on, so 
ignoring the [Item Name] in the 
import file.

Warning 
Message

Click OK to continue.

10330001 Warning: There [Number of Choices] Warning 
Message

Click OK to continue.

10330002 Warning: There [Number of Choices] Warning 
Message

Click OK to continue.

10330003 Warning: There [Number of Choices] Warning 
Message

Click OK to continue.

10330004 Warning: There [Number of Choices] Warning 
Message

Click OK to continue.

10630008 Warning: You have already created 
Results Media Validation File.

If you create new election media you 
must recreate the Results Server 
Media Validation file.

If you don’t re-create the validation 
file, you will not be able to transmit 
results.

Do you want to continue?

Warning 
Message

Click Yes to complete the 
action. Note however that if you 
proceed, the Media Validation 
file must be recreated.

10730045 Warning: You have selected the 
Reserve Panel for Write-in 
Recognition option in Paper Ballot, 
but have not selected the Detect 
unmarked write-ins option for the 
[Item Name] or [Item Name]. 
Unmarked write-ins will not be 
detected unless you select that 
option on the [Item Name] and [Item 
Name] settings screens. 

Do you want to continue?

Warning 
Message

Click Yes to complete the 
action. Note however that 
write-in recognition will not 
function unless the options in 
the warning message have been 
activated.

10520001 Welcome Page Link Error [Error Code] Error Message Contact ES&S Customer 
Support.

10010014 Write to Primary Log failed: [Log ID]. Critical Error 
Message

Contact ES&S Customer 
Support.

10650006 Writing header file Verbose 
Message

No action required.
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10220086 You can only have up to [Number] 
[Item Name].

Error Message Verify the information, and then 
retry the action.

10220185 You cannot add another [Item Name] 
to the Group: [Group Name] because 
this will cause the number of [Item 
Name] in the Group to exceed the 
Vote-For-Number: [Number]. Please 
change the Vote-For-Number to 
match the number of [Item Name] in 
the Group.

Error Message Verify that the number of items 
is equal to or less than the Vote 
For number of the group.

10421020 You cannot change your own Login 
ID.

Error Message Contact your Electionware 
administrator.

10420007 You cannot inactivate yourself. Error Message Contact your Electionware 
administrator.

10020026 You entered an invalid order number. 

Please enter a number between 
[Number] and [Number].

Error Message Enter a value within the 
specified range, and then retry 
the action.

10730016 You have already created accessible 
equipment media.

If you change codes you should 
recreate all of the election media.

Do you want to continue?

Warning 
Message

Click Yes to complete the 
action. Note however that if you 
proceed, you will have to 
recreate all accessible 
equipment media.

10730012 You have already created accessible 
equipment media.

If you generate election data again 
you should recreate all of the election 
media.

Do you want to continue?

Warning 
Message

Click Yes to complete the 
action. Note however that if you 
proceed, you will have to 
recreate all election media.

10730014 You have already created DS election 
media and/or reporting key media.

If you generate election data again 
you should recreate your reporting 
key media and all of the election 
media.

Do you want to continue?

Warning 
Message

Click Yes to complete the 
action. Note however that if you 
proceed, you will have to 
recreate all election media.

10730018 You have already created DS 
qualification media, election media 
and/or reporting key media.

If you change codes, you should 
recreate your qualification media, 
reporting key media, and all of the 
election media.

If you have prepared any ballot 
scanners with the qualification media 
and/or election media, you will have 
to repeat that process.

Do you want to continue?

Warning 
Message

Click Yes to complete the 
action. Note however that if you 
proceed, all equipment media 
will have to be recreated, and 
that any machines already 
qualified for the election will 
have to be requalified to 
continue.
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10431016 You have already entered election 
codes for this election. You must 
enter new election codes for [Code 
Type] and [Code Type] for the new 
security level to be implemented. If 
you have generated election data or 
created media you must also repeat 
those steps for the new security level 
to be implemented. If you do not 
repeat these steps, your election 
codes will not incorporate the new 
security level.

Do you want to continue?

Warning 
Message

Click Yes to complete the 
action. Note however that if you 
proceed, all election data has to 
be regenerated, all equipment 
media will have to be recreated, 
and that any machines already 
qualified for the election will 
have to be requalified to 
continue.

10730038 You have already generated election 
files or created media. If you change 
[Equipment Type] settings you will 
need to generate election files again 
and re-create all media. Do you want 
to continue?

Warning 
Message

Click Yes to complete the 
action. Note however that if you 
proceed, all election data has to 
be regenerated, and all 
equipment media will have to 
be recreated to continue.

11030017 You have already generated the 
Accessible Equipment election data. 
If you change screen definitions you 
must re-generate the Accessible 
Equipment election data and 
re-create the media for [Equipment 
Type].

Do you want to continue?

Warning 
Message

Click Yes to complete the 
action. Note however that if you 
proceed, all accessible 
equipment election data has to 
be regenerated, and all 
accessible equipment media will 
have to be recreated to 
continue.

10730020 You have already generated the 
Accessible Equipment election data.

If you change equipment settings you 
should re-generate the Accessible 
Equipment election data.

Do you want to continue?

Warning 
Message

Click Yes to complete the 
action. Note however that if you 
proceed, all accessible 
equipment election data should 
be regenerated to continue.

10730022 You have already generated the DS 
election data.

If you change equipment settings you 
should re-generate the DS election 
data.

Do you want to continue?

Warning 
Message

Click Yes to complete the 
action. Note however that if you 
proceed, all DS election data 
has to be regenerated.

10230144 You have entered more write-ins than 
it is possible to vote for, based on the 
vote for number entered.

Warning 
Message

Correct either the Vote For 
number, or the number of 
write-ins. The number of 
write-ins must be equal to or 
less than the Vote For 
responses.

10520031 You have insufficient permissions to 
perform this operation because of 
your Electionware license and/or your 
login role.

Error Message Contact your Electionware 
Administrator.
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10220184 You have not selected any equipment. 
You must have at least one Election 
Day or Absentee/Early equipment 
selected.

Error Message Select at least one Election Day 
or Absentee piece of 
equipment, and then retry the 
action.

10230145 You have selected [Equipment Type]. 
You must also select the equipment of 
that type.

Warning 
Message

Select the appropriate 
equipment type and then retry 
the action.

10620031 You must select [Poll Place] to create 
election media

Error Message Select a poll place (or 
jurisdictional entity) to create 
election media.

10220136 You must select a [Item Name] for 
[Item Name].

Error Message Select the appropriate item 
association, and retry the 
action.

10220137 You must select at least one [Item 
Name]. 

Error Message Select the specified item and 
retry the action.

10220152 You must select at least one [Item 
Name] and one [Item Name].

Error Message Select the specified items and 
retry the action.

10220154 You need to have at least one rotation 
exception to save.

Error Message Create at least one rotation 
exception to save your data.

11021019 You need to make sure a [File Name] 
is selected for import. Verify you have 
a valid file selected to import so that 
you can select a [Item Name].

Error Message Verify that a file name is 
selected, and then retry the 
action.

10520051 You need to select [Item Name] to 
delete.

Error Message Select an item to delete it.

11530017 Your password has expired. You must 
change your password now.

Warning 
Message

Change your password as 
instructed.

10640017 Zipping the ballot style files. Informational 
Message

Click OK to continue.
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Chapter 24: Revision History

Electionware Module 1: Administrator
Document Version 4.0

April 24, 2014

Chapter Version Description Project

2,11 3.0 Removed references to viewer software. 5.2.0.0

Electionware Module 1: Administrator
Document Version 3.0

February 21, 2014

Chapter Version Description Project

23 3.0 Removed all modem messages from System 
Messages table.

5.2.0.0

Electionware Module 1: Administrator
Document Version 2.0

February 7, 2014

Chapter Version Description Project

9 2.0 Clarified note text regarding password lock function. 5.2.0.0

9 2.0 Corrected software version in instructions. 5.2.0.0

11 2.0 Deleted section “DS200 Results Transmission.”

Deleted unsupported languages.

Deleted section “Regional Sending.”

Deleted section “Import DS200 Modem 
Configuration.”

Deleted section “SFTP User Accounts.”

5.2.0.0
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Electionware Module 1: Administrator
Document Version 1.3

January 31, 2014

Chapter Version Description Project

11, 16 1.3 Clarified Chapter 16 instructions & referenced them 
from Chapter 11.

5.2.0.0

11 1.3 Distinguished currently supported languages. 5.2.0.0

11,17 1.3 Added notes to Vacuum Analyze and Vacuum Full 
options, clarifying when they are available for use.

5.2.0.0

Chapter Version Description Project

Entire Book 1.0 New book based upon FLEVS 4.5.0.0. 5.2.0.0

2 1.2 Add free Microsoft Excel Viewer to System 
Requirements

5.2.0.0

11 1.2 Add Important note that Excel Viewer is required to 
view/print exported spreadsheets.

5.2.0.0

11 1.2 Add Important note that exported spreadsheets 
must be saved to a computer w/ Excel in order to 
edit them.

5.2.0.0
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